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1 DVD-Audio Creator Installation
Say Something Special

DVD-Audio Creator is a suite of seven applications that run on a 

workstation using the Microsoft Windows 2000 operating system 

(Professional or Server). 

The most efficient workflow for the production of DVD-Audio albums is 

typically achieved when the workstation running DVD-Audio Creator is part 

of a networked workgroup that includes a Macintosh workstation running 

SonicStudio HD. If the albums to be produced include DVD-Video content, 

the workgroup may also include a Macintosh running Sonic DVD Creator or 

a Windows machine running Sonic Scenarist.

This Chapter covers installation of the DVD-Audio Creator suite [need 

description of this installation], setup of the Windows 2000 operating 

system for using DVD-Audio Creator, and network setup for the production 

workgroup. 

For up-to-date details about the recommended hardware and operating 

system configuration of machines running DVD-Audio Creator, please refer 

to the DVD-Audio Creator Configuration Guide, available for download 

from the Sonic Web site:

www.sonic.com/get the real url
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Instal l ing the Operat ing System

Installation of Windows 2000 Server and Professional involves setting or 

entering values for various parameters. This section covers the parameters 

and values to set for optimum operation of DVD-Audio Creator.

PARTITION SIZE

During the installation you will be asked which partitions you want to 

create on your hard-disk(s). It is recommended to keep your data and the 

operating system in separate partitions. This makes it easier to recover lost 

data or to re-install the operating system.

The preferred size of the partition for your operating system depends on 

the size of your hard-disk. The minimum size for this partition is four 

Gigabytes; 8GB is recommended. If you plan to keep all your data files and 

documents on external hard-disks, you can use one partition on the 

internal drive for the operating system. 

If you are installing a second copy of a Windows operating system [Q: does 

this mean an additional copy (two at once on the machine), or a copy that 

replaces the existing operating system? A: two at once. For details, see e-

mail from Simon 9/15] you can choose the same partition that is used by 

the already-installed operating system. Windows will automatically create a 

boot menu.

NTFS FILE SYSTEM

Authoring DVD-Audio requires the ability to work with very large files 

stored on a hard-disk. The only file system able to work with sufficiently 

large files in the Windows environment is NTFS, which should be selected 

as the file system for all hard-disks used to store data files.

In Windows 2000 Server Edition, the NTFS file system is also required for 

the startup disk. Use of NTFS for the operating system’s hard-disk is 

recommended for Windows 2000 Professional Edition as well.
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If you are installing a second copy of the Windows 2000 operating system 

[additional or replacement?] in the same partition as the existing operating 

system, you will be asked to choose a drive formatting option. Do not 

choose to format the drive with NTFS. Instead, either choose to leave the 

existing file system intact or to convert it to NTFS.

Note: NTFS hard disks cannot be accessed by the Windows 95, Windows 

98 or Windows Millennium Edition operating systems. Converting a hard 

disk containing one of these operating systems to NTFS will cause the 

previous operating system to be unusable.

INSTALLING SCRIPT DEBUGGER

During the initial installation of Windows 2000, the installation wizard will 

display a list of optional additional components that you may choose to 

install at the same time. Check the checkbox for the "Script Debugger" 

component. Script Debugger offers a better environment in which to edit 

XML and other text-based files than Windows’ default text-editor 

application (Notepad).

To install Script Debugger after Windows has already been installed, use 

Add/Remove Programs in the Control Panel folder (accessed via the 

"Settings" submenu on the Start menu).

SETTING THE COMPUTER’S NAME

When computers are used together on a network, or connected directly via 

a cross-cable connection, every computer must have a unique name. The 

name is defined during the initial installation of Windows 2000. In addition 

to identifying the computer on the network, the name identifies the 

computer in the Chooser application when file-sharing with a Macintosh.
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During installation, Windows will ask if the computer should belong to a 

workgroup or a domain. If you are using a cross-cable connection only, 

[what if you are connected to a network?] the recommended setting is 

"workgroup." The name of the workgroup does not affect communication 

between Macintosh and Windows machines.

Note: If you need to connect your Windows machine to an enterprise-

wide LAN (local area network), it may be necessary to connect using a 

domain. In this case, consult with your network administrator.

First-Time Startup

When starting up for the first time after installation, each version of 

Windows 2000 will present a different window. This section covers 

recommended user response to these windows.

WINDOWS 2000 SERVER: "CONFIGURE YOUR SERVER"

During the first startup of Windows 2000 Server, you will see the "Windows 

2000 Configure Your Server" window. The window asks if you would like to 

configure your server, meaning that Windows is offering to help you set up 

enhanced server services, including the ActiveDirectory, which is 

Microsoft’s implementation of a Domain Controller service.

Note: Because installing a domain controller may decrease system 

performance, it is strongly recommended that you choose not to configure 

this server at this time. After clicking on "Next," un-check the "Show this 

screen at startup" checkbox for the wizard. 

The "Windows 2000 Configure Your Server" window includes some useful 

information on how to setup server services like "File Sharing." However, it 

is not needed for any set up related to DVD-Audio Creator.
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WINDOWS 2000 PROFESSIONAL: "WELCOME TO WINDOWS"

After starting Windows 2000 Professional, Windows will display a window 

providing tips and tricks for beginning to work with Windows. This 

window can be deactivated by using the checkbox at the bottom of this 

window.

Installing Devices

For best performance, Windows 2000 requires compatible, up-to-date 

drivers for devices connected to the computer. This section explains how 

to ensure that the proper driver is installed for each device. 

While most hard disks and optical drives do not require special drivers, 

drivers are required for controller boards (SCSI-Controllers, RAID-

Controllers, or IDE-Controllers) connecting these devices to the system. It 

is recommended that you use drivers especially designed for your specific 

controller.

CHECKING DEVICE DRIVERS

During installation, Windows 2000 checks for hardware devices in the 

system. However, Windows may not associate the correct drivers with your 

hardware, in which case some functions may not be available or the 

hardware may run in slower compatibility mode. 

To double-check the drivers with which your devices have been associated, 

open the Computer Management application in the Administrative Tools 

folder on the Windows Start menu. Click on the Device Manager tab to 

display a list of all installed components. The list will have several branches. 

Open each branch of the component tree to see the listed components. 

[Image: computermanagement.bmp]
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In some hardware configurations, especially those involving newer 

Ethernet controller and display adapter hardware Windows may not find a 

suitable driver for a given device on its installation CD. In this case, the 

device will be displayed in the Other Devices branch of the Device 

Manager tab. Some devices, especially PCI cards, will be listed in this 

branch as just a generic device type, without the actual brand or name of 

the product (e.g. "Ethernet Controller," "USB Token," or "Video Controller"). 

[Image: computermanagementunknown.bmp]

To use devices listed in the Other Devices branch, you must first install the 

appropriate drivers. 

INSTALLING DEVICES DRIVERS

All hardware vendors include CDs or floppy-discs containing drivers 

working with your computer, but it is recommended to look out for new 

drivers on the Internet to ensure you are using the latest drivers providing 

the highest performance and stability. 

Windows 2000 (all editions) supports drivers designed especially for 

Windows 2000 and some so-called WDM-drivers which can be used on 

other Windows platforms, too. If available, it is recommended to use 

"native" Windows 2000 drivers.

First of all, you have to select the device you want to install a driver for by 

clicking on its name. If Windows did not install a driver by itself, the device 

will be listed in the section "Other devices", otherwise you will find it in 

the appropriate section of the component tree. By clicking on the name 

with the right mouse button and selecting "Properties" a new window will 

appear. Using the button "Reinstall Driver…" will open a new window 

which will guide you through the installation of the driver.

Some drivers have to be installed using an installation program provided by 

the hardware vendor. In such a case, Windows will not find any suitable 

drivers on the inserted CD or floppy disk.
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Depending on the hardware you are installing, you will have to restart 

Windows after installing a new device driver. 

HOT-PLUGGING DEVICES

Some controllers used to connect external devices to your computer 

support hot-plug functionality. This means that you can plug-in and use 

your hardware without shutting down your computer.

After such hardware was installed Windows will open the "Device Driver 

Wizard" which will guide you through the installation of the driver required 

to use this device. For some devices not needing a special driver or devices 

for which a driver is already available Windows will not open the above-

mentioned wizard and activate the driver by itself.

SCSI-Devices should not be connected after starting up the system, 

connecting additional devices to an already running SCSI-Chain should be 

done after the system was shut down. Also do not turn of the power of 

currently used devices or disconnect them while the system is running. 

You should always ensure that the device at the end of your SCSI-chain is 

terminated properly! Active Terminators are recommended for chains 

containing hard disks and wide SCSI devices!

INSTALLING DVD AUDIO CREATOR "SUPERPRO"-DONGLE

Using the DVD-Audio Creator software requires to install a hardware dongle 

(USB) along with the dongle’s drivers. The drivers are included on the DVD-

Audio Creator installation disc and have to be installed before the dongle 

can be used.

The driver is supplied as an installer file with a filename including the name 

"rainbow", after the manufacturer of the dongle. When starting the 

installation by running this file from the installer CD-ROM you have to 

connect the dongle to your computer. Windows will now associate the 

drivers to the hardware device. For the actual installation follow the 
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instructions on the screen. During the installation process you will be 

asked to temporarily remove the dongle again. After the installation 

procedure is finished you then reconnect it.

Current drivers for the "Sentinel System Dongle" can also be found on the 

website of Rainbow Technologies (http://www.rainbow.com). 

As long as Windows is unable to find a suitable driver for the dongle, it will 

refer to it as "USB Token".

SCSI ASPI-DRIVERS FOR WINDOWS

Many Windows applications access SCSI devices by using the ASPI-Drivers. 

Those drivers were originally created by Adaptec. This is the reason why 

they are included in every Adaptec SCSI-Retail-Kit. Because of license 

problems using ASPI-Drivers with other SCSI controllers can be a problem 

or impossible, so it is recommended to use a SCSI controller which 

supports ASPI. Most of the DVD-Audio Creator and many CD/DVD-

Recording software applications need ASPI-drivers to run.

If you have installed an Adaptec driver for your SCSI device you will 

probably have ASPI-Drivers available. It is recommended to update to the 

current ASPI drivers by downloading the current ASPI32.EXE update file 

from the Adaptec website. The file ASPICHK.EXE will allow you to check 

which version of the ASPI drivers is installed.

Consult your reseller if you did not receive ASPI drivers with your Adaptec 

board!

Performance Optimization (Windows 2000 Server)

If you are using Windows 2000 Server it is important that you change the 

performance optimization setting from "Background services" to 

"Applications".
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This setting can be changed by clicking on the icon "System" in the folder 

"Control Panel" of the sub-menu "Settings" in your start-menu, selecting the 

tab "Advanced", clicking on "Performance Options…" and selecting the 

"Applications" option box. 

Windows Service Pack Installation

It is highly recommended to install the latest Service Pack available from 

the Microsoft Website or downloadable with the Windows Update service.

As of August 2001 the current Service Pack released by Microsoft is Service 

Pack 2. Service Packs are working with all editions of Windows 2000. If you 

are using a foreign language version of Windows 2000 you will need to 

download the Service Pack based on the language of your operating 

system.

Setting up the Network

To transfer encoded and prepared video and audio files from your 

Macintosh to your PC, you must set up a network connection. This 

connection may be used to transfer files with the FTP protocol or by using 

AppleTalk Routing. You will also need to configure the TCP/IP protocol to 

enhance file transfers. 

If you are not using a crosslink-cable ethernet connection as described 

above and using a switch to connect to a network with other computers 

instead, you will have to ask you network-administrator for more 

information on how to configure the TCP/IP settings!

PHYSICAL CONNECTION

Before you begin you should establish a physical network connection by 

using a crosslink ethernet-cable to connect your PC and Macintosh.
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All Macintosh G4 computers contain an 1 GBit ethernet adapter, so it is 

recommended to install a 1 GBit ethernet adapter in your PC to enhance 

the transfer speed. You can use regular crosslink ethernet cables to connect 

both machines.

Most ethernet adapter cards display the current network connection speed 

by using LEDs at the back of the adapter as soon as a physical connection 

is established. Please make sure that the correct speed is shown.

PREPARING WINDOWS

Most 1 GBit Ethernet adapters are not natively supported by Windows, so 

that you have to install suitable drivers to use such adapter cards. Please 

refer to the section "Installing Devices" to get more information on how to 

install Windows drivers.

After you have installed the ethernet adapters drivers, Windows will 

automatically create an icon labelled "Local Area Connection" in the folder 

"Network and Dial-Up Connections" which can be found in menu "Settings" 

of the start-menu.

[Image: networkconnection.bmp]

By clicking on this icon with the right mouse button and by selecting 

"Properties" you will open the window to configure your network 

connection.

If the "AppleTalk Protocol" is missing in the list of network components 

and you are configuring Windows 2000 Server you should install this 

protocol by clicking on the button "Install…" and selecting "Protocol". 

Using this protocol on Windows 2000 Professional has no effect on the 

network connection and does not provide any additional features.
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WINDOWS CONFIGURATION OF TCP/IP PROTOCOL

In the still opened window "Local Area Connection Properties" select 

"Internet Protocol (TCP/IP)" and click on the button "Properties" to open 

the TCP/IP configuration window. 

Using a crosslink-cable ethernet connection requires assigning a unique 

own static IP address to each of both computers. IP-Addresses have to 

belong to the same subnet mask to establish a working connection. 

[Image: tcpipsettings.bmp]

Please select the "Use the following IP address" option box and enter a 

valid IP address (e.g. 192.168.115.10) with the appropriate subnet mask 

(e.g. 255.255.255.0). By using IP-Addresses based on the subnet mask 

255.255.255.0 the  IP-Addresses of your both connected network 

computers have to contain the same numbers in the first three parts 

(192.168.115.) and a unique own number in the fourth. So if the PC has 

the IP-Address 192.168.115.10 based on the subnet mask 255.255.255.0 the 

Macintosh has to use the same subnet mask with the IP-Address 

192.168.115.20 or any other address with a unique own fourth part.

Then click on the button "OK" to close the TCP/IP configuration window. If 

the checkbox "Show icon in taskbar when connected" is not already 

activated you should activate it now and close the "Local Area Connection 

Properties" window by clicking on the "OK" button. Windows will then 

show you the speed of your connection in the, so called, tray area to the 

right of the taskbar. If you are using 1 GBit network adapters Windows 

should show "Speed: 1 GBit".

MACINTOSH-CONFIGURATION OF TCP/IP PROTOCOL

[Image: mactcpipsettings.bmp]

As described in the chapter before, both computers have to use own 

unique IP-Addresses to establish a connection. Both computers have to use 

the same subnet mask.
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To edit the TCP/IP configuration on your Macintosh operating system you 

have to open the control panel "TCP/IP" which can be found in the 

submenu "Control Panels" located in the so-called apple-menu. 

First you have to select "Ethernet" in the combo box named "Connect via:". 

In the combo box "Configure:" you have to select "Manually" to be able to 

enter IP-Address and subnet mask.

If you have used the IP-Address and subnet mask mentioned in the example 

of the chapter before, you have to use an IP-Address beginning with 

192.168.115. and ending with a number between 1 – 254 that is different 

from the one entered in the PCs configuration. The subnet mask has to be 

the same that has been used on the PC, in our example 255.255.255.0.

ACTIVATING MACINTOSH FILE SHARING (WINDOWS 2000 SERVER)

By activating Macintosh File Sharing on Windows 2000 Server you will be 

able to access directories on your PCs hard disk as regular network 

volumes by using the application "Chooser" on your Macintosh.

To activate Macintosh File Sharing you have to install the "File Services for 

Macintosh". This can be done by clicking on the icon "Add/Remove 

Programs" in the folder "Control Panel" which can be opened by clicking 

on "Control Panel" in the sub-menu "Settings" of the start-menu. You then 

need to click on the button "Add/Remove Windows Components" located 

at the left of the window and scroll down the list of the window appearing 

next. Opening the "Details…" of the topic "Other Network File and Print 

Services" will allow you to activate the checkbox belonging to "File 

Services for Macintosh". To continue, click on the "OK" button and select 

"Next >". All necessary components will now be installed and activated. 

[Image: enableguestaccount.bmp]

At the end of the process you have to enable the user "Guest" to be able to 

log-on to use PC folders on your Macintosh without requiring entering 

username and password. In the window "Computer Management", which 

can be opened by clicking its icon in the folder "Administrative Tools" of 
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the start-menu, open the tree branches "Local Users and Groups" and 

"Users". At the right select the user "Guest" and click with the right mouse 

button on its name, then select "Properties". In the window "Guest 

Properties" you have to deactivate the checkbox "Account is disabled" and 

confirm by clicking on "OK". Activating the user "Guest" has to be done 

once only, but you have to add this user to each additional volume you 

want to share as described below.

SHARING A FOLDER AS MACINTOSH VOLUME (WINDOWS 2000 

SERVER)

By default Windows automatically shares a volume labelled "Microsoft UAM 

Volume". This folder contains the Macintosh installer file "MS UAM Installer" 

which will install advanced encrypted user authentication services on your 

Macintosh. This is not required in a network connected with a crosslink-

cable connection. The "Microsoft UAM Volume" folder is not intended for 

use to save files and is therefore write-protected by default.

[Image: createnewshare.bmp]

To share other folders on your PC, you will first have to create the folder 

you want to share in the case that it does not already exist. Then you have 

to open the "Computer Management" application by using the link in the 

"Administrative Tools" folder of your start-menu. Then open the tree 

branches "Shared Folders" and "Shares". By clicking on an empty space of 

the folders list to the right of the window with the right mouse button a 

context-menu will appear allowing you to select "New File Share".

[Image: newsharevalues.bmp]

In the new window "Create Shared Folder" you have to "Browse…" for the 

folder you want to share, activate "Apple Macintosh" in the area "Accessible 

from the following clients", disable the "Microsoft Windows" checkbox 

above and enter a "Macintosh share name" which represents your PC-Folder 

in the "Chooser" window of your Macintosh computer.
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After clicking on the button "Next >" at the bottom of the window you can 

set the access permissions for this new volume. By default all users of your 

PC will have access to your shared volumes by providing their username 

and password.

To make this folder available to guests, click on the button "Custom…" and 

select the tab "Security". There you can click on the button "Add…" to add 

the user "Guest" (not "Guests") which is disabled by default for security 

reasons (mark with an X). Then select "Full Control" as "Allow"-Permission 

to deactivate the write-protection. After closing the "Customize 

Permissions" window by clicking on the button "OK" you have to click on 

the button "Finish" to create the new share. 

A message box will appear and inform you that the sharing is now 

established. You can now decide if you want to share other folders as well 

or close the "Create Shared Folder" window.

ACTIVATING THE FILE-TRANSFER-PROTOCOL (FTP) SERVICE

The file transfer protocol empowers you to share files between two or 

more computers without any restrictions to the size of a single file or the 

type of operating systems both computers are using. It was originally 

designed to transfer files in large area networks like the Internet, but can be 

used in a local network in the same way. 

To use the file transfer protocol you need a computer with ftp server 

capabilities installed which is hosting all files in folders you have to specify. 

The client computer will have access to these files by using ftp capable 

client applications such as the DVD Creator’s Imager application or a web 

browser. By using Imager on your Macintosh you can use the file transfer 

protocol to transfer DVD Volumes or other File/Folder hierarchies directly 

to a hard disk connected to your PC. You can then continue the mastering 

process on your PC, no further file transformation/copy has to be done.
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Unlike with Macintosh file sharing you cannot directly mount ftp folders on 

your Macintosh’s desktop, the two computers use their IP-Addresses to 

communicate with each other. This means that you have to enter the IP-

Address of the target computer to transfer files from  your client computer 

(typically your Macintosh) to the server’s, (usually the PC’s) ftp folder. By 

using gigabit ethernet connections you can reach enormous transfer speeds 

with this technique.

All editions of Windows 2000 include a line of internet services including a 

ftp server service allowing you to specify folders you want to share. To use 

the file transfer protocol you have to install the ftp server service by using 

the control panel applet "Add/Remove Programs". By clicking on the button 

"Add/Remove Windows Components" to the left of the applets window you 

will open the "Windows Components Wizard" which will allow you to 

select the components you want to use.

Selecting "Internet Information Services (IIS)" and clicking on the button 

"Details…" will open a new window including a list of all internet server 

services available. A component marked with an activated checkbox is 

currently installed on the system.

First you should uncheck all subcomponents listed there to make sure that 

no other server components, which are useless for your working 

environment, are activated. Then you should activate the checkbox 

belonging to the "File Transfer Protocol (FTP) Server". By doing this other 

checkboxes will be activated as well. These other components are 

necessary to run the ftp server and have to be installed.

By clicking on the buttons "OK" and "Next >" you will begin with installing 

the ftp services. In most cases you will need the Windows CD to perform 

this process. After the successful installation you are able to set up the ftp 

server following the instructions described in the next chapter.
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1.6.8 SETTING UP THE FTP-SERVER

Before you can access your ftp server from your client computer you have 

to set up some basic settings to get started. First you should create a new 

folder which will be shared by using the ftp server. This folder can be 

located everywhere you like on your PCs hard disk and may also contain 

subfolders.

This folder has to be selected as root directory (also referred to as "home 

directory") of your ftp configuration. All subfolders of this folder will be 

automatically shared, too.

[Image: ftpfolderproperties.bmp]

To begin with the configuration of your ftp server you have to open the 

application "Computer Management". This tool can be found in the 

"Administrative Tools" folder of your control panel which can be opened by 

clicking on its name in the "Settings" submenu of the start-menu.

In the tree "Computer Management (Local)" you have to open the branches 

"Services and Applications" and "Internet Information Services" to find a 

branch called "Default FTP Site" containing all configuration and 

administration options for your ftp server. Click on this branch by using the 

right mouse button to open a context menu allowing you to select 

"Properties" to set up your ftp server.

[Image: ftpsitehomedirectory.bmp]

Open the tab "Home Directory" and click on the button "Browse…" to 

select the folder you have created as root directory for your shared ftp 

folder. Activate the checkbox "Write" to enable write access to this folder 

from your client computer. Otherwise you will not be able to save files to 

this folder.

The tab "Security Accounts" allows you to choose if you want to allow 

anonymous connections to your ftp folder. By deactivating the checkbox 

"Allow Anonymous Connections" you will limit access to those users 

knowing the username and password used for log-on at your PC. Username 
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and password will be set during the initial installation of Windows 2000, 

but you can also add additional users to your configuration by following the 

instructions given in the Windows help files.

Security advice: Do not leave your allowed anonymous connections 
unattended in the internet !

If you computer is directly connected to the Internet it may be possible to 

access your files from outside your company! To make sure to avoid these 

security problems you should disable anonymous log-in as described above. 

If your computer is connected to the Internet through a local area network 

you should ask your network administrator if the network is protected by a 

firewall before leaving anonymous log-on activated. If both computers are 

directly connected with a cross-cable connection without using any other 

network connection you can leave anonymous connections activated.

By clicking on the button "OK" you will save the settings you have just 

made and will be ready to connect to your ftp server from your client 

computer (e.g. the Macintosh) by using Imager or other ftp capable 

software. To open an anonymous connection to the ftp server the ftp 

address would be ftp:// followed by the IP-address of your PC as set in the 

TCP/IP configuration. If the PC is using the IP-address 192.168.115.10 your 

ftp address would be ftp://192.168.115.10. 

If you want to connect to the ftp server using username and password, you 

have to provide this information in your ftp capable client application or 

include it in the ftp address. Imager requires including username and 

password in the ftp address. The default way of including this information is 

to use an address that looks like this: ftp://username:password@ipaddress.

[Image: imagerurl.bmp]

Some applications like Imager require adding folder and filename 

information to the ftp address (e.g. ftp://192.168.115.10/master/file.mlp). 

More information can be found in the DVD-Creator’s Imager 

documentation.
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VIRTUAL FTP DIRECTORIES

Virtual Directories, as seen from the client computer, behave like normal 

sub-folders of the home ftp directory. Seen from the ftp server those folders 

can be located on completely different hard disks than the home directory 

or other virtual directories. Using a Virtual Directory makes it possible to 

share different folders at the same time by configuring them as virtual 

subfolders of the home directory.

[Image: virtualdirectorymenu.bmp]

To add a virtual directory, click on the branch "Default FTP Site" using the 

right mouse button, then select "New" followed by "Virtual Directory".

The window appearing next will allow you to set up the alias, which will 

be the name of the new virtual subfolder belonging to the home directory, 

the location (path) pointing to the files you want to share on your PCs hard 

disk, and the level of permissions which should be set to "Write" and 

"Read".

If you, for example, set up to share all files located in the path "D:\" in a 

virtual directory with the alias "project2", the files located in this folder and 

its subfolders will be available by using the ftp address 

ftp://192.168.115.10/project2/ (if the IP-address of the PC is different use 

the correct one instead).

1 .7  Troubleshoot ing

 A STOP error-message (blue screen) appears at the beginning of the 
Windows 2000 initialization, or the text-mode part of setup hangs:

Windows requires a driver to read and write information on hard disks 

connected to SCSI-Controllers. Some new SCSI controllers are unknown to 

Windows and therefore it cannot access the hard disks connected to these 

controllers. If the setup program is unable to locate any hard disk this 

message / blue screen appears.



 

1.7 Troubleshooting 19

     
Solution: During the beginning of the installation Windows displays the 

message at the bottom of the screen that you can press F6 to install third-

party SCSI/RAID drivers. This message appears for a very short time. If you 

press F6 during this period Windows will ask for a driver disk containing 

the current SCSI driver.

I cannot boot from CD-ROM to install Windows 2000:

To install Windows 2000 from CD-ROM you have to select CD-ROM as first 

drive in the BIOS-Setups boot order. You will find detailed information 

about how to do this in your computers manual.

SCSI bios stops when initializing a device, or SCSI device does not work 
properly:

This occurs if a device was not properly assigned with a unique SCSI ID or 

the termination of your SCSI chain is inappropriate.

Looking out for new drivers for your devices on the Internet is also 

recommended in case you have problems with your hardware.

Some devices require disabling the "Enable Wide Negotiation" function for 

their SCSI ID to function properly with some SCSI adapters. More 

information can be found in the documentation of your SCSI card.

It is also good to look out for new versions of your SCSI devices or 

controllers firmware. Firmware updates will update the software installed 

in your hardware device and solve a lot of problems. Please follow the 

detailed instructions of your hardware’s manufacturer on how to update 

the firmware. Otherwise you can seriously damage your hardware!
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2 Overview and Workflow
DVD-Audio Creator is a comprehensive suite of applications designed for 

efficient, graphically-driven production of albums in the DVD-Audio format. 

(If you are not yet familiar with the specific capabilities of DVD-Audio, see 

Appendix XX in this Guide.) 

Starting with prepared audio files, still images, menu graphics, and DVD-

Video content, DVD-Audio Creator handles all aspects of creating 

specification-compliant DVD-Audio disc images that are ready for 

replication. 

In this chapter, we’ll learn about the component parts of the DVD-Audio 

Creator suite, the suggested workflow for using DVD-Audio Creator, and 

how DVD-Audio Creator fits into an integrated DVD production 

environment. 

DVD-Audio Creator  Appl icat ions
DVD-Audio Creator is a suite of applications that are used together to 

complete the production of a DVD-Audio album. The seven applications are 

used for three main phases of production that are specific to DVD-Audio 

album creation: importing assets, authoring (defining title structure and 

navigation), and outputing the project.
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[In this next section, use the desktop icons for each application in place of 

bullets]

The applications used to import prepared assets into a DVD-Audio project 

are:

• Import Audio (Chapter 4) — imports AIFF (.aif), WAV (.wav), DVD 
(.bin), and MLP (.mlp) audio source files into the project directory, and 
defines resolution, channel configuration, and downmixing parameters 
for each Audio Track. Also used to define multiple Tracks in a single 
source file.

• Import Menu (Chapter 5) — imports the graphics files (Backgrounds, 
Overlays, and Button Hotspots) used to create Menus, which are 
displayed images that include buttons. Menus are used to navigate 
through the album, and may also be displayed during audio playback.

• Import VIDEO_TS (Chapter 6) — imports DVD-Video material (if any) to 
be incorporated into a DVD-Audio album.

The applications used to author a DVD-Audio project are:

• Author (Chapter 7) — used to define the overall structure of the album, 
including its Menus, Groups, Tracks, and Slides. 

• Command Editor (Chapter 8) — used to define links between the parts 
of an album structure that has been defined in Author, as well as menu 
color palettes and other attributes.

The applications used to output a DVD-Audio project are:

• Format (Chapter 9) — formats the presentation data (audio, graphics, 
and video) and logical data (album structure and links) into files that 
can be read and interpreted by a DVD-Audio player.

• Imager (Chapter 10) — organizes the formatted files into the exact 
directory structure that will be present on the final DVD, and writes this 
"disc image" to a DLT tape (for replication at a plant) or to an external 
hard-drive, from where it may be transferred to a DVD-R.
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Together, these seven applications are all you need to transform a 

collection of audio, video, and graphic source files into a finished DVD-

Audio album on a DLT master tape. To record the album’s disc image from 

your hard-drive to a DVD-R, you will also need the DVD-R writing 

application that comes with your DVD-R drive (see Chapter 11).

DVD-Audio Creator  Workflow

As we’ve seen above, DVD-Audio Creator is used to define the structure of 

a DVD-Audio album, to populate that structure with content (presentation 

data), to define links between parts of the structure, and to output the 

entire album in a form that may be used by a replication plant to 

manufacture copies for distribution. 

However, DVD-Audio Creator is not designed to actually create content files 

— audio, graphics, and video — used in a DVD-Audio album. Because the 

same capabilities needed to create content files for DVD-Audio are also 

utilized in preparing media for other purposes, it is not necessary to 

integrate those capabilities directly into DVD-Audio Creator. Instead, parts 

of the DVD-Audio preparation process utilize separate applications, with 

each task handled by a specialist in that particular area of production:

• Audio files are mastered by audio mastering engineers in 
SonicStudio®HD, and finalized for DVD-Audio use in OneClick™ DVD. 

• Graphics files are prepared by graphic designers in bitmap-editing 
programs such as Adobe Photoshop™.

• Video content is prepared by DVD-Video authoring specialists using 
Scenarist™, DVD Creator, or DVD Fusion® for Macintosh. 

The result is that DVD-Audio production workflow involves a series of 

stages, some handled in external applications, and some handled in DVD-

Audio Creator. The stages are project planning, asset preparation, asset 

import, authoring, and project output.
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Project Planning

Before you can build a DVD-Audio album, you first need to know exactly 

what it is that you are trying to build. The better a project is planned in 

advance, the more smoothly the production process will go.
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PLANNING QUESTIONS

As in any planning process, one of the most effective ways to define the 

scope of a DVD project is to be sure that you have thought through the 

answers to a series of basic questions:

• How many Audio Tracks will the album contain?

• For each Audio Track that uses more than two channels, will there be a 
separate stereo (or mono) mix, or will stereo output be provided via 
DVD-Audio’s SMART downmix feature?

• Are the word-length (bit-depth), sample-rate, channel assignment, and 
bit-rate of each Audio Track compliant with the audio requirements of 
the DVD-Audio specification (see Chapter 14, section 14.2.1), or does 
the audio material need to be converted?

• How many different Groups (paths or playlists through the available 
Tracks) will the album contain (maximum is nine)?

• What menus will be needed to allow end-users to navigate to and 
between the various Groups and Tracks, and what buttons will be on 
those menus?

• Will there be still-graphic presentations (Slides, Slideshows, or 
Stillshows) accompanying the playback of Audio Tracks?

• Are graphical materials available for use in Menus and Track graphics, or 
will they be created from scratch?

• Will Track graphics have on-screen buttons to link to other locations in 
the album? (This defines the graphics as Menus rather than Slides.)

• Will Track graphics include lyrics or libretto that will be used to navigate 
to different parts of the Track? (These are called Linked Lyrics Menus.)

• Will the album include DVD-Video material? The DVD-Video material 
allowed on a DVD-Audio album is subject to limitations that do not 
apply to a DVD-Video disc. (See Chapter 6, section 6.1.2).

• Will the album be a "hybrid" DVD that includes DVD-ROM material 
(content stored outside the disc’s DVD-Audio and DVD-Video 
directories)?
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• What capacity DVD (i.e. DVD-5, DVD-9, or DVD-10) will be needed to fit 
all the material planned for inclusion on the album?

PROJECT DESIGN AND ASSET LIST

As the answers to the questions above become known, it’s possible to 

develop an overview of what the title will consist of and how it will be 

organized. Variously referred to as a template, flowchart or storyboard for 

the title, this design document serves as the "blueprint" to be referred to 

throughout the production process. 

Note: While authoring is typically described as taking place after asset 

preparation, DVD-Audio Creator’s Author application may be used to 

define the template for a project during the project design phase.

From the project design, you can derive a list of required source "assets" 

(presentation data files). The asset list will include: audio sources, graphic 

files, video sources, and text files. 

As an example, let’s look at a DVD-Audio — designed for both US and 

Japanese release — that includes DVD-Video content. The title is made up 

of two main parts: 

• a 75-minute audio segment will consist of 15 tracks in high-resolution 
(24-bit/96kHz) PCM surround sound, accompanied by still images, 
subpictures, and text. 

• a 90-minute concert video documentary will use a Dolby Digital 5.1 
surround soundtrack.

For this production one would need the following assets:

Table 1: Source assets for example DVD title.

Audio • Source for 6-track music program (24-bit/96 kHz)
• Source for 5.1 channel video soundtrack

Video • Video source tapes

Slideshow/Stillshow • TIFF graphic files for still images
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The asset list would become more detailed as the filenames of specific 

source files are defined. 

2.2.2 Asset Preparation

In general, before DVD-Audio Creator is used in the production process, 

the source files for all the assets have already been prepared in other 

applications. For instance, audio may be prepared in SonicStudio HD and 

OneClick DVD, while motion video material may be prepared in Scenarist, 

DVD Creator, or DVD Fusion for Macintosh. 

A brief overview of asset preparation for different media types is provided 

here. For more detailed information, see Chapter 13 in this Guide, as well 

as the User Guides for the other software applications mentioned.

AUDIO ASSETS

The primary type of audio used in DVD-Audio is PCM (pulse code 

modulation). Two types of PCM are supported:

• Linear PCM (LPCM) is completely uncompressed, and is stored in the 
.bin file format. 

• Meridian Lossless Packing (MLP) uses a lossless compression scheme, 
allowing a greater volume of audio data to be stored and transmitted, 
while ensuring playback that is bit-for-bit identical with the original 
source. MLP is stored in the .mlp file format.

Menus • TIFF graphic files for menu Backgrounds, Overlays 
and Button Hotspots

Text • English lyrics (TIFF graphics files) with time 
references

• Japanese lyrics (TIFF graphics files) with time 
references

Table 1: Source assets for example DVD title.
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The workflow for preparation of audio assets is as follows:

• Master the audio material in SonicStudio HD, including the channel 
assignments for each Track.

• Set the Start and End marks (PQ codes) for each Track, and print out a 
PQ list.

• Export the EDL in SonicStudio version 5.4 format.

• Open the EDL in OneClick DVD, and specify the target audio format 
(.mlp or .bin) in the drop-down list in the Open dialog. If the target 
audio format is MLP (.mlp), set the SMART downmix coefficients for 
any multi-channel tracks for which you will not be preparing a separate 
stereo mix.

• Specify the filename and destination folder for the .mlp or .bin file.

• After the encoding to .mlp or .bin, FTP-transfer the "Sources" folder 
generated by OneClick DVD to the machine running DVD-Audio 
Creator. 

GRAPHIC ASSETS

DVD-Audio Creator supports the use of still pictures in two main scenarios:

• Slides — on-screen still pictures that do not utilize any buttons. Slides 
are displayed during playback of Audio Tracks during Slideshows and 
Stillshows.

• Menus — on-screen still pictures that utilize buttons. Menus may be 
displayed as part of an album’s menu structure (Single-Page Menus), or 
during playback of Audio Tracks (Single-Page Menus, Linked Lyrics 
Menus, and Multi-Page Menus within Slideshows and Stillshows).

Whether a still picture is a Slide or a Menu, if it is displayed during Audio 

Track playback it is referred to as an ASV (Audio Still Video).
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Still pictures are prepared in the TIFF (.tif) format using a bitmap editing 

application such as Adobe Photoshop™. If you are using the standard 

television aspect ratio of 4:3, graphics for both Slides and Menus are 

prepared as follows:

• Create the graphic at 720 x 540. Make sure all important parts of the 
graphic fall within the NTSC safe area (not less than 10% from the edge 
of the image), and that the graphic uses only colors within the NTSC 
color palette.

• Scale the graphic to 720 x 480 for an NTSC album or 720 x 576 for a 
PAL album.

If, on the other hand, the aspect ratio for your album is 16:9, graphics are 

prepared as follows:

• Create the graphic at 960 by 540. Make sure all important parts of the 
graphic fall within the safe area, and that the colors used are within the 
NTSC color palette.

• Scale the graphic to 720 x 480 for an NTSC album or 720 x 576 for a 
PAL album. The scaled graphics will look vertically compressed on a 
computer, but will appear at the proper aspect ratio when displayed on 
a widescreen (16:9) television.

Slides are made up of only one layer (Background). To make a Menu, 

however, you will need to output either two or three layers from the image 

editing tool. The layers are defined as follows:

• Background — a 24-bit color file (used for both slides and menus) that 
contains the visible image displayed during playback.

• Overlay — a 2-bit mask for shapes, including text, that are displayed 
over the background image:

- An overlay file may contain up to four colors (no aliasing), each of 
which is mapped during authoring to a color and transparency level 
that will actually be displayed during playback. 

- The playback colors are drawn from a 16-color palette defined 
during authoring for each of the album’s Menus. 
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- Color and transparency mapping may be defined for three button 
states: Normal (outside the hotspot of the selected button), Select 
(button selected), and Action (button activated, usually by end-user 
pressing ENTER key on the remote).

• Button Hotspots — a mask for the rectangular areas of the screen 
associated with each button (no overlapping allowed). For example, 
when a button is in a selected state, the hotspot defines the area of the 
screen in which the overlay mask is mapped to Select colors rather than 
Normal colors. 

- If no Hotspots layer is provided, DVD-Audio Creator will 
automatically derive the hotspots from the areas defined in the 
overlay mask. 

Note the importance of the naming conventions used for the Background, 

Overlay and Button Hotspots files. The filenames allow DVD-Audio Creator 

to correctly identify the files as a set associated with a given menu. The 

naming conventions vary depending on the whether the Menu is Single-

Page, Multi-Page, or Linked Lyrics (see Chapter 5, section 5.2).

DVD-VIDEO ASSETS

The DVD-Audio format allows an album to include Video Tracks in the DVD-

Video format, though the DVD-Audio specification places some additional 

limitations on DVD-Video material beyond those of the DVD-Video 

specification (see Chapter 6, section 6.1.2). 
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Before DVD-Video material can be imported into a DVD-Audio Creator 

project, it must be prepared in a DVD-Video authoring application such as 

Scenarist, DVD Creator, or DVD Fusion:

• Create DVD-compliant MPEG-2 video streams by capturing the motion 
video on a workstation equipped with encoding hardware, or by 
transcoding existing video files.

• Capture or transcode audio into DVD-Video compliant LPCM, Dolby 
Digital, or DTS files.

• Author the DVD-Video content in Scenarist, DVD Creator, or DVD 
Fusion for Macintosh. The authored content must comply with the DVD-
Video limitations of the DVD-Audio specification.

• Modify the script for the video content to prepare it for use in DVD-
Audio Creator (see Chapter 13, section 14.3.X)

• Output a valid VIDEO_TS volume and transfer it to the machine running 
DVD-Audio Creator.

Album Production

Once an album’s assets are prepared, DVD-Audio Creator handles the 

following stages of album production:

• imports assets into the project

• creates the navigational structure and links that allow users to access 
the album’s contents

• formats the content (presentation data) and navigational information 
(logical data) into a specification-compliant disc image, which may be 
written to a DLT tape for replication in a DVD plant, or to a hard-drive 
for transfer to DVD-R (DVD-5 only)

The specific stages of production, and the DVD-Audio Creator applications 

used to accomplish them, are outlined below.
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PROJECT STRUCTURE

DVD-Audio Creator requires the presence on a local hard-drive of a specific 

directory structure (set of folders) that is used by the various DVD-Audio 

Creator applications during the album production process. At the start of 

each project, this structure is a folder that contains six empty folders 

named as follows: AUDIO, AUTHORSCRIPT, IMAGE, MENU, PUBLISH, and 

VOB.

A ready-made empty directory structure, named "PROJECT," may be found 

at the root level of the DVD-Audio Tutorial CD-ROM. The structure may also 

easily be created manually using Windows Explorer. See Chapter 3 for 

further information. 

Note: Throughout the subsequent chapters of this User Guide, the words 

"PROJECT folder" are used to refer generically to the project directory 

structure described above (even if the folder itself has been given a 

different name). 

ASSET IMPORT

• Use Import Audio to import audio files, and to provide the settings and 
information DVD-Audio Creator needs to use the files. This includes 
setting downmix coefficients (if needed) for non-MLP SMART content, 
as well as manually entering the Start and End times of Audio Tracks in 
files that contain more than one Track (e.g. continuous program such as 
a live album). The times come from a PQ list output from SonicStudio 
HD.

• Use Import Menu to import the graphics files (.tif) for the Background, 
Overlay, and Button Hotspot components of each Menu.

• If the album includes DVD-Video content, use Import Video to import a 
VIDEO_TS folder containing a DVD-Video volume output by Scenarist, 
DVD Creator, or DVD Fusion for Macintosh.
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AUTHORING

• Use Author to create a visual representation defining the overall 
structure of the album, including its Menus, Groups, Tracks, and Slides 
(this step may actually be performed at the outset of a project as part of 
the project planning stage), and to assign imported assets to each part 
of the structure. 

• Use Command Editor to define links between the parts of the album 
structure, including the action and destination of all buttons. Command 
Editor is also used to define default button selection, Menu palettes, and 
the color-mapping for Normal, Select, and Action button states.

PROJECT OUTPUT

• Use Format to format the project’s presentation data (audio, graphics, 
video) and logical data (album structure and links) into files that can be 
read and interpreted by a DVD-Audio player during album playback.

• Use Imager to organize the formatted files into the exact directory 
structure that will be present on the final DVD, and to output this "disc 
image." The image may be written to a DLT tape to send to a replication 
plant. Or it may be written to an external hard-drive, from where it can 
be transferred to a DVD-R using the DVD-R writing application that 
comes with your DVD-R drive (see Chapter 11).
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The DVD Product ion Workgroup

DVD-Audio Creator may be used in a completely independent setup, using 

input files from portable media such as removable hard-drives or DVD-RAM. 

However, to make the process of working on DVD-Audio albums most 

efficient, Sonic recommends networking the workstations used for the 

various tasks into an integrated production environment.

[IMAGE & CAPTION: DVD Production Fig. 9.1]
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An integrated workgroup allows each person involved in the process to 

work as productively as possible on their own, without being limited to the 

throughput of the slowest area of production. At the same time, the 

network allows an easy flow of files back and forth between all production 

areas.

[IMAGE & CAPTION: DVD Production Fig. 10.3]

While the diagram above shows a separate workstation for each task, in 

reality more than one task may be handled by each workstation. The 

number of workstations needed will depend on the workload (and thus the 

required throughput) of the production facility. At a minimum, however, a 

DVD-Audio workgroup would consist of the following:

• an Apple Macintosh™ computer running SonicStudio HD and OneClick 
DVD

• an IBM-compatible PC with the Microsoft Windows operating system 
(Windows 2000 or higher) running DVD-Audio Creator

• DVD Creator or DVD Fusion for Macintosh running in a partition on the 
Macintosh, or Scenarist running on the PC 

• a network setup supporting FTP file transfer between Macintosh and 
Windows computers

Workflow for integrated DVD production environment
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3 Creating a Project Structure
DVD-Audio Creator requires the presence on a local hard-drive of a specific 

directory structure (set of folders) that is used by the various DVD-Audio 

Creator applications during the album production process. 

At the start of each project, the project structure is a folder that contains 

six empty folders named as follows:

AUDIO
AUTHORSCRIPT
IMAGE
MENU
PUBLISH
VOB

Using the Tutor ial  PROJECT Folder

A ready-made empty directory structure, named "PROJECT," may be found 

at the root level of the DVD-Audio Tutorial CD-ROM. 
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The PROJECT folder may be used in one of the following ways:

• Before beginning work on each new album, copy the entire PROJECT 
folder from the Tutorial Assets CD-ROM to a local hard-drive (not to the 
empty SCSI "disc image" drive reserved for writing projects to DVD-R). 

• Keep a blank copy of the PROJECT folder on your hard-drive and 
duplicate it before starting work on each album.

Once the PROJECT folder is present on your local hard-drive, the folder 

may be re-named for the specific album on which you are working. 

However, do not rename or otherwise change any of the folders contained 

inside.

Note: Throughout the subsequent chapters of this User Guide, the words 

"PROJECT folder" are used to refer generically to the project directory 

structure described above (even if the folder itself has been given a 

different name). 

Creat ing a  Project  Structure  Manually
If you do not have access to the DVD-Audio Tutorial CD, and you do not 

have an empty PROJECT folder on your hard-drive, the project directory 

structure may easily be created manually using Windows Explorer. 

To create a project directory structure:

1 Open Windows Explorer.

• Choose Programs > Windows Explorer from the Windows Start menu. 
Windows Explorer will appear.

2 Choose the hard-drive for the project.

• In the Folders list at the left side of the Windows Explorer window, click 
on a hard-drive to select it. 

• You must choose a local hard drive. Do not choose the dedicated SCSI 
hard-drive (empty of all data) that you will use to store a disc image of 
the project in preparation for writing a DVD-R.
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3 3. Create the PROJECT folder.

• Choose File > New > Folder. A folder labeled New Folder will appear in 
the left-hand list under the selected hard-drive. 

• Click on the folder once to select it, then again to edit its name.

• Type PROJECT (or another name of your choosing), then press the 
ENTER key.

4 Create the project’s subdirectories.

• With the PROJECT folder selected in the left-hand list, choose File > 
New > Folder. A folder labeled New Folder will appear in the right-hand 
list in the Windows Explorer window. The label will be highlighted.

• Type AUDIO, then press the ENTER key.

• Repeat the steps above five more times, typing the following names for 
the added folders: AUTHORSCRIPT, IMAGE, MENU, PUBLISH, VOB.

5 Confirm the setup.

• On your chosen hard-drive you should now have a folder named 
PROJECT (or any other name of yourt choosing).

• Inside the PROJECT folder, you should see the following six empty 
folders: 

AUDIO
AUTHORSCRIPT
IMAGE
MENU
PUBLISH
VOB

Once the directory structure for the project is defined, you’re able to start 

working with DVD-Audio Creator to create a DVD-Audio album.
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4 Import Audio
Import Audio is used to import audio source files into the project directory, 

and to define the resolution, channel configuration, and downmix 

parameters for each Audio Track, as well as to define multiple Audio Tracks 

in an Audio-only Title (AOTT) that is based on a single source file. It also 

creates an audio info file (in the XML format) for each Track that is used in 

subsequent steps of the DVD-Audio Creator production process.

Import Audio is not used to determine the placement of a given Audio Track 

within the overall structure of a DVD-Audio album. This is defined later 

using DVD-Audio Creator’s Author application (see Chapter 7). It is also not 

used to add a second stream (PGC Block) to an Audio Track in an AOTT 

Audio Title (see Chapter 12, section 12.1), to add a Silent Cell before an 

Audio Track (see Chapter 12, section 12.2), or to define Indexes and 

Spotlights within Audio Tracks (see Chapter 12, section 12.3).
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To launch Import Audio:

• Choose Programs > DVD-Audio Creator > Import Audio from the 
Windows Start menu.

To exit Import Audio:

• Click Exit in the lower right of the Import Audio window.

WORKFLOW

The typical workflow for importing the first audio file into a DVD-Audio 

Creator project is as follows:

1 Prepare the source audio files using SonicStudio HD and OneClick DVD 

(see Chapter 13, “Asset Preparation”).

2 Specify the format (.aif, .wav, .bin, or .mlp) of the file or files containing 

audio for the Track.

3 Set the Import Type.

4 Specify the source file or files to be imported.

Import Audio window
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5 Specify the Destination Directory.

6 Set the channel assignment (.aif, .wav, and .bin only).

7 Set the resolution (.bin only).

8 If the Track is multichannel and the album will not include a separate 

stereo mix of the Track, set the downmix parameters (.aif, .wav, and .bin 

only).

9 If a single file contains more than one Track (e.g. a live album with 

continuous program), define the start and end times of each Track.

10 Confirm the Audio Track data settings.

11 Import the file.

Import Audio allows you to import multiple audio files into your project 

without re-entering all the settings for each file. After the first file, you need 

only change those settings that are different for each subsequent file. For 

instance, if the source files for all your audio tracks are in the same format, 

channel assignment, and resolution, you may leave those settings as they 

are, but you will still need to specify the filepath for each new source file.

Audio Fi le  Formats
Import Audio works with source files in the following formats:

• AIFF (.aif)

• WAV (.wav)

• DVD (.bin)

• MLP (.mlp)

AIFF, WAV, and DVD are all Linear PCM formats with no data compression. 

MLP, however, uses lossless compression (Meridian Lossless Packing) to 

allow storage and transmission of a greater volume of audio data, making 

possible multichannel sound at high resolutions. While MLP stores audio 



44 Chapter 4, Import Audio
data more efficiently than LPCM, it has no effect on audio fidelity. The 

decoded output of an MLP-encoded signal is bit-for-bit identical with the 

original source.

Import Audio does not import audio files in the Dolby Digital (AC-3) format 

(or in any other formats defined as “optional” in the DVD-Audio 

specification). DVD-Audio Creator does not support the creation of Audio 

Tracks containing audio streams in optional audio formats. However, DVD-

Audio Creator does support the import of DVD-Video material that includes 

a Dolby Digital audio stream (see Chapter 6, “Import VIDEO_TS”).

Note: Import Audio uses the three-letter extensions at the end of the 

filename to determine the format of source files. Do not include any 

characters other than the extension to the right of the period in the 

filename. 

Specify the File Format

To specify the format of the file that you are going to import:

• Click on the appropriate button in the File Format pane at the upper 
left of Import Audio’s main window.

Fi le  Import  Set t ings

In addition to digital audio data, AIFF, WAV, and MLP files contain further 

information (metadata) about how the file’s audio content should be played 

back. This information affects the settings required when files in these 

formats are imported into a project with Import Audio. 

File Format for Import Audio
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AUDIO FILE METADATA

AIFF, WAV, and MLP files each contain information defining the number of 

channels, the sample-rate (FS), and the word-length (Q). Because DVD 

(.bin) files do not contain this information, these parameters are defined 

manually for .bin files in Import Audio.

Additionally, the MLP encoding process builds into each MLP file the 

downmixing coefficients for the SMART content playback system included 

in every DVD-Audio player (see Appendix XX). Because these coefficients 

are already built into the encoded MLP data, they cannot be set or changed. 

Downmixing coefficients for AIFF, WAV, and DVD files, however, are set in 

Import Audio. 

CHANNEL GROUPS AND CHANNEL ASSIGNMENTS

DVD-Audio supports high-resolution sound in multichannel configurations 

of up to six discrete channels. However, the format’s maximum data-rate 

allocable to audio — 9.6 Megabits per second — places limits on the total 

data bandwidth available to spread among the channels. These constraints 

are addressed in part by the use of MLP (to reduce bandwith 

requirements), and in part by the use of mixed resolutions, which allow an 

album’s producer to prioritize the allocation of bits among the channels in 

a given Audio Track.

In DVD-Audio’s mixed resolution system, each channel in a Track is 

assigned to one of two "Channel Groups," with the resolution (sample-rate 

and word-length) of Group 1 always greater than or equal to that of Group 

2. Within a given Track, the sample-rates used for all the channels in both 

Channel Groups must be from the same family (either 48/96kHz or 

44.1/88.2kHz). The assignment of channels to Channel Groups may be 

changed with each Audio Track.

To regularize the use of mixed resolutions among channels, the DVD-Audio 

specification supports 21 different channel assignments.
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Table 2: DVD-Audio channel assignments for two groups

ch0 ch1 ch2 ch3 ch4 ch5

1 C

Priority to 
fron L and R

2 L R

3 L R S

4 L R Ls Rs

5 L R Lfe

6 L R Lfe S

7 L R Lfe Ls Rs

8 L R C

9 L R C S

10 L R C Ls Rs

11 L R C Lfe

12 L R C Lfe S

13 L R C Lfe Ls Rs

14 L R C S

Priority to 
front

L, R, and C

15 L R C Ls Rs

16 L R C Lfe

17 L R C Lfe S

18 L R C Lfe Ls Rs

Priority to corners: 
L, R, Ls, Rs

19 L R Ls Rs Lfe

20 L R Ls Rs C

21 L R Ls Rs C Lfe

Channel Group1 Channel Group2

Key: C = center; L = front left; R = front R; S = surround (mono); LS = left surround;
Rs = right surround; Lfe = low frequency effects (subwoofer)
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Import Audio can accept source files in any of these 21 supported channel 

assignments. However, if you are preparing audio files for import using 

OneClick DVD, note that OneClick DVD accepts files only in one of the 

following channel assignments:

• Channel Assignment 0: C (mono)

• Channel Assignment 1: L, R

• Channel Assignment 2: Lf, Rf + S

• Channel Assignment 3: Lf, Rf + Ls, Rs

• Channel Assignment 19: Lf, Rf, Ls, Rs + C

• Channel Assignment 20: Lf, Rf, Ls, Rs + C, LFE

Setting the Import Type

The Import Type pane at the left of the window is used to tell Import Audio 

how distribute the audio channels in the source file among the two 

possible Channel Groups.

There are three possible Import Type settings:

1File for 1Group  Used when the channel assignment is either mono or 

stereo, and therefore only Group 1 is used in the Track. 

1File for 2Groups  Used when all the channels for Group 1 and Group 2 are 

included in a single source file.

2Files for 2Groups  Used when the channels for Group 1 are in one file and 

the channels for Group2 are in a different file.

Import Type for Import Audio
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Click on the radio button corresponding to the correct setting for the 

source file(s) that you are importing.

Designating the Source Files

Once Import Audio knows how many files are associated with a given 

Track, you can specify the audio source files. The main Import Audio 

window includes two filepath fields for source files. The fields are located 

just below the Import Type pane.

The filepath field labeled File1 is always active. The filepath field labeled 

File2 is active only if the Import Type setting is set to 2Files for 2Groups. 

To set the source file for File1:

1 Click the Browse button ("…") next to the File1 field. An Open File 

dialog will appear. 

2 Use the dialog to locate and select the source file.

3 Click Open. The dialog will close, and the filepath will be displayed in 

the field.

If the Import Type setting is set to 2Files for 2Groups, repeat the steps 

above to set the source file in the File2 field.

Source Files and Destination for Import Audio
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Specifying the Destination directory

The Destination directory is the folder within the overall project structure 

to which Import Audio will write the files it creates during an import.

To specify the Destination directory.

1 Click the Browse button ("…") to the right of the "Destination" name-

field at the bottom left of the main Import Audio window. A Browse 

dialog will appear. 

2 Find the AUDIO folder within your current project’s PROJECT folder. 

Click on the folder to select it.

3 Click OK. The dialog will close.

Setting the Channel Assignment (.bin only)

The Ch Assignment setting tells Import Audio the correct channel 

assignment for the audio channels in the source file. Because the AIFF, WAV, 

and MLP formats include channel metadata built into the file, this setting is 

set automatically based on the Import Type and source filepath (File1, 

File2) settings. 

For DVD (.bin) files, the Ch Assignment setting is made manually in the Ch 

Assignment pane, found to the right of the Import Type pane. 
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The DVD-Audio format supports 21 different channel assignments, which 

are listed on the drop-down list. For each assignment that involves two 

Channel Groups (assignments 3-21), the channels assigned to Group 1 are 

shown before the "+" sign, while the channels assigned to Group 2 are 

shown after.

To set the channel assignment:

• Click on the drop-down list and choose the correct assignment for the 
source file you are importing.

Note: If you choose a channel assignment that does not correspond with 

the Import Type setting or the number of audio channels in the source file, 

an alert dialog will inform you that the channel assignment you have 

chosen is illegal, and the channel assignment will not be changed.

Channel Assignment for Import Audio
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Setting the Resolution (.bin only)

The resolution of a given channel is determined by its sample-rate (Fs) and 

word-length (Q). When importing a source file in the AIFF, WAV, or MLP 

format, the file’s resolution attributes are set automatically based on 

metadata in the file. However, when importing DVD (.bin) files, these 

attributes are set manually in the Ch Group 1 and Ch Group 2 panes at the 

upper right of the main Import Audio window. 

If the current Ch Assignment setting is "C" (mono) or "L, R" (stereo), only 

one group is used in the Audio Track, and the Ch Group 2 pane will be 

inactive.

FS AND Q

As noted earlier, the resolution of Group 1 is always equal to or greater 

than that of Group 2. At the same time, the Fs of both groups must be from 

the same sample-rate family. Thus the Fs and Q settings in the Ch Group 1 

pane affect the options available in the Ch Group 2 pane. 

Channel Group settings for Import Audio
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To specify the Fs and Q:

• Fs — specify the sample-rate of the audio channels in Group 1, 
choosing from either the 44.1 kHz family (44.1/88.2/176.4) or the 
48kHz family (48/96/192). Then, if the Track uses two Channel Groups, 
choose from the available options to specify the sample-rate of the 
audio channels in Ch Group 2.

• Q — specify the word length (16-, 20-, or 24-bit) of the audio channels 
in Group 1. Then, if the Track uses two Channel Groups, choose from 
the available options to specify the word-length of the audio channels in 
Ch Group 2.

NUMBER OF CHANNELS (CH)

Within each pane, the number of channels (Ch) in the Group is set 

automatically based on the current setting in the drop-down Ch Assignment 

list. Changing the number of channels with the Ch buttons will change the 

current channel assignment. If you change the Ch buttons, be sure to 

double-check the effect of the change on the channel assignment shown in 

the drop-down list.

Setting Downmix Parameters (.aif, .wav, and .bin only)

As noted earlier, if a separate stereo mix of a given multichannel Audio 

Track is not provided on an album, SMART downmix coefficients are 

required to tell DVD-Audio players how to downmix the multichannel Track 

to stereo outputs for playback on a two-channel system. (The downmix is 

only performed if the playback configuration is set to stereo in the player’s 

setup menu.)

For AIFF, WAV, and DVD files, downmix coefficients are set in Import 

Audio’s Down Mix level dialog. Depending on how they are prepared, MLP 

files may already include the information required to support SMART 

downmixing. 
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Note: If the File1 source file is changed to a new file after downmix 

parameters are set in the Down Mix level dialog, the parameters will all be 

reset to their default values (0 attenuation and normal phase).

To set SMART downmix parameters:

1 Open the Down Mix level dialog.

• Find the Down mix sub-pane in the bottom center of the main Import 
Audio window.

• Click the checkbox labeled Valid. (If the checkbox is not active, the 
source file is either in MLP format or is not multichannel.) The Edit 
button to the right of the checkbox will become enabled.

• Click the Edit button. The Down Mix level dialog will appear.

• The dialog is laid out as a table. Each channel in the multichannel mix is 
represented as a row. Each channel in the stereo mix (left and right) is 
represented by two columns, one for level (COEF) and one for phase 
(PH). 

Down Mix Level dialog
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2 Set the levels for the downmix.

• For each channel in the multichannel mix, enter a value in the left and 
right COEF columns. The number entered defines the amount in dB by 
which the level of the channel is to be attenuated in the corresponding 
channel (left or right) of the stereo mix. For infinite attenuation (-∞), 
use the "Backspace" or "x" keys on the computer keyboard.

• The numbers entered will be rounded slightly by Import Audio to the 
nearest value that corresponds to the 256 levels defined by the DVD-
Audio specification. After entering all the COEF values, click the 
Calculate button at the bottom of the dialog to see the actual levels that 
will be used.

Note: Level attenuation is used not only to control the balance of the 

source channels in the downmix, but also to avoid excessive levels and 

distortion when signals from multiple source channels are combined into 

left and right downmix channels. In general, the average attenuation of 

the source channels assigned to a given downmix channel increases with 

the total number of source channels assigned to the same channel. Be sure 

to test your downmix parameters in SonicStudio HD to confirm that 

neither channel of the stereo mix will exceed 0dBfs when the parameters 

are applied.

3 Set the phase for the downmix.

• For each channel in the multichannel mix, set the phase in the left and 
right PH columns. The setting — normal or inverted — determines the 
phase of each channel in the multichannel mix when the channels are 
downmixed to stereo.

4 Exit the dialog.

• When the COEF and PH settings are complete, click OK to exit the 
dialog. 

• When the dialog is closed, a file (trackname.DMX) is created by Import 
Audio that contains the current downmix parameter settings in a 
"DVDMIXLIST" XML tag. The file is stored in the Destination directory 
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until the source file is imported (see section 4.5 below), at which time 
the .DMX file disappears and the DVDMIXLIST tag is incorporated into 
the trackname.XML file for the Track.

SAVING CHANGES TO DOWNMIX PARAMETERS (.AIF, .WAV AND 

.BIN ONLY)

Whenever changes are made to downmix parameters and the Down Mix 

level dialog is closed by clicking OK, Import Audio looks for the 

trackname.DMX file in the Destination directory (see above). 

• If the .DMX file exists, its values are revised to reflect the changes to the 
Down Mix level dialog. 

• If the file is not found, Import Audio creates a new .DMX file. 

• If the current File1 source file has already been imported to the project, 
the Save button below the Down mix pane in the main Import Audio 
window becomes active. Clicking on Save inserts the the .DMX file’s 
DVDMIXLIST tag into the filename.XML file for the Track. The .DMX file 
then disappears from the folder.

Fi les  Containing Mult iple  Audio  Tracks
In most cases, a source file will contain audio for only a single Audio Track. 

However, in the case of concert albums, segues between Tracks, or other 

program where the transition from one Track to the next occurs during 

audio program, a source file may contain audio for two or more Tracks. In 

this situation, the start and end times of each Track in the file must be set 

manually in Import Audio.

The start and end times are set by entering timecode values. The source of 

these values would typically be a list of start and end times printed out 

from the audio mastering system (e.g. SonicStudio HD).
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The Track Editor dialog

Track start and end times are set in the Track Editor dialog. The Source and 

Destination files for the import must be specified before the Track Editor 

dialog will open.

Note: If the File1 source file is changed after Tracks are defined in the 

Track Editor dialog, the Track List in the dialog will revert to a single Track 

with the duration of the new File1 source file.

To open the Track Editor dialog:

1 Find the Track Editor sub-pane in the bottom center of the main Import 

Audio window.

2 Click the checkbox labeled Valid. The Edit button to the right of the 

checkbox will become enabled.
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3 Click the Edit button. A progress bar will appear, indicating that the 

duration of the source file is being scanned. When the scanning is 

complete, the Track Editor dialog will appear.

The top section of the Track Editor dialog displays the following 

information:

• Number of Tracks — the number of Tracks currently defined in the 
source file

• Audio file duration — the duration of the file expressed in the current 
time-code format

• TC — a drop-down list used to choose the timecode format used for 
start and end times in the Track list and the Set Track Information dialog. 
The three available options — 30 NDF, 29.97 NDF and 29.97 DF — are 
the most common timecode formats formats used in SonicStudio HD 

Track Editor dialog for Import Audio
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projects. Choose the option corresponding to the timecode format used 
in the EDL from which you will be reading the start and end times of 
the Tracks.

• Audio File Start TC — This field defaults to the correct setting: 
00:00:00:00. Do not enter a different value. [MEI’s latest explanation of 
the use of this field is incomprehensible (see my reply to Matt 10/3)]

The top section of the Track Editor dialog also includes the following 

buttons:

• Add — adds a new track.

• Delete — deletes the selected track

• Edit — opens the Set Track Information dialog. The dialog may also be 
opened by double-clicking on a Track in the Track list.

• Proof — opens a dialog displaying audio stream information for the 
selected Track, and allowing the Track to be played back. See section 4.4 
below for information on this dialog.

The main body of the Track Editor dialog is made up of the Track list, which 

shows the following information:

• IN, OUT and Duration for each track expressed in time-code (columns 
2-4). 

• IN, OUT and Duration for each track expressed in seconds (columns 
5-7). 

• The RTI data file for the track (column 8).

Note: IfAt the time of this writing, no DVD-Audio players are available 

that support RTI (Real Time Information) playback. RTI is not a supported 

feature of DVD-Audio Creator at this time.

When the Track Editor dialog is initially opened, the source file will appear 

in its entirety as Track 1 in the Track list. the Track will be highlighted 

(white text against dark blue background).
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Defining Multiple Audio Tracks in a File

Audio Tracks are added in the Track Editor dialog. The start and end times of 

each Track are then defined in the Set Track Information dialog.

To add Tracks:

1 Click on the Add button in the Track Editor dialog. A new Track will 

appear in the Track list, with no times defined. The highlight will shift to 

the new track. The background color of the highlight will be magenta, 

indicating that valid IN and OUT times have not yet been entered for 

the Track.

2 Repeat the step above until the number of Tracks shown in the Track list 

equals the number of Tracks to be defined in the file. As each Track is 

added, the highlight will shift to the new Track, while the lettering of 

the other new Tracks will be magenta, indicating that they still do not 

have valid IN and OUT times.

To define start and end times:

1 Click on Track 1 to select it.

2 Click on the Edit button. The Set Track Information dialog will appear.

[IMAGE: Set Track Information dialog]

Set Track Information dialog for Import Audio
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3 Enter the start and end times for Track 1 in the IN and OUT time-code 

fields in the Set Track Information dialog. (Ignore the RTI Data file field; 

see above.) The minimum duration for a Track is one second. 

4 Click the up arrow. The Track No. display at the left of the dialog will 

change to 2. Enter the start and end times for Track 2 in the IN and OUT 

time-code fields in the Set Track Information dialog.

Note: IfIn general, the start time for a given track should be identical to 

the end time of the preceeding track. If there is a gap defined between the 

times, the portion of the source file within the gap will not be present on the 

final album (playback will be shortened by the duration of the gap).

5 Repeat the step above for each remaining Track in the Track list.

Note: IfIf the up arrow is clicked when the number in the Track No. 

display equals the total number of Tracks in the Track List, a new Track 

will be added to the List. This is an alternative to using the Add button to 

add Tracks.

6 If Import Audio detects an error in the times that are entered, an alert 

dialog will appear when clicking on the up or down arrows to move to 

a different Track.

7 When the start and end times for all Tracks are defined, click OK. If 

Import Audio detects errors in the list, an alert dialog will appear, and 

the track(s) with an error will appear in magenta text. If the list 

contains no errors, the Set Track Information dialog will close. 

To check the start and end of Audio Tracks:

1 Click on a Track to select it.

2 Click on the Check button. A Stream dialog will appear displaying audio 

stream information about the selected Track. The track may also be 

played back, allowing the defined IN and OUT points to be checked. 

See section 4.4 below for information on the operation of Stream 

dialogs.
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When all the Tracks in the file are defined and checked, click the OK 

button in the Track Editor dialog to close the dialog. When the dialog is 

closed, a track information file (filename.tki) containing the current Track 

Editor settings is created by Import Audio and stored in the Destination 

directory.

SAVING CHANGES TO TRACK EDITOR PARAMETERS (.AIF, .BIN AND 

.WAV ONLY)

Whenever changes are made to Track Editor parameters (adding new Tracks 

or changing start/end times) and the dialog is closed by clicking OK, 

Import Audio revises the track information file (.tki) in the Destination 

directory. If the current File1 source file has already been imported to the 

project, the Save button below the Down mix pane in the main Import 

Audio window becomes active at this time. 

Clicking on Save revises the filename.tki file, as well as the filename.XML 

files for each individual Track, without requiring that the source audio file 

be re-imported.

[explain use of "Only XML file" checkbox: for MLP files? for DVD files? need 

better info from MEI]

Displaying and Audi t ioning files  and Tracks ( .a i f ,  .wav,  
and .bin  only)

Import Audio includes a set of proofing functions that allow you to review 

audio file parameters to ensure correct settings. You can also view a 

waveform display of a source file, a Track, or an imported file (or a portion 

thereof). And you can listen to some or all of a file or Track. These features 

are accessed through Import Audio’s Stream dialogs.
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Opening a Stream Dialog

To open a Stream dialog:

• ...for a source file: In the main Import Audio window, click on the 
waveform icon to the right of the filepath field for File1 or File2 (if any). 
The icon will be active (blue) only after a filepath has been defined.

• ... for an imported file: In the main Import Audio window, click on the 
waveform icon to the right of the Elem Path filepath field. The icon will 
be active (blue) only after a file import has been executed during the 
current session.

• ...for a Track (when a source file contains two or more Tracks): In the 
Track Editor dialog, click on a Track to select it, then click on the Proof 
button.
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[IMAGE: Stream dialog for WAV file]

Stream Dialog Fields and Controls

Stream dialogs are broken into three main panes.

Steam dialog for Import Audio
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AUDIO DATA FILE INFORMATION

The Audio Data File Information pane for WAV and DVD (.bin) streams are 

identical. For AIFF streams, the pane is slightly different in layout, but 

displays essentially the same information.

For AIFF, WAV and DVD streams, the Audio Data File Information pane 

contains the following fields:

File Name  The name of the source file.

Number of channels  The number of channels in the source file.

Sample size  The word-length (Q) of the source file (number of bits per 

sample).

Sampling rate  (in Hz) The number of samples per second (Fs) of the source 

file.

Time length (hh:mm:ss)  The duration in of the source file (hours: minutes: 

seconds).

For WAV and DVD streams, the Audio Data File Information pane contains 

the following additional fields:

Total Samples  The total number of samples in the source file

DVD Audio Frames  The duration of the source file expressed in DVD-Audio 

frames. 

For AIFF and WAV files, all the information fields are for display only. For 

DVD files, the Number of Channels, Sample size, and Sampling rate fields 

may be set or changed in the Stream dialog. 

[Matt, you questioned this paragraph, but I doublechecked with a 2-

channel 16/44.1 AIFF file, a 2-channel 16/44.1 WAV file, and a mono 

16/44.1 WAV file (these are the only cases I had available to test). The 

statement is true for all these cases]
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If a source file contains more than two audio channels, and therefore 

requires two Channel Groups, the Audio Data File Information pane will 

contain a sub-pane for each Channel Group. Each sub-pane will contain the 

following fields: Number of Channels, Sample size, and Sampling rate.

DISPLAY INFORMATION

The Display Information pane allows you to define a section of the audio 

stream for waveform display. The defined section also determines the 

portion of the stream that plays back when using the Sound Playback 

feature (see below).

The Display Information pane includes the following fields:

• Begin — sets the start of the range of audio data for which waveforms 
are to be displayed and sound is to be played back

• End — sets the end point of the range of audio data for which 
waveforms are to be displayed and sound is to be played back

• Unit — sets the units in which the data range is expressed: DVD Frames, 
Seconds, or Samples

• Total Samples — displays the total number of samples included in the 
data range

• Wave format — sets the type of waveform display: Sampling point 
(amplitude waves) or Power wave

• Normalize — when the source file contains more than one audio 
channel, Normalize determines whether the amplitude values of the 
waveforms are shown as the absolute value for each channel ("No"), or 
as the relative values between channels ("Yes").

Steam dialog with Group1 and Group2
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The Display Information pane also includes the following buttons:

• Print — prints out the waveform data for the defined range.

• Display — displays the waveform data for the defined range. 

To open a waveform display:

1 Click on the Display button. A progress bar will appear while the 

waveform is being prepared for display using the current settings in the 

display information fields.

2 When the waveform analysis is complete, a waveform display window 

will open. To close the window, click the close button at the upper 

right.

SOUND PLAYBACK

The Sound Playback pane allows you to audition the portion of range the 

audio stream that is defined by the Begin/End fields in the Display 

Information pane.

The Sound Playback pane includes the following fields and controls for 

sound playback:

Play  Starts playback of the defined range

Stop  Stop playback.

Channel field  Specifies which channels to play.

• Level (horizontal fader) — sets the playback volume.

The Sound Playback pane also allows you to save the defined range as a 

separate WAV file using the following fields and controls.

Waveform Display for Import Audio
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File Name (field)  — allows you to type in a file name for the file 

• Browse (button) Å\ opens an Open dialog allowing you to specify an 
audio file to which you wish to write the currently defined playback 
range. During the Save operation, the existing audio data in the selected 
file will be replaced by audio data from the currently defined playback 
range. Alternatively, you may use the File name field in the Open dialog 
to define the name of a new file in the current directory.

Save  •— saves the currently defined playback range to the specified file

Executing an Import

Once all the file and track settings are complete, you can import source 

file(s) into your DVD-Audio Creator project.

To import a file:

1 Import the file.

• Click the Import button at the bottom right of the window. A Progress 
dialog will appear.

• When the import is complete, the Progress dialog will be replaced by a 
confirming dialog. Click OK.

IMPORT OPERATION RESULTS

After a file import operation, the files generated by Import Audio are found 

in the AUDIO folder within the PROJECT folder for the current project. 

The specific files generated depends on the source file format and the 

Tracks (if any) defined in the Track Editor dialog. For each source file 

filename.ext (the filename in a 2Files for 2Groups import is taken from 

File1), you will see the following files:

filename.Raw  a file containing audio data. One Raw file is generated per 

import operation. When importing 2Files for 2Groups, the audio data from 

both source files is combined into a single Raw file.
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filename.XML  Generated for each Track in the Raw file and contains 

information describing the Track and its parameter settings. XML flies are 

used by DVD-Audio Creator in subsequent production steps.

filename.tki  Contains Track parameter data derived from the Track Editor 

dialog when multiple Tracks are defined in the source file. One .tki file is 

generated per import operation.

filename.snc  Generated only when the source file is in MLP format.

filename _ADD.XML  [Matt is finding out their purpose]

IMPORTING ADDITIONAL SOURCE FILES

Import Audio allows you to import multiple audio files into your project 

without re-entering all the settings for each file. After the first file import, 

you need only change those settings that are different for each subsequent 

file. For instance, if the source files for all your audio tracks are in the same 

format, channel assignment, and resolution, you can leave those settings as 

they are, but you will still need to specify the filepath for each new source 

file.

To import additional files using the same format and settings:

1 Specify the audio file to import.

• Click the Browse button ("…") next to the "File1" name-field at the 
bottom left of the window. An Open File dialog will appear. 

• Click on the source file to select it. 

• Click Open. The dialog will close.

• If the file is for an Audio Track using two Channel Groups, and the 
Groups are in two separate files (i.e. Import Type = 2Files for 2Groups), 
repeat the steps above to specify the File2 source file. 
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2 Import the file.

• Click the Import button at the bottom right of the window. A Progress 
dialog will appear.

• When the import is complete, the Progress dialog will be replaced by a 
confirming dialog. Click OK.

Repeat the steps above for each subsequent file you wish to import into the 

current project. 
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5 Import Menu
In the DVD-Audio format, a menu is any displayed image that includes one 

or more buttons. Menus are used to navigate the DVD-Audio album, and 

can also be displayed while audio tracks play.

Some types of menus are divided into multiple "pages," meaning that they 

are made up of more than one screen. The maximum number of buttons on 

any page is 36.

Import Menu is used to import to the project the graphic source files (in 

TIFF format) that DVD-Audio Creator uses to create menus. When source 

files are imported, Import Menu outputs a set of XML files, used in 

subsequent steps of the DVD-Audio Creator production process, that 

contain information about menu parameters such as the highlight areas and 

the location of button hotspots.

For details regarding the requirements for and preparation of source TIFF 

files for DVD-Audio Menus, see Appendix B, “Asset Preparation.”
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Not all graphic source files used in a DVD-Audio Creator project need to be 

imported with Import Menu:

• Graphic files for slides (still pictures with no buttons) are brought into a 
project in Author (see Chapter 7, section 7.4.8).

• Graphic files for Overlay [and Button Hotspots? this isn’t addressed in 
the MEI explanation forwarded by Matt 10/25] for a pan/scan or 
letterbox Menu in a 16:9 albums need only be copied to the same 
location as the corresponding Background file imported by Import 
Menu for that Menu (see Chapter 13, section 13.2.4)

Import Menu is not used to determine the placement of a given Menu 

within the overall structure of a DVD-Audio album (this is defined later 

using DVD-Audio Creator’s Author application; see Chapter 7), or to define 

the commands associated with a Menu’s buttons (defined later using the 

Command Editor application; see Chapter 8), or to set the timing of 

changes in button selection in Linked Lyric Menus (defined later using 

Author).

To launch Import Menu:

• Choose Programs > DVD-Audio Creator > Import Menu from the 
Windows Start menu.

Import Menu window
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To exit Import Menu:

• Click the Exit button in the lower right corner of the main Import Menu 
window.

WORKFLOW

The typical workflow for importing the first set of Menu files into a DVD-

Audio Creator project is as follows:

1 Prepare the source TIFF files using a bitmap graphics program such as 

Adobe Photoshop™.

2 Specify the Source Directory containing the files to be imported.

3 Specify the Destination Directory within the project folder.

4 Set the Import Type.

5 Set the Subpicture Type.

6 Execute the import.

Import Menu is designed to import multiple sets of TIFF files into a project 

at the same time (all the source files to be imported at the same time must 

be stored in a common source directory). Because every Menu involves at 

least two source files, Import Menu uses the filenames to determine which 

source files are associated with each Menu. That makes it crucial to exactly 

follow the file naming conventions for source files (explained in section 5.2 

below).

Import Menu also allows you to execute multiple imports for a given 

project without re-entering all the settings for each set of source files. After 

the first import for a given project, you need only change those settings 

that are different for each subsequent set of files. For instance, if all your 

Menus use the same Import Type and Subpicture Type (see below), you can 

leave those settings as they are, and simply re-specify the filepath for each 

different set of source files.
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Menu Layers

A Menu is made up of two or more source files in TIFF format, one for each 

of the Menu’s layers. There are three basic types of layers. The Menu type 

determines the layers used.

BACKGROUND LAYER

A Menu’s Background layer is a 24-bit color file that contains the visible 

background image displayed during playback.

OVERLAY LAYER

The Overlay layer is a 2-bit mask for shapes, including text, that are 

displayed over the background image.

An overlay file may contain up to four key colors (no aliasing), each of 

which is mapped during authoring to a color and transparency level that 

will actually be displayed during playback. The playback colors are drawn 

from a 16-color palette defined during authoring (see Chapter 8, 

"Command Editor") for each of the album’s Menus. 

Menu composed of background layer (MPEG still), overlay layer, and 
optional button hotspot layer

Button 
Hotspot

Overlay Background Menu+ + =
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Color and transparency mapping may be defined for three button states: 

Select (button selected), Action (button activated, usually by the end-user 

pressing ENTER key on the remote), and Normal (outside the hotspot of 

the currently-selected button).

BUTTON HOTSPOTS LAYER

The Button Hotspot layer is a mask for the rectangular areas of the screen 

associated with the Menu’s buttons (no overlapping of buttons allowed). 

For example, when a button is in a selected state, the hotspot defines the 

area of the screen in which the overlay mask is mapped to Select colors 

rather than to Normal colors. 

If no file is provided to define the Button Hotspots layer, Import Menu may 

(depending on the Menu type) automatically derive the hotspots from the 

areas defined in the overlay mask. In this case the overlay for each button 

must be a single contiguous area. Import Menu will look for each 

contiguous area in the Overlay file, and automatically assign a button 

number to the defined areas based on their location, starting from the top 

left corner (horizontal axis takes precedence over vertical axis).

Note the importance of the naming conventions used for the Background, 

Overlay and Button Hotspots files. The filenames allow DVD-Audio Creator 

to correctly identify the files as a set associated with a given Menu, and to 

correctly assign each file to its intended function within the Menu.

Menu Types

DVD-Audio Creator supports three types of Menus for use in a DVD-Audio 

album. The Import Type pane is used to tell Import Menu the type of Menu 

for which files are being imported.
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Single-Page Menu

In a Single-Page Menu, the entire contents of the Menu is displayed on a 

single "page" (screen) with a maximum of 36 buttons.

A Single-Page Menu may be used in the following places within the 

structure of a DVD-Audio album:

• In the album’s Audio Manager Menu Domain (referred to in the 
specification as AMGM_DOM), Single-Page Menus may be used to 
navigate to Groups (playlists), Tracks, or to other Menus in the Menu 
domain.

• In the album’s Title Group Domain (referred to in the specification as 
TT_GR_DOM) a Single-Page Menu may be displayed during playback of 
Audio Tracks. The Menu may be used to navigate to other Tracks in the 
same Group, or to either Slides or other Menus within the same Track. 
When used in the Title Group Domain, a Single-Page Menu is referred to 
in the specification as an ASV (Audio Still Video).

Each Single-Page Menu is made up of the following layers:

• Background layer (menuname.tif) — required; one per Menu.

• Overlay layer (menuname_HL.tif) — required; one per Menu. 

• Button Hotspot layer (menuname_BTN.tif) — optional; one per Menu. 

- If no Button Hotspot layer is provided, hotspots will be defined by 
contiguous areas in the Overlay layer.

- The Button Hotspot file may define up to 36 buttons.

Multi-Page Menu

A Multi-Page Menu is used in an album’s Title Group domain to incorporate 

buttons into a series of pages (ASVs) displayed during playback of an Audio 

Track. The pages are used in a form of ASV display that the DVD-Audio 

specification refers to as "Browsable pictures." 
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Depending on the order and the duration of the display of the pages, DVD-

Audio Creator allows two situations within which a Multi-page Menu may 

be used: 

• Slideshow: 

- the default display duration is fixed at a certain number of seconds, 
making what is defined in the specification as a "Browsable pictures 
with automatic transition." A duration different from the default  may 
be specified in either Author or Command Editor.

- the display order may be set in Author to sequential, random, or 
shuffle

• Stillshow:

- the display duration is automatically set by Author to infinite ("0"), 
making what is defined in the specification as a "Sequential 
Browsable pictures without automatic transition." However, the 
setting may be modified later in Command Editor.

- the display order is preset by Author to sequential, and may not be 
changed

[the use of the term "Slideshow" above is in contradiction to the definition 

of Slideshows in the spec.]

For further information on Slideshows and Stillshows, see Chapter 7, 

section 7.4.7.

Each page of a Multi-Page Menu is an ASV (Audio Still Video) made up of the 

following layers:

• Background layer (menuname.tif) — required; one per page.

• Overlay layer (menuname_HL.tif) — required; one per page. 

• Button Hotspot layer (menuname_BTN.tif) — optional; one per page. 

- If no Button Hotspot layer is provided, hotspots will be defined by 
contiguous areas in the Overlay layer.

- The Button Hotspot file may define up to 36 buttons.
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Linked Lyrics Menu

A Linked Lyrics menu is a special type of Menu in which both the display of 

pages and the selection of buttons on those pages are programmed to 

change over time. Linked Lyrics Menus are used only in the Title domain 

(TT_GR_DOM) during playback of Audio Tracks. 

The timing of changes in button selection is defined by Marker times 

entered in the Markers tab of the Audio Track Properties window in the 

Author application (see Chapter 7). Each Marker in the Audio Track must be 

assigned a unique time (no two markers may be assigned to the same point 

in the Track’s timeline). 

Like a Multi-Page Menu, a Linked Lyrics Menu is made up of a series of 

ASVs, each of which displays as a background image with overlaid buttons. 

During playback, as the Audio Track reaches the time defined for a given 

Marker, the button that is in a selected state changes to the "marker-button" 

that is associated with that Marker. If the marker-button is on a different 

page, the player navigates to that page and selects the button. 

As the marker-button that is selected changes, so too does the button’s 

hotspot (the area of the screen within which the key colors in the Overlay 

layer are mapped to Select state colors). This allows the creation of effects 

such as synchronizing the highlighting of lines of lyrics, libretto, or liner 

notes to audio playback.

[IMAGE: Linked Lyric showing highlighted lyrics]

The end-user may manually change the selected marker-button using the 

Arrow keys (Left, Up, Right, Down) on the remote control. Activating the 

selected marker-button (pressing the ENTER key) will seek the playback of 

the Audio Track to the time defined for that button’s Marker.
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In addition to buttons associated with Markers, pages in a Linked Lyric 

Menu may also contain regular buttons that are not associated with 

Markers. Import Menu uses the filenames of the Menu’s Button Hotspot 

TIFF files to determine which files define marker-buttons, and to determine 

the order in which those buttons are linked to Markers.

Note: It is not possible within a Linked Lyrics Menu to have a page in 

which all buttons are regular buttons. Without at least one marker-button 

in a page, there is no way to define the time within the Audio Track at 

which that page displays.

MARKER NAMES AND TIMES

As noted above, the Markers in a Linked Lyric Menu are defined in the 

Markers tab of the Audio Track Properties window in Author (see Chapter 7, 

section 7.4.3). The tab shows an Audio Markers list and allows the entry of 

a unique time and name for each Marker.

[IMAGE: multiple markers in the Markers tab of the Audio Track Properties 

window in Author]

The appropriate name for a Marker depends on how it will be used. 

Markers may be used in one of two ways: 

• Button-selection change — when used only to define the time of a 
change in button selection within a given page, the names of Markers 
may be left as they are assigned by default in Author, or any new name 
may be entered by the user.  

• Page change — when used to define the time of a change in button-
selection to a button on a different page, Markers must be named "m1," 
"m2," etc. (continuously upcounting based on their defined times). 
Based on the filenames of the source files, Import Menu will 
automatically create a link to the marker-button associated with each of 
these Markers. During playback, that button will be the selected button 
when the new page is displayed.
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PAGE LAYERS AND FILENAMES

Each page is made up of one or more layers, one of which must be derived 

from either a Button Hotspot or an Overlay file.

During a Linked Lyric import, Import Menu assigns source files to page 

layers based on their filenames (in the following filename examples, "##" 

represents the page’s place in the series of pages, starting from "01"). As 

with other Menu types, there are three kinds of layers:

• Background layer (menuname_BG##.tif) — one per page. 

- A Background file is required for the first page in the Menu.

- For each subsequent page, if the Background image to be displayed 
is to be identical to that of the preceding page, the source file for the 
image need not be duplicated and provided as a separate file.

• Overlay layer (menuname_HL##.tif) — one per page.

- An Overlay file is required for the first page in the Menu.

- For each subsequent page, if the Overlay mask is to be identical to 
that of the preceding page, the source file for the mask typically 
need not be duplicated and provided as a separate file. However, if 
the hotspots for all buttons in the Menu are being derived from 
Overlay files (see below), then a separate Overlay file must be 
provided for each page. 

• Button Hotspot layer — the number and type (marker or non-marker) of 
buttons on each page determines the source files required for each 
page’s Button Hotspots, and how those files are named:

- Hotspots from Overlay files — if every button on every page in the 
Menu is to be a marker-button, and the hotspots for buttons on each 
page are to match the contiguous area(s) defined in the Overlay file 
for that page, then it is not necessary to provide separate source files 
for Button Hotspots. Import Menu will automatically derive the 
hotspots for each page from that page’s Overlay file. 
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Note: This approach requires that a separate Overlay file be provided for 

each page, even when the overlay mask is to be identical to that of the 

preceding page.

- Hotspots from Button Hotspot files — if the hotspots for any page in 
the Menu are not identical to the contiguous areas defined in the 
Overlay file for that page, or if some buttons in the Menu are not 
marker-buttons, then all pages in the Menu will require one or more 
Button Hotspot source files, with filenames as follows:
- If all the buttons on a given page are to be marker-buttons, then all 
the hotspots for that page may be defined within a single file 
(menuname_BTN##.tif).
- If the page is to include both marker-buttons and regular buttons, 
the hotspots for all the regular buttons are defined with a single 
source file (menuname_BTN##.tif), while the hotspot for each 
marker-button is defined in its own individual file 
(menuname_BTN##_nn.tif, where "nn" indicates the number of the 
marker-button within the page, starting with "01").

Subpicture  Type
The Overlay files (menuname_HL.tif) and Button Hotspot files (menuname 

_BTN.tif) used in Menus may be prepared in either of two color schemes: 

Sonic or MEI. The Subpicture Type pane in Import Menu is used to specify 

which color scheme has been used in preparing the Menu files to be 

imported. This setting does not affect the import of Background files.

Overlay file colors

As described earlier, a Menu’s Overlay layer is a 2-bit mask for shapes, 

including text, that are displayed over the background image. Each Overlay 

file may contain up to four key colors.
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In DVD-Audio Creator, the four Overlay colors are referred to as 

Background, Foreground, Caption, and Border. (The DVD-Audio 

specification refers to these colors respectively as Background, Pattern, 

Emphasis 1, and Emphasis 2). 

The Background color in the Overlay file is typically used for areas that are 

to be transparent, allowing the Menu’s Background layer to show through. 

The other three colors are used to define areas of overlayed text and 

shapes. In the Command Editor application (see Chapter 8), the areas 

defined by the four colors are each mapped to a color and transparency 

level that will actually be displayed during each of three playback states 

(Normal, Select, Action).
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[IMAGE: Something similar to Figure 4-3 from the ReelDVD 2.0 manual, but 

with terminology and color names changed to be consistent with the 

descriptions given here: "Overlay colors" instead of "Original Colors," 

"Border" instead of "Color 1," "Caption" instead of "Color 2", "Foreground" 

instead of "Color 3", "Background" instead of "Color 4," "Normal" instead of 

"Display," "Select" instead of "Selection," "Transparency" instead of "%" (scale 

of numbers in these columns must also be changed to 0-15)]
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Normal Color Map
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Select Color Map
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System Color Palette (16 colors)
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5
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Purple

Yellow
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9
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Dk. Grey
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Dk. Green

Lt. Green

13

14

15

16
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Lt. Blue

Orange

Purple

Foreground (Black)

Background (White)
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Import Menu can import files using either of two color schemes for the 

four key colors that define the masks. Expressed in RGB (Red, Green, Blue) 

values, the following colors are used in the two modes:

Sonic mode:

• Background = White (255, 255, 255)

• Foreground = Black (0, 0, 0)

• Caption = Red (255, 0, 0) 

• Border = Blue (0, 0, 255)

MEI mode:

• Background = Black (0, 0, 0) 

• Foreground = Blue (0, 0, 255) 

• Caption = Green (0, 255, 0)

• Border = Red (255, 0, 0)

Button Hotspot mapping

Button Hotspot files are two-color files that Import Menu uses to define the 

rectangular areas of the screen associated with a Menu’s buttons. 

Mapping of the colors used in a Button Hotspot file is determined by the 

Subpicture Type setting:

Sonic mode:

• White (255, 255, 255) = Background

• Black (0, 0, 0) = Button areas
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MEI mode:

• Black (0, 0, 0) = Background  

• White (255, 255, 255) = Button areas

Fi le  Import  Set t ings

When importing Menu source files into a DVD-Audio Creator project, 

Import Menu is used to specify four import parameters and to execute the 

import.

Specifying the Source Directory

The Source Directory is a folder in which you have stored files to be 

imported for Menus. In each import operation (each time the Execute 

button is clicked), Import Menu imports all the TIFF files in the specified 

Source Directory. A separate import operation is required for each Source 

Directory.

During each import, Import Menu associates the Background, Overlay, and 

Button Hotspot files for a given Menu page based on the names of the 

source files. This makes it crucial that when source files are prepared, the 

naming conventions used are correct for the type of menu being prepared 

(see section 5.2 above).

The way that Menu files should be grouped into Source Directories varies 

depending on the Menu type:

• Single-Page Menus:

- if the source files for all the Single-Page Menus in the project are of 
the same Subpicture Type, they may all be stored in the same folder, 
allowing them to all be imported at once.
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- if source files in both Sonic and MEI format are used, a separate 
Source Directory will be needed for each Subpicture Type.

• Multi-Page Menu:

- all source files for all pages of each Multi-Page Menu should be 
prepared in the same Subpicture Type.

- the source files for all pages of each Multi-Page Menu should be 
stored in a separate Source Directory.

- each Multi-Page Menu is imported in a separate import operation.

• Linked Lyrics Menu:

- all source files for all pages of each Linked Lyrics Menu should be 
prepared in the same Subpicture Type.

- the files for all pages of each Linked Lyrics Menu should be stored in 
a separate Source Directory.

- each Linked Lyrics Menu is imported in a separate import operation.

To specify the Source Directory:

1 Click the Browse button to the right of the "Source Directory" name-

field at the top of the window. A Browse dialog will appear. 

2 Find the folder containing the Menu files that you want to import. Click 

on the folder to select it.

3 Click OK. The dialog will close.

Specifying the Destination Directory 

The Destination Directory is the folder within the overall project structure 

to which Import Menu will write the files it creates during an import. 
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The correct folder to specify depends on the Import Type of the Menu(s) 

being imported:

• Single-Page Menus:

- the destination folder for all Single-Page Menus is the MENU folder 
within the PROJECT folder for the current project.

• Multi-Page Menu:

- each Multi-Page Menu requires its own separate destination folder. 

- the destination folder for each Multi-Page Menu must be created 
manually before the Menu is imported.

- the folder must be within the PROJECT folder; it may be (but does 
not have to be) within the MENU folder.

- there are no naming conventions governing the name of the folder.

• Linked Lyrics Menu:

- each Linked Lyrics Menu requires its own separate destination folder.

- the destination folder for each Linked Lyrics Menu must be created 
manually before the Menu is imported.

- the folder must be within the PROJECT folder; it may be (but does 
not have to be) within the MENU folder. 

- there are no naming conventions governing the name of the folder. 

Once you have manually created the destination folder needed for a Multi-

Page Menu or a Linked Lyrics Menu, you can specify the Destination 

Directory in Import Menu.

To specify the Destination Directory:

1 Click the Browse button to the right of the "Destination Directory" 

name-field at the center of the window. A Browse dialog will appear. 

2 Find the folder to which you want to import. Click on the folder to 

select it.
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3 Click OK. The dialog will close.

Setting the Import Type

The Import Type setting is made in the Import Type pane at the lower left. 

See section 5.2 above for a description of the three settings.

To set the Import Type:

• Click on the radio button that corresponds with the type of Menu 
(Multi-Page, Single-Page, or Linked Lyrics) for which you are importing 
source files.

Setting the Subpicture Type

The Subpicture Type setting is made in the Subpicture Type pane toward 

the lower right. See section 5.3 above for a description of the two settings.

To set the Subpicture Type:

• Click on the radio button that corresponds with the color scheme 
(Sonic or MEI) used in the source files you are importing.

Executing an Import
Once all the parameters of an import are set, Import Menu is ready to 

execute the import. 

To execute the import:

1 Click the Execute button at the bottom of the window. A Progress 

dialog will appear.
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2 When the import is complete, the Progress dialog will be replaced by a 

confirming dialog. 

3 Click OK or press Enter. The dialog will close.

IMPORT OPERATION RESULTS

The result of each import operation depends on the source files provided 

and the Import Type of the menus being imported:

Single-Page Menu:

• For each set of Single-Page Menu TIFF files that are imported, Import 
Menu automatically creates a separate subfolder (named after the 
filename of the Menu’s Background file) within the MENU folder.

• After the import, each subfolder (menuname) contains the following 
items:

- BUTTON-DOC.XML

- CMD-DOC.XML

- menuname.tif

- menuname_BTN.tif

- menuname_DVDMENUSTYLE-DOC.XML

- menuname_GRAPHIC-DOC.XML

- menuname_HL.tif

- menuname_MENUPAGE-DOC.XML
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Multi-Page Menu:

• During the import, Import Menu writes the XML files for the Multi-Page 
Menu to the user-created folder specified as the Destination Directory.

• For each page in the Menu, Import Menu automatically creates a 
separate subfolder (named after the filename of that page’s Background 
file) within the destination folder, and uses it to store the TIFF files 
associated with that page. 

• After the import, the destination folder (menuname) contains the 
following items:

- ImportMenu.log (documents which imported files were used to 
derive Button Hotspots)

- menuname_DVDMENUSTYLE-DOC.XML

- menuname_GRAPHIC-DOC.XML

- menuname_MENUPAGE-DOC.XML (indicates the number of pages 
created during the import)

- menuname_MENUPAGE-DOC_ADDCELL.XML

- BUTTON-DOC.XML file (pagename_BUTTONDOC.XML) for each 
page in the Menu

- CMD-DOC.XML file (pagename_CMD-DOC.XML) for each page in 
the Menu

- subfolder (pagename) for each page in the Menu

• Subfolder (pagename) for each page contains the following files:

- pagename.tif

- pagename_BTN.tif

- pagename_HL.tif
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Linked Lyrics Menu:

• During the import, Import Menu writes all files associated with the 
Linked Lyrics Menu to the the user-created folder specified as the 
Destination Directory.

• After the import, the destination folder (menuname) contains the 
following items:

- ImportMenu.log (documents which imported files were used to 
derive Button Hotspots)

- menuname_DVDMENUSTYLE-DOC.XML

- menuname_GRAPHIC-DOC.XML

- menuname_MENUPAGE-DOC.XML (indicates the number of pages 
created during the import)

- menuname_MENUPAGE-DOC_ADDCELL.XML

- CMD-DOC.XML

- BUTTON-DOC.XML

- BUTTON#-DOC.XML file for each page in the Menu, with "#" 
indicating the number of the page

- TIFF file corresponding to each imported source file 
(menuname_BG##.tif, menuname_HL##.tif, menuname_BTN##.tif, 
or menuname_BTN##_nn.tif) 

IMPORTING ADDITIONAL SOURCE FILES

Import Menu can execute multiple imports for a given project without re-

entering all the settings for each set of source files. For each successive 

import, you need only change those parameters that differ from the 

previous import. For example, if the project uses only Single-Page Menus of 

the Sonic Subpicture Type, you need only change the Source Directory 

filepath to import each set of source files that is stored in a different 

location.
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6 Import VIDEO_TS
The DVD-Audio format allows an album to include Video Tracks in the DVD-

Video format. You use the Import VIDEO_TS application to import into 

your project the source files needed for Video Tracks.

The source files used for Video Tracks in a DVD-Audio album come from a 

VIDEO_TS directory created by a DVD-Video authoring application such as 

Scenarist, DVD Creator, or DVD Fusion for Macintosh. When the directory 

is imported, Import VIDEO_TS extracts from the DVD-Video data the 

information required for DVD-Audio, and outputs XML files that are used by 

DVD-Audio Creator for subsequent steps of the production process.

Import VIDEO_TS is not used to determine the placement of a given Video 

Track within the overall structure of a DVD-Audio album (this is defined 

later using DVD-Audio Creator’s Author application; see Chapter 7).

Import VIDEO_TS is also not used to create material in the DVD-Video 

format. Before DVD-Video material can be imported into a DVD-Audio 

Creator project, it must be prepared in a DVD-Video authoring application 

such as Scenarist, DVD Creator, or DVD Fusion for Macintosh. For 

information on preparing video assets for use in DVD-Audio, please refer to 

Chapter 13, section 14.3.
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Note: While the DVD-Audio format supports the inclusion of DVD-Video 

material, the specification places some additional limitations on that 

material that are not part of the DVD-Video specification. That means it is 

possible to create DVD-Video material in Scenarist, DVD Creator, or DVD 

Fusion for Macintosh that cannot actually be used as part of a DVD-Audio 

album. The DVD-Audio format’s requirements for DVD-Video material are 

covered later in this chapter.

To launch Import VIDEO_TS:

• From the Windows Start meni, choose Programs > DVD-Audio Creator > 
Import VIDEO_TS.

To exit Import VIDEO_TS:

• Click the Exit button in the lower right corner of the main Import 
VIDEO_TS window.

WORKFLOW

The typical workflow for importing a VIDEO_TS directory into a DVD-

Audio Creator project is as follows:

1 Prepare a DVD-Audio compliant VIDEO_TS directory in Scenarist, DVD 

Creator, or DVD Fusion for Macintosh (see Chapter 13, section 13.3).

Import VIDEO_TS window



DVD-Video Material in DVD-Audio 95
2 In Import Video, specify the VIDEO_TS Directory to import.

3 Specify the Destination directory for the project.

4 Execute the import.

DVD-Video Material  in  DVD-Audio

While the operation of Import Video is very simple, it is important to first 

understand how video may be used on a DVD-Audio disc.

AUDIO_TS, AMG, and Domains

Under the DVD-Audio specification, all the content on a disc that can be 

played back by a DVD-Audio player — except DVD-Video content — must 

be stored in a root-level directory named AUDIO_TS (referred to as the 

"DVD-Audio zone"). DVD-Video content may be stored in AUDIO_TS when 

used in the disc’s Audio Manager Menu (AMGM), but is otherwise stored in 

the disc’s VIDEO_TS (the "DVD-Video zone") and is referenced from there 

by VTS-based Audio Titles (see below) defined in the Audio zone.

The first thing a DVD-Audio player does when a disc is loaded is to look in 

AUDIO_TS to find the appropriate "Audio Manager" file (table of contents). 

Simple Audio-only players read an Audio Manager file known as SAMG 

(Simple Audio Manager), used for linear, track-based navigation. All other 

player types read the Audio Manager file referred to as AMG. 

Included in the AMG file are "search pointers" (references) that the player 

uses to determine the location on the disc of all the content that it is 

capable of playing. If the disc includes motion video, the player will find 

pointers to the video content within this AMG file.

When a DVD-Audio disc is played in a player that uses AMG, its content 

plays back within one of two conceptual "domains":
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Audio Manager Menu domain  (AMGM_DOM) The Audio Manager Menu 

(AMGM) is the visual menu that appears when the end-user presses the Top 

Menu key on the remote control, and (optionally) when a Group has 

completed playback.

Title Group domain  (TT_GR_DOM) Includes all the content of the Audio 

Titles that play back as part of an album’s Groups. 

[Because video in the AMGM was not yet supported, the rest of this chapter 

was written only to cover the use of motion video in the Title domain only.]

Groups, Titles, and Tracks 

All content in the Title domain plays back as part of a Group, which is 

essentially a playlist of Titles. Two types of Groups may be used, up to a 

total of nine Groups per album:

AOTT_GR  Groups made up only of Titles that are playable on all players 

(including Audio-only players).

ATT_GR  Groups that may include Titles that are not playable on Audio-only 

players.

A Group may contain up to 99 Titles, but the Total number of titles in an 

album must not exceed 99.

TITLES

The content played back by Groups is organized into Titles. A Title 

combines presentation data (audio, pictures, video) with logical data (a 

Program Chain or PGC) defining the attributes of the presentation data and 

determining the manner in which the presentation data plays back.

There are three types of Titles in DVD-Audio:

• AOTT — an Audio-only Title with no motion video content:
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- plays back on Audio-only DVD-Audio players and video-capable DVD-
Audio players, but not DVD-Video players

- one audio stream must be LPCM or MLP (for specific requirements, 
see Chapter 14, section 14.2.1)

- may contain still pictures (ASVs) that are displayed as the audio 
plays. The pictures may be Slides (no buttons) or Menus (buttons). 
(For more information, see Chapters 5 and 7.) 

- Í may not be in the same Group as an AVTT

• AVTT/AOTT — a video-based Title in which the audio may be played in 
an Audio-only player without the accompanying video:

- plays back on Audio-only DVD-Audio players as well as video-capable 
DVD-Audio players and DVD-Video players

- one audio stream must be LPCM

- only one AVTT/AOTT Title may be used in a Group that also contains 
an AOTT. The Title must reference a Video Title Set (VTS) with only 
one Part of Title (PTT), which must be used as either the first or last 
Track in the Group.

• AVTT — a video-based Title in which the audio must be accompanied 
by the video:

- plays back only on video-capable DVD-Audio players and DVD-Video 
players, not on Audio-only DVD-Audio players 

- one audio stream must be either LPCM or Dolby Digital

- may not be in the same Group as an AOTT or an AVTT/AOTT Title.
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Aside from the distinctions described above, video-based Titles 

(AVTT/AOTT and AVTT) have the following attributes in common:

• an optional second audio stream may be either LPCM, Dolby Digital, or 
an optional audio format that DVD-Audio players are not required to 
support (DTS, MPEG 1 layer 2, or SDDS). 

• it is not possible to switch seamlessly between audio streams during 
playback

• the video may use up to nine angles (the same as in DVD-Video)

VTSS AND TRACKS

When a video-based Title is included in a Group, the search pointer list 

defining the Group includes a pointer to a Video Title Set (VTS) 

corresponding to the Title. During playback of the Title, it is the 

presentation data (the Video Object Set made up of VOB files) and logical 

data (PGC) of this VTS that determine what is displayed. 

All VTSs are stored within the VIDEO_TS folder. This arrangement supports 

the specification’s requirement that every VTS on a DVD-Audio disc be 

playable in a DVD-Video player. When played on a DVD-Video player, each 

VTS is referenced by a pointer within the Video Manager (VMG) file, a 

required component in the VIDEO_TS folder. When the disc is played in a 

DVD-Audio player, the VMG is ignored, and each VTS is referenced via AMG.

The following considerations apply to usage of a VTS for a video-based Title 

in DVD-Audio:

• as with Audio-only Titles (AOTTs), a video-based Title may be made up of 
one or more Tracks. (While such Tracks may be referred to as Video 
Tracks, that terminology is not actually used in the DVD-Audio 
specification.) The Tracks are derived from  "part of title" (PTT) data 
(known as "chapter points") defined during authoring of the VTS in a 
DVD-Video authoring program.

• All the video-based Titles in a given Group must be part of the same VTS 
[true?]
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VTS LIMITATIONS IN DVD-AUDIO

While a VTS on a DVD-Audio album is fundamentally similar to a VTS on a 

DVD-Video title, the DVD-Audio specification defines certain limitations on 

a VTS for a video-based ATT that do not apply to a VTS on a DVD-Video disc:

• the VTS must be made up of a One_Sequential Program Chain (PGC)

• because no album may contain more than 99 Tracks, no VTS may 
contain more than 99 PTTs (instead of 999 in DVD-Video)

• Pre-, Post- and Cell commands are not allowed, except ‘Call System 
VMGM’ in the Post-command area of the last video-based Title in a 
Group (this command is only seen by a DVD-Video player and is ignored 
by a DVD-Audio player)

• the PGC may not be part of a PGC-block

• User Operations (the disabling of some or all remote control keys for a 
certain part of a disc) may only be prohibited in a video-based Title that 
belongs to a hidden Group (this affects only DVD-Video playback, since 
User Operation control does not apply to DVD-Audio)

• Cell-blocks [explain very briefly what they are] may only be defined for 
a VTS used for an AVTT Title. It is not possible to use Cell-blocks within 
an AVTT/AOTT Title.

• all Cells must be flagged for seamless playback (handled in the DVD-
Video authoring process).

• Cell Stills are not allowed. A still picture must be associated with an 
audio stream, even if the audio program is silence.

CSS Encrypt ion

When DVD-Video material is included on a DVD-Audio disc, it may be 

encrypted with the Content Scrambling System (CSS) encryption scheme 

used in DVD-Video. Normally, the DVD authoring facility sends an 

unencrypted master to the DVD mastering and replication facility, and the 

encryption — if any — is performed by the plant. 
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Encryption may be applied to each VTS (Video Title Set) used in the album, 

as well as the VMG (Video Manager) that is required whenever a VIDEO_TS 

directory is included on a DVD-Audio disc.

The decision to encrypt or not to encrypt is made before or during the 

preparation of the VIDEO_TS directory in Scenarist, DVD-Creator, or DVD 

Fusion for Macintosh. For each VTS or VMG to be encrypted, the DVD-

Video author sets a encryption flag in the DVD-Video authoring tool.

Import VIDEO_TS does not automatically recognize the encryption flag 

settings of a VIDEO_TS directory when it is imported. Instead, during 

execution of the import the Scramble dialog appears. The dialog has a list 

showing the VMG and every VTS in the VIDEO_TS directory. 

For each item in the list, a checkbox allows the user to manually indicate 

whether or not the encryption flag has been set:

• Checkbox checked — tells Import VIDEO_TS that the item has already 
been flagged for CSS encryption during DVD-Video authoring. 

- Import VIDEO_TS will include an encryption flag in the XML file 
generated for that item during the import. 

- Later in the production process, the Format and Imager applications 
will read the flag in the XML file, and will expand the sector size for 
the video data to allow room for the CSS data that will be generated 
during encryption at the plant.

• Checkbox not checked — if the encryption flag for the item was not set 
during DVD-Video authoring, leave the item’s checkbox unchecked. The 
sector size will not be changed, and the item will not be encrypted at 
the plant.

Note: In order to set the checkboxes correctly, you must first determine 

from the DVD-Video authoring facility which of the items, if any, were 

flagged for CSS encryption at the plant.
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Import  Set t ings

When importing a VIDEO_TS source file into a DVD-Audio Creator project, 

two import parameters are specified in Import VIDEO_TS before executing 

the import.

Specifying the Source Directory

The Source Directory is the VIDEO_TS folder to be used in the project. 

Only one VIDEO_TS folder is used per album, even if there are multiple 

video-based Titles in the album, and those Titles appear in more than one 

Group.

In each import operation (each time the Execute button is clicked), Import 

VIDEO_TS imports the entire VIDEO_TS folder specified as the Source 

Directory. The components within the VIDEO_TS folder are used in a DVD-

Audio album as follows:

• Each VTS in the VIDEO_TS will be referenced by an AVTT or 
AVTT/AOTT Title in one of the album’s Groups (these relationships are 
defined using DVD-Audio Creator’s Author application; see Chapter 7). 

• Each PTT (Part of Title) defined within a given VTS will translate into a 
Track within the AVTT or AVTT/AOTT Title that references that VTS.

To specify the Source Directory:

1 Click the Browse button to the right of the "VIDEO_TS Directory" name-

field at the top of the window. A Browse dialog will appear. 

2 Find the VIDEO_TS folder that you wish to import. Click on the 

VIDEO_TS folder to select it.

3 Click OK. The dialog will close.
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Specifying the Destination Directory

The Destination Directory is the overall project directory containing the 

folders to which Import VIDEO_TS will write the files it creates during an 

import. 

To specify the Destination Directory:

1 Click the Browse button to the right of the "Destination" name-field at 

the center of the window. A Browse dialog will appear. 

2 Find the PROJECT folder for the current project. Click on the folder to 

select it.

3 Click OK. The dialog will close.

Executing an Import
When the Source and Destination directory parameters are set, Import 

VIDEO_TS is ready to execute the import. 

To execute the import:

1 Click the Execute button at the bottom of the window. The Scramble 

dialog will appear.

2 The Scramble dialog lists each VTS in the project, as well as the VMG. 

Using the checkboxes, set the appropriate CSS flag for each item in the 

list (see section 6.2 above).

3 Click OK. An Execute dialog will appear, indicating the progress of the 

execution.

4 When the import is complete, the Progress dialog will be replaced by a 

confirming dialog. Click OK.
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IMPORT OPERATION RESULTS

After an import operation, the files and folders generated by Import 

VIDEO_TS are found in the PROJECT folder for the current project:

• two folders are added to the PROJECT folder: VIDEO and VTSINFO

• three items are created within the VIDEO folder: 

VIDEO_TS folder (for each file in the source VIDEO_TS folder, contains 
one file with a corresponding name)

ImportLog.txt

Scramble.lst

• the following items are created within the VTSINFO folder:

a VIDEO_Volume.xml file

a folder for every Title in each VTS defined in the source VIDEO_TS

• the following items are created within the folder for each Title 

a VIDEO_TT.xml file

an XML file for each PTT in the Title (contains information about 
attributes such as duration, audio format, resolution, etc.)

Note: Import VIDEO_TS does not use the VOB folder in the PROJECT 

folder. The VOB folder is used later in the DVD-Audio Creator production 

process.
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7 Author
Once an album’s audio, menu, and video assets have been imported into a 

DVD-Audio Creator project, Author is used define the overall structure. The 

structure includes the contents of the Groups that make up the album’s 

Title domain (TT_GR_DOM), and the contents of the optional Top Menu 

(AMGM_DOM; the visual menu that appears when the disc is first loaded 

into a video-capable player or the end-user presses the Top Menu key on 

the remote control).

The album is defined by using icons to create a visual representation or 

layout of its structure — including Groups, Tracks, Menus, and Slides — 

and by assigning imported assets to each part of that layout.

Author is not used to define the commands associated with buttons in any 

of the album’s Menus (defined later using the Command Editor application; 

see Chapter 8).

To launch Author:

1 Choose Programs > DVD-Audio Creator > Author from the Windows 

Start menu. 
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2 If no projects have been created in Author since it was installed, or the 

Open last disk on startup checkbox is not checked in the User 

Preferences dialog, an Open dialog will appear.

• To open an existing project, use the Open dialog.

• To start a new project, click Cancel to close the Open dialog, then see 
section 7.2.1 (Starting a New Project) below.

3 If a project has been created in Author since it was installed, and the 

Open last disk on startup checkbox is checked in the User Preferences 

dialog, Author will open the most recent Author project opened in the 

application.

• The structure of the project will appear in the Layout window (see 
section 7.1.2 below), which is named after the current project.

• A Properties window (see section 7.1.3 below) named Disc Properties 
will appear with the words "No properties available" on the General tab.

WORKFLOW

The typical workflow for building a project in Author is as follows:

1 Prepare the source files for audio, pictures, and video (see Appendix 

XX, "Asset Preparation"

2 Import source files into the project directory structure using Import 

Audio (Chapter 4), Import Menu (Chapter 5), and Import VIDEO_TS 

(Chapter 6)

3 Build a visual representation of the project structure in the Layout 

window (saving the project as you work)

4 Import XML files for Single-Page Menus and Linked Lyrics Menus by 

right-clicking on their icons

5 Define properties for each icon in the layout using the Properties 

window (saving the project as you work)
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6 Publish the project (File menu)

Note: Author may be used to define a layout of the project during the 

design stage, before assets are prepared and imported. After asset 

preparation and import, the .dsc file for the project would be re-opened, the 

properties of the layout’s elements (icons) would be defined, and the project 

would then be published (after which it is ready for use in subsequent steps 

of the DVD-Audio Creator production process).

Inter face Overview

Author is made up of three main parts: the main window, the Layout 

window, and the Properties window.
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Main window

The main window defines the on-screen boundaries within which the 

Layout window may be displayed. The window may be moved and resized. 

Closing the main window exits Author.

MENUS

Across the top left of the main window are Author’s four menus: File, Edit, 

View, and Help. File menu operations are explained in section 7.2 (File 

Operations) below. The other menus are covered in section 7.6 (Menu 

Reference) below.

Author window
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STATUS BAR

Across the bottom of the main window is a status bar. The status bar is not 

used in this version of DVD-Audio Creator. It may be hidden by un-checking 

Status Bar on the View menu (Alt+V > S).

Layout window

The Layout window is the area used to build and display the visual 

representation of the project structure. The window may be moved and 

resized within the frame of Author’s main window. Closing the Layout 

window closes the current project (but does not exit Author).

Layout window
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ICONS

Across the top left of the Layout window is the Icon Bar, with 10 icons 

representing the various structural elements that may be used in a DVD-

Audio project: Album, Group, Audio Track, Slideshow, Linked Lyrics, 

Stillshow, Single-Page Menu, Video Track, Multi-Page Menu, and Slide.

As you move your cursor over the Icon Bar, ToolTips will appear to identify 

each icon. The use of each icon is covered in section 7.4 (Building a 

Project) below.

The project layout is built by dragging icons from the Icon Bar into the 

Layout window work area. As the project is built, the arrangement of the 

icons will show the current structure of the project.

Icon bar

Album
Single Page 

Menu
Audio 
TracK

Group

Linked 
Lyrics

StillshowSlideshow Video 
TracK

Multi Page 
Menu

Slide
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The size of the icons in both the Icon Bar and the work area may be 

adjusted in the Preferences dialog (Edit > Preferences or Alt+E > F). Select 

the preferred size in the Icon Size pane at the lower left of the dialog, then 

click OK or press Enter.
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Properties Window

The Properties window is used to define attributes for each of the project’s 

structural elements that are represented by an icon in the Layout window. 

The Properties window is a floating window that is always displayed on a 

closer layer than the Layout window. It may be moved, but not sized. 

Closing the Properties window does not close the current project. If the 

Properties window is closed, it may be opened by choosing View > 

Properties (Alt+V > P).

DEFINING PROPERTIES

The Properties window always shows the properties for the element 

whose icon is currently selected in the Layout window. The tabs on the 

window, and the attributes defined there, vary depending on the type of 

icon that is selected. Defining the properties for each icon type is covered 

in section 7.4 (Building a Project) below.

Audio Track Properties window
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File Operations

The basic operations related to working with project files in Author are 

handled from the File menu. These include starting, opening, closing, and 

saving projects, as well as publishing a project, which is required for the 

project to be used by subsequent steps in the DVD-Audio Creator 

production process.

CREATING A NEW PROJECT

To start a new project:

1 Choose File > New (Ctrl+N). A New dialog will appear.

2 Click in the "Look in" field [shouldn’t this field actually be labeled "Save 

in"?] at the top of the dialog. Using the drop-down list, find the 

AUTHORSCRIPT folder within the PROJECT folder. Click on the folder 

to select it.

3 In the "File name" field near the bottom of the dialog, type in a name for 

the new project. 

Note: Do not use any spaces or hyphens in the project name. [is this true, 

or am I mixing this up with the album name in album properties window? 

If true, what other characters are illegal?]

File menu
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4 Click Open [shouldn’t this be Save?] or press the ENTER key. The dialog 

will close, and a Layout window will appear, titled with the project 

name.

Opening an Existing Project

To open an existing project:

1 Choose File > Open (Ctrl+O). An Open dialog will appear.

2 Click in the "Look in" field at the top of the dialog. Using the drop-down 

list, find and open the PROJECT folder for the project you wish to open. 
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3 Within the PROJECT folder, find the .dsc file for the project you wish to 

open, and double-click on the file to open it.

Closing the Current Project

To close the current project:

• Choose File > Close (Alt+F > C), or close the Layout window. The 
current state of the project is saved, including any changes made since 
the last Save operation.

Saving the Current Project

Saving a project stores the project’s current state in the .dsc file defined 

when each new project is first created (see above). It is a good idea to save 

regularly as you work.

To save the current state of the project:

• Choose File > Save (Ctrl+S). [If you are saving a newly-created project 
for the first time, Ctrl+S currently brings up Save As dialog, and if you 
don’t change the shown filename it asks you if you want to overwrite 
the project you just created with the New dialog. This doesn’t happen if 
you choose File > Save (or Alt+F > S). Is the Ctrl+S behavior a bug?]

To save the current state of the project under a different name:

1 Choose File > Save As (Alt+F > A). The Save As dialog will appear.

2 Click in the "Save in" field at the top of the dialog. Using the drop-down 

list, find the folder in which you wish to save the new .dsc file. 

3 In the "File name" field near the bottom of the dialog, type in a new 

name for the .dsc file. 
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4 Click Save or press the Enter key. 

• If you typed in a new name for the .dsc file, the dialog will close.

• If you did not type in a new name for the .dsc file, an alert will appear, 
asking if you wish to replace the existing file. Click Yes to replace the 
file, or No to return to the Save As dialog to enter a new filename. 

Publishing the Current Project

Before a project defined in Author can be used by subsequent steps in the 

DVD-Audio Creator production process, the project must be published. 

Before publishing, check to be sure that all the required properties are 

defined for each icon in the layout.

To publish the current state of the project:

1 Choose File > Publish (Alt+F > B). The Publish dialog will appear.

• The Folder field in the Publish dialog will display the filename of the 
folder currently designated as the destination of the publish operation. 
This folder is normally the PUBLISH folder within the PROJECT folder 
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for the current project. If a different folder is shown, click select to 
designate the correct destination folder in the Select Destination Folder 
dialog.

• The Options pane in the Publish dialog contains the Want log checkbox, 
which specifies that a log file (log.txt) of the publish operation should 
be written to the destination folder (typically the PUBLISH folder within 
your current PROJECT folder). The checkbox is checked by default. 
Uncheck the box if you do not want a log.

2 Click Publish.

• If the project does not contain any undefined properties, or unresolved 
links that need to be defined in Command Editor (see Chapter 8), the 
Publishing Complete dialog will appear, indicating that "Publishing has 
completed successfully." Click OK or press the ENTER key to close the 
dialog.

• If the project does contain undefined properties, or links that need to 
be defined in Command Editor, the Error during Publish alert will 
appear, indicating that "Publishing has not completed successfully," and 
showing the number of "errors" that still need to be defined. Click OK 
or press the ENTER key to close the dialog.
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If errors are indicated in the Error during Publish alert, you may be able to 

determine the nature of the errors by checking the log file (log.txt) in the 

destination folder (typically PUBLISH). There are two basic categories of 

errors:

• Undefined properties — Errors that relate to properties that must be 
defined in Author. The following are properties that must be defined to 
avoid errors, along with the corresponding entries in the log file (see 
section 7.4 below for information on setting these properties):

- the Source Filename on the Image tab of the Slide Image Properties 
window for each Slide: 
"ERROR! The still Image has not been defined."

- the Filename on the MENUPAGE-DOC tab of the Multi-Page Menu 
Properties window for each Multi-Page Menu: 
"ERROR! There is no menupage-ptr defined."

- the Folder on the Buttons tab of the Linked Lyrics Properties 
window for each Linked Lyrics Menu: 
"ERROR! There must be at least one menu page in menu doc 
LinkedLyrics.Name."

Note: The following properties also must be defined in Author, but do not 

cause errors during the publish operation: [why not?]

- the Filename on the Audio tab of the Audio Track Properties window 
for each Audio Track 

- the Source Filename on the Video tab of the Video Track Properties 
window for each Video Track 

- the Folder on the Buttons tab of the Single-Page Menu Properties 
window for each Single-Page Menu

• Unresolved links — If the project includes menus, there will likely be 
errors that relate to unresolved button links:
"ERROR! Could not find the Target for command ButtonName."
These errors are normal; the links are defined later in Command Editor.

[Recent File: this menu option does not seem to be active in this version. 

How should this be handled in documentation?]
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Exiting Author

To exit Author:

• Choose File > Exit, or close the main window (Alt+F4). The current 
state of the project is saved, including any changes made since the last 
Save operation.

Project Layout and Icons

A project is created by building a visual representation of the project 

structure with icons in the Layout window, and defining the properties of 

each element in that structure in the Properties window.

Hierarchy and containers

The structure of a project is hierarchical, with higher-level elements acting 

as containers for lower-level elements. A Group, for example, is a container 

for Audio Tracks and/or Video Tracks. Similarly, an Audio Track may be made 

up not only of audio data, but also of associated pictures or sets of pictures, 

including Single-Page Menus, Slideshows, Stillshows, or Linked Lyrics 

Menus. Each Slideshow or Stillshow is in turn a container for either a Multi-

Page Menu or one or more individual Slides.

The hierarchy of the project is reflected in the position of the icons 

representing project elements in the project layout. The higher an element 

is in the hierarchy, the further left its icon will be positioned in the layout. 

Lines between icons indicate the connection between elements that are 

containers and the lower-level elements they contain.
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Each of the elements in the project that are containers may be displayed 

expanded or collapsed. The arrows along the far left side of the Layout 

window are used to collapse or expand the containers. The default for 

layout display is fully expanded. 

Adding Icons

Elements are added to a project structure by dragging icons from the Icon 

Bar and dropping them in the Layout window. 

The Album icon is the only icon that may be dropped in an empty Layout 

window. To be accepted in the Layout window, all other icons must be 

dropped onto an existing icon in the project layout (or onto the existing 

Project hierarchy
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icon’s label). [Inconsistent behavior: you can’t really drop directly on the 

Album icon; only to the right of it or on its label] The existing icon must be 

of a type that can act as a container for the new icon. 

When an icon is dragged over an existing icon, a red box will appear 

around the existing icon’s label if the existing icon can act as a container 

for the new icon. Dropping the element will then place the new icon in 

the project layout at the level of hierarchy below that of the existing icon.

Icon names

When an icon is dropped in the Layout window, it is assigned a generic 

name made up of the icon type and a number. The name appears in a label 

to the right of the icon. The number in the name represents the count of 

the number of icons of that type that have been used in the project. (The 

count includes icons that have been dragged into the Layout window and 

subsequently deleted.)
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The name of every icon may be changed on the General tab of that icon’s 

Properties window (see below).

Moving icons

Once an icon is part of the project layout, it may be moved by dragging and 

dropping:

• When moving an icon outside of its current container, it must be 
dropped over an icon of a type that can act as a container for icons of 
the type being moved.

• Moving an icon within a container changes the playback order of the 
elements in the container:

- Moving a Group within the Album changes the number (1-9) 
assigned to the Group, which is the number the end-user enters on 
the player remote control to play that Group. 

- Moving Audio or Video Tracks within a Group changes the order in 
which the Tracks play back.

- Moving the Slides in a Slideshow or Stillshow changes the display 
order of the Slides in the show.

Deleting icons

Deleting an icon that represents a container also deletes all the elements 

within that container. 

To delete an icon in the Layout window:

1 Click the icon to select it.

2 Choose Edit > Delete or press the DEL key.
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Note: A delete operation does not invoke an alert dialog to confirm the 

delete, and Author does not include an Undo function. Use caution when 

deleting icons. 

Defining icon properties

The properties of each element in the project layout are defined in the 

Properties window. 

To define the properties of an icon:

1 Click on the icon of the element whose properties you wish to view or 

define. The icon will be highlighted to indicate that it is selected.

2 The Properties window will display the tabs available for icons of the 

type selected. Each tab will display the current settings for one or more 

of the icon’s properties.

3 Edit the desired property on the tab

The specific properties of each icon type, and how to edit them, are 

covered in section 7.4 below. 
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The Topmost Icon

When a container includes more than one Single-Page Menu, Slideshow, or 

Stillshow, the topmost icon in the container serves as a gateway through 

which the content in the other icons is accessed. This situation may exist in 

two cases:

• Top Menu — the topmost Menu icon in the album’s Menu domain (the 
level of hierarchy directly below the Album icon). The Top Menu is the 
visual menu that appears when the end-user presses the Top Menu key 
on the remote control. Access to all other Menus in the Menu domain is 
through the Top Menu. [true?]

• Top icon in a Track — as noted earlier, an Audio Track may be made up 
not only of audio data, but also of associated pictures or sets of pictures 
(a series of ASVs). The contents of the topmost icon (Single-Page Menu, 
Slideshow, or Stillshow) in a Track are displayed as the Track’s audio 
begins playback. Access to any other ASV-series whose icons are 
associated with that Track is through the contents of the topmost icon 
(see "Access to multiple ASV-series" in section 7.4.4 below).

Note: Because the Top Menu and the top icon in a track are defined by 

their positions in the layout, deleting an icon, changing the order of icons 

in a container icon, or moving an icon to or from a container icon may 

affect how the content represented by other icons in that container is 

accessed by the end-user.

Building a  Project

As explained above, building a project involves laying out the project’s 

structure with icons in the Layout window, and defining the properties of 

each element in that structure in the Properties window.
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Starting an Album

The DVD-Audio specification mandates that each side of a DVD-Audio disc 

may contain only one album. DVD-Audio Creator supports both DVD-5 

(single-sided, single layer) and DVD-9 (single-sided, dual layer) discs, 

meaning that every disc created with DVD-Audio Creator is a single-sided 

disc containing one album.

Because there can be only one album per project, only one Album icon is 

used in the layout. The Album icon represents the highest level of hierarchy 

in a project. All other elements of a project’s structure are contained within 

the Album. It follows that the Album icon is the first icon used in a project, 

and the only icon that may be dropped into an empty Layout window.

ALBUM PROPERTIES

To display an album’s properties in the Properties window, click on the 

Album icon to select it. The Album Properties window includes three tabs:

• General tab (one property):

- Name — enter the name of the album in the Name field. Do not use 
any spaces, or any of the following characters: [which ones?]

• Album tab (three properties):

- Artist(s) —  [need explanation and normal usage]

Album icon in Layout window



126 Chapter 7, Author
- Album ID — [need explanation and normal usage]

- Auto — a drop-down list with three options:

- no setting: 

- Menu: 

[MEI doc says: "If anything other than "play" is set, nothing is automatically 

played back." Is this true? If so, why have two other options (‘Menu’ and 

‘no setting’) instead of one? If MEI doc is not correct, what’s the purpose of 

each of the two other options (‘Menu’ and ‘no setting’)?]

- Play: Track1 of Group1 automatically begins playing when the disc is 
inserted in a player.

• Video Set tab (two properties):

- TV System —  [need explanation and normal usage]

- Video Format —  [need explanation and normal usage]

[MEI doc gives no explanation at all of this tab]

Adding a Group

A Group is a playlist that defines the playback order of presentation content 

in an album’s Title domain. A Group is defined by a Search Pointer List 

(SRP) in an album’s Audio Manager (AMG). Each pointer in the list 

references an Audio Title, each of which is made up of 1-99 Tracks.

The DVD-Audio spoecification defines the following limits regarding 

Groups:

• Up to nine Groups are allowed per album. 

• A Group may contain up to 99 Titles, but not more than a total of 99 
Tracks.
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To add a Group to the Layout:

1 Drag a Group icon from the icon bar and drop it onto the label of the 

Album icon in the Layout window.

2 The new Group icon will appear in the layout at the second level of 

hierarchy (the column of icons that is second from the left). 

3 A label with a generic name will appear to the right of the new icon. 

The name may be changed in the Properties window (see below).

TITLE TYPES AND GROUPS

A given Title may be referenced by more than one Group. In some cases, 

Groups simply provide different paths through the same material on the 

disc; in other cases, Titles in one Group are not used in any other Group. 

Ultimately, the organization of the Titles into Groups is up to the producer, 

but is subject to constraints defined in the DVD-Audio specification.

Under the specification, a Group is only recognized by a given player if all 

the Titles in that Group are playable by that player type. The specification 

defines two basic classifications of Titles, determined by the type of players 

on which the Title plays back:
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AOTT

Title with no motion-video content:

• plays back on Audio-only DVD-Audio players and video-capable DVD-
Audio players, but not on DVD-Video players

• includes one or more Audio Track

• one audio stream must be LPCM or MLP.

• may contain still pictures (ASVs) that are displayed as the audio plays, 
either Slides (no buttons) or Menus (buttons)

• may not be in the same Group as an AVTT Title

AVTT

A video-based Title in which the audio must be accompanied by the video:

• plays back on video-capable DVD-Audio players and DVD-Video players, 
but not on Audio-only DVD-Audio players 

• only one allowed per Group

• includes one or more Video Track, each defined as a PTT

• one audio stream must be either LPCM or Dolby Digital

• may not be in the same Group as an AOTT or an AVTT/AOTT Title.

The specification also allows Titles with certain attributes to be 

simultaneously classed as both AOTT and AVTT, effectively creating a third 

type of Title:
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AVTT/AOTT

A video-based Title in which the audio may be played without the 

accompanying video:

• plays back on Audio-only DVD-Audio players, as well as video-capable 
DVD-Audio players and DVD-Video players

• only one allowed per Group

• includes one or more Video Track, each defined as a PTT (Part of Title in 
the DVD-Video specification) 

• one audio stream must be LPCM

• in a Group that also contains an AOTT, an AVTT/AOTT Title must be 
made up of a single PTT (Track), and it may only be used as either the 
first or last Track in the Group.

DVD-Audio Creator automatically defines a video-based Title as an AVTT 

Title or an AVTT/AOTT Title when the project is formatted in Format (see 

Chapter 9):

• If a video-based Title includes an LPCM audio stream it will be defined as 
an AVTT/AOTT Title. 

• If no LPCM stream is present, it will be defined as an AVTT Title. 

[Is there any way in Author to tell the type of Title (AVTT or AVTT/AOTT) 

that a given Video Track is part of? If not, how does one know while 

authoring what combinations of Tracks that one creates in the layout 

window will result in a legal album?]

Note: If you create a Group in Author that includes a combination of 

Titles that is not supported by the DVD-Audio specification, an error alert 

will be generated when the project is formatted in Format. 
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COMBINING TITLES IN GROUPS

Based on the Title types defined above, there are five cases of specification-

compliant Groups that you may build in the Layout window:

• a Group made up of one or more Audio Tracks, each of which makes up 
all or part of an AOTT Title (the Title itself is actually defined by Format 
later in the DVD-Audio Creator production process). If more than one 
Track is defined in a given Title, all Tracks in that Title must be used in 
the Group.

• a Group made of one or more Video Tracks, where all Tracks are PTTs 
defined in the same AVTT Title. If more than one Track is used in the 
Group, the Tracks must be in the same sequence as the PTTs defined in 
the AVTT Title.

• a Group made of one or more Video Tracks, where all Tracks are PTTs 
defined in the same AVTT/AOTT Title. If more than one Track is used in 
the Group, the Tracks must be in the same sequence as the PTTs 
defined in the AVTT/AOTT Title.

• a Group made up of one or more Audio Tracks (each defined in an AOTT 
Title that may be made up of one or more Tracks) followed by a single 
Video Track defined in an AVTT/AOTT Title.

• a Group made up of a single Video Track, defined in an AVTT/AOTT 
Title, followed by one or more Audio Tracks (each defined in an AOTT 
Title that may be made up of one or more Tracks).

GROUP PROPERTIES

To display a Group’s properties in the Properties window, click on the 

Group’s icon to select it. The Group Properties window includes two tabs:

• General tab (one property):

- Name — if desired, enter a name for the Group in the Name field. 
(Group names have no effect on the functionality of a completed 
album.)

• Group tab (five properties):
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- UPC —  [inactive; need explanation and normal usage, if any]

- ISRC —  [display only? empty; need explanation and normal usage, if 
any]

- Title —  [inactive; need explanation and normal usage, if any]

- Artist —  [need explanation and normal usage]

- Password — used to define the current Group as a hidden Group, 
which can only be played back if the end-user enters a numeric code 
on the remote control.

The code defined in the field must be a string of four numerals (0000-
9999).

Only one Group per album may be defined as hidden. If a password is 
entered for more than one Group, an error alert will appear during the 
Publish operation.

If the field is left blank, the Group is not defined as hidden.

Adding an Audio Track

Once a Group is present in the layout, you may begin adding icons for the 

Group’s Audio Tracks (each of which is part of an AOTT Title). Before an 

Audio Track is brought into the layout in Author, it is imported into the 

project in Import Audio, which generates XML files defining the Track (see 

Chapter 4).

Note: Author is not used to add a second stream (PGC Block) to an 

Audio Track in an AOTT Audio Title (see Chapter 12, section 12.1), to add 

a Silent Cell before an Audio Track (see Chapter 12, section 12.2), or to 

define Indexes and Spotlights within Audio Tracks (see Chapter 12, section 

12.3).
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The DVD-Audio specification defines the following limits regarding Audio 

Tracks:

• 1-99 Tracks may be defined for each Title, with no more than 99 Tracks 
total used in any one Group

• Up to 99 Audio Cells may be defined in each Audio Track, each of which 
corresponds to an Index in the Track (see Chapter 12, section 12.3)

• Durations:

- minimum Audio Cell: 1 second

- minimum Silent Cell (see Chapter 12, section 12.2): 0.5 second

- maximum Audio Track: 47,721 seconds

To add an Audio Track to the Layout:

1 Drag an Audio Track icon from the icon bar and drop it onto a Group 

icon in the Layout window.

2 The new Audio Track icon will appear in the layout, underneath the 

Group icon, at the next lower level of hierarchy (the column of icons 

that is third from the left). 

3 A label with a generic name will appear to the right of the new icon. 

The name may be changed in the Properties window (see below).

SPECIFYING THE XML FILE

Once an Audio Track icon is present in the layout, the XML file for the 

Audio Track represented by the icon must be specified.
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To specify the XML file for an Audio Track:

1 Click on the Audio Track icon to select it.

2 On the Audio tab of the Audio Track Properties window (see below), 

click the Define... button at the bottom. A Select Audio dialog will 

appear.

3 Click in the Look in field at the top of the dialog. Using the drop-down 

list, find the AUDIO folder within the PROJECT folder. Double-click on 

the folder to open it.

4 Find the correct XML file for the Track that you wish to associate with 

current Audio Track icon:

• If the entire audio source file (SourceFile.ext) is defined as a single 
Track, the correct XML file to specify for that Track will be named 
SourceFile.XML

• If more than one Track is defined for a given audio source file 
(SourceFile.ext), the XML file for each Track derived from that source 
file will be named SourceFile_tr##.XML, with "##" being a series of 
numbers corresponding to the position of each Track in the source file 
(beginning with "01").

Note: Depending on the format (AIFF, WAV, DVD, or MLP) of the audio 

source file, Import Audio may generate more than one file in XML format 

for each Track. To define the correct file in the Audio tab, be sure that the 

name matches the naming conventions described above.

5 Double-click on the XML file (or click on the file to select it, then click 

Open). The dialog will close.

6 On the Audio tab of the Audio Track Properties window, the Filename 

pane will show the filepath of the XML file you defined for the Track. 

Once an XML file is associated with a Track, the Details pane of the Audio 

tab (see below) displays the attributes of the Track’s audio data.
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AUDIO TRACK PROPERTIES

To display an Audio Track’s properties in the Properties window, click on 

the Track’s icon to select it. The Audio Track Properties window includes 

four tabs:

• General tab (one property):

- Name — if desired, enter a name for the Track in the Name field. 
(Track names have no effect on the functionality of a completed 
album.)

• Track tab (four properties):

- UPC —  [needs explanation and normal usage]

- ISRC —  [needs explanation and normal usage]

- Title —  [needs explanation and normal usage]

- Artist —  [needs explanation and normal usage]

• Audio tab (one property):

Audio Track Properties
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- Filename — the filepath for the XML file for the Track (see Defining 
the XML file above).

• Markers tab (one list):

- Audio Markers list — a list of all the Markers defined in the Track 
(see Working with Markers below). Markers are used only for Tracks 
that contain Linked Lyrics Menus.

WORKING WITH MARKERS

The Audio Markers list in the Markers tab of the Audio Track Properties 

window is used to set the times of Markers in a Linked Lyrics Menu. 

A Linked Lyrics Menu is a series of ASVs (still pictures) that incorporate 

buttons and whose display timing is synchronized to the audio in an Audio 

Track. The synchronization controls the timing of changes in the button 

selection on each ASV, as well as the timing of transitions between the ASVs 

in the series. This allows effects such as synchronized highlighting of lyrics, 

libretto, and liner notes displayed during an Audio Track.

For a full explanation of Linked Lyrics Menus, see Chapter 5, section 5.2.3. 

To learn how to add Linked Lyrics Menus to a layout in Author, see section 

7.4.5 below.

The Audio Markers list allows entry of a unique time (no two Markers may 

use the same time) and name for each Marker. Marker times are expressed 

in seconds. The appropriate name for a Marker depends on how it will be 

used: 

• Button-selection change — when used only to define the time of a 
change in button selection within a given ASV, the names of Markers 
may be left as they are assigned by default in Author, or you may enter 
any new name (except "m" followed by a number).  

• ASV change — Markers used to define the time of a change in button-
selection to a button on a different ASV must be manually renamed 
"m1," "m2," etc. (continuously upcounting based on their defined 
times). 
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- Author uses the number in each of these Marker names to associate 
the Marker time with the correct set of ASV files that have been 
prepared for the Linked Lyric Menu and imported with Import 
Menu. 

- Author also automatically creates a link to the first marker-button in 
each ASV. When the link is executed during playback, the ASVs 
change as the player navigates to these buttons, which are 
highlighted when each ASV is first displayed. 

To set Markers in the Markers tab:

1 Click the New Marker button at the upper right of the tab.

• A Marker named "Marker 1" will appear in the list, with a time of 0.000.

• The Marker Time pane will appear at the bottom right of the tab.

2 Click in the field in the Marker Time pane, and type the time (in 

seconds) for the Marker, then click the Set button. The entered time will 

be reflected in the Audio Markers list.

3 To rename the Marker (required for "ASV change" Markers; see above), 

click on the name in the Audio Markers list, then click again to enable 

editing of the name. Type the desired name and press ENTER.

4 Repeat the steps above, entering a unique time and name for each 

marker. 

[IMAGE: multiple markers in the Markers tab of the Audio Track Properties 

window in Author]

To remove a Marker in the Markers list:

1 Click on the Marker to select it.

2 Click the Remove button. The Marker will be removed from the list.
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Still Pictures in Audio Tracks

In addition to audio data, an Audio Track may optionally include display of 

one or more still picture. Each such picture is an ASV (Audio Still Video). 

There are two basic categories of ASVs:

• Slide — an ASV without buttons, made up of only an image layer. 

• Menu — an ASV with buttons (up to 36), made up of a Background 
image layer, an Overlay layer, and a Button Hotspots layer (see Chapter 
5, section 5.1). 

ASVs of either type may be organized into a set of pictures that is read from 

disc and preloaded into player memory before playback begins of the Audio 

Tracks during which the set is displayed. The set is called an ASVU (Audio 

Still Video Unit), and the Tracks over which an ASVU displays is called an 

ASVU range. To avoid muting of audio output during program, an ASVU 

range should not be defined such that it begins or ends during continuous 

program such as a live recording.

The DVD-Audio specification defines the following limits applying to ASVs 

and ASVUs:

• 1-99 ASVs may be included in each ASVU

• 1-99 ASVUs may be used in an album

• no more than 1604 ASVs total may be used in an album

• the file size of each ASVU may not exceed 2MB

In addition to these restrictions, DVD-Audio Creator does not support the 

use of more than 20 ASVs in each Audio Track. [This comes from MEI’s 

"Overall system specs and restictions" (SYSTEM~1.DOC), section 2.6. Have 

I interpreted this correctly, and is it still true?] 
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ASSOCIATING ASVS WITH TRACKS

In DVD-Audio Creator, the layout in Author is used to organize the ASVs that 

are to be presented during playback of Audio Tracks. Based on that layout, 

as well as additional settings in Command Editor, the ASVs are grouped into 

ASVUs by Format.

Depending on the type of ASV or series of ASVs, there are two ways to 

associate ASVs with Audio Tracks:

• Associated directly — Single-Page Menus and Linked Lyrics Menus are 
associated directly with a given Track by dragging the icon from the 
icon bar onto the Track in the Layout window. 

• Associated via container — individual Slides, multiple Slides, and Multi-
Page Menus must be associated with a container, either a Slideshow or a 
Stillshow. First the container is associated with the Track by dragging its 
icon from the icon bar onto the Track in the Layout window. Then the 
icon for the Multi-Page Menu or for each Slide is dragged onto the 
container icon in the layout.

Definitions for each of the various ASV types and containers, as well as the 

properties for each type, are covered in section 7.X below.

MULTIPLE ASV-SERIES IN A TRACK

DVD-Audio Creator allows each Track to contain more than one ASV or ASV-

series, as long as the types are compatible and certain parameter settings 

are consistent. ASVs and ASV-series in the same Track will be grouped into a 

single ASVU range by Format.

The following list shows which icon combinations are and are not allowed 

in an Audio Track (see section 7.X below for further information about the 

Duration and Display Order settings):
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Homogeneous combinations:

• Single-Page Menu with Single-Page Menu: yes

• Stillshow with Stillshow: yes, if Durations are all the same

• Slideshow with Slideshow: yes, if Durations and Display Order are all 
the same

• Linked Lyrics with Linked Lyrics: no

Heterogeneous combinations:

• Single-Page Menu with Stillshow: yes, if all Durations = 0

• Single-Page Menu with Slideshow: yes, if all Durations = 0 and Display 
Order is all Sequential

• Stillshow with Slideshow: yes, if Durations are all the same and Display 
Order is all Sequential

• Single-Page Menu with Linked Lyrics: no

• Stillshow with Linked Lyrics: no

• Slideshow with Linked Lyrics: no

In the case of Slideshows and Stillshows, the conditions that govern 

combining are the same whether any given Slideshow/Stillshow associated 

with a Track contains Slides or a Multi-Page Menu. 

ACCESS TO MULTIPLE ASV-SERIES

When more than one ASV or ASV-series is associated with a given Audio 

Track (directly or within a container), the topmost icon (Single-Page Menu, 

Slideshow, or Stillshow) below the icon for that Track indicates the content 

that will be displayed as the Track’s audio begins playback. 
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The content represented by icons below the first icon in a Track may be 

accessed in one or more of the following ways, depending on the nature of 

the preceding icons:

• Menu access — if the first icon is a Single-Page Menu, or a Slideshow or 
Stillshow containing a Multi-Page Menu, the Menu may contain on-
screen buttons linking to the ASVs in the next icon (and/or subsequent 
icons).

• Page-key access — [based on descriptions from Johannes that have not 
been indepedently verified] if the first icon is a Slideshow or Stillshow, 
the end-user may use the Page keys (Prev, Next) on the remote control 
to navigate ASVs. This allows the end-user to skip through the ASVs in 
the first icon to get to ASVs in the next icon (and subsequent icons). 

• Timed access — [based on descriptions from Johannes that have not 
been indepedently verified] if the first icon is a Slideshow or Stillshow 
that does not have a duration setting of infinite ("0"), ASV display will 
automatically advance to the contents of the next lower icon when the 
ASVs represented by the first icon have all been displayed (assuming 
that the end-user does not navigate manually with the Page keys or on-
screen buttons). For example, if the first icon is a Slideshow containing 
four slides, and the Duration setting is 5000 (five seconds), display of 

Audio Track icon with associated Single-Page Menu, Slideshow, and 
Stillshow
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the ASVs in the next icon will begin 20 seconds into the Track. Display 
of the ASVs in each subsequent icon will begin when display of the 
preceding icon’s ASVs is completed. 

MULTIPLE ASV-SERIES IN AN ASVU RANGE

As noted earlier, an ASVU is a collection of ASVs created by Format based 

on the layout in Author and settings in Command Editor. The Audio Track or 

Tracks during which an ASVU’s ASVs are displayed is an ASVU range. Unless 

a series of Tracks is defined as an ASVU range, there may be muted pauses 

between the Tracks as individual ASVUs are read into player memory

The same rules that govern the combining of multiple ASV-series in a given 

Track and access to those ASV-series during playback (see above) apply as 

well to multiple ASV-series in an ASVU range. [this is an assumption that has 

not been fully verified]

The defining of a given series of Tracks as an ASVU range is handled in 

Command Editor (see Chapter 8, section 8.X).

7.4.5 Adding a Single-Page Menu

A Single-Page Menu is a Menu (ASV with buttons) made up of a single ASV 

of infinite duration (no automatic transition to a subsequent ASV). A Single-

Page Menu is imported into the project in Import Menu (see Chapter 5, 

section 5.2.1)

In the project layout, a Single-Page Menu is associated directly with an 

Audio Track (not part of a Slideshow or Stillshow).

To add a Single-Page Menu to an Audio Track:

1 Drag a Single-Page Menu icon from the icon bar and drop it onto the 

Audio Track icon in the Layout window.
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2 The new Single-Page Menu icon will appear in the layout, underneath 

the Audio Track icon, at the next lower level of hierarchy (the column of 

icons that is fourth from the left). 

3 A label with a generic name will appear to the right of the new icon. 

The name may be changed in the Properties window (see below).

SPECIFYING THE MENUPAGE FILE

Once a Single-Page Menu icon is present in the layout, the icon must be 

associated with the MENUPAGE file generated for the Menu by Import 

Menu. 

To specify the MENUPAGE file for a Single-Page Menu:

1 In the Layout window, right-click on the icon for the Single-Page Menu, 

and choose "Import XML" from the pop-up menu. An Open dialog will 

appear.
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2 Click in the "Look in" field at the top of the dialog. Using the drop-down 

list, find the MENU folder within the PROJECT folder. Double-click on 

the folder to open it. The folder will contain a subfolder for each Single-

Page Menu imported into the current project with Import Menu.

3 Find the subfolder containing the files for the current Single-Page Menu. 

The folder will bear the same name (menuname) as the TIFF file 

(menuname.tif) imported as the Background for the menu. Double-click 

on the folder to open it.

4 Double-click on the MENUPAGE file (menuname_MENUPAGE-

DOC.XML). The dialog will close.

5 The Folder indicator on the Buttons tab (see below) will now show the 

path of the folder that contains the MENUPAGE file.

SINGLE-PAGE MENU PROPERTIES

To display a Single-Page Menu’s properties in the Properties window, click 

on the Menu’s icon to select it. The Single-Page Menu Properties window 

includes three tabs:

• General tab (one property):

- Name — if desired, enter a name for the Menu in the Name field. 
(Menu names have no effect on the functionality of a completed 
album.)

• Menu tab (one property):

- Language —  [need explanation and normal usage]

• Buttons tab (one property, one list):

- "Menu Builder" [shouldn’t this say "Import Menu", or XML file"?] 
Data Path — shows the filepath of the folder containing the files 
generated by Import Menu for the current Menu (see Specifying the 
XML file above). 

- Menu Buttons list — a list of all the buttons defined in the Menu. The 
list contains three columns:
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Name: [this column seems redundant to Status; I’ve only seen either the 
red X (broken or invalid) or the chain (resolved). If the heading of this 
column is not going to be changed, how do you want this seemingly 
mislabeled column described?]

Target: [I understand that this indicates the label that will be applied to 
the button when it is opened in Command Editor. But it seems like this 
is actually the Name of the button, so I’m not sure how to describe it]

Status: The status of each button in the list will be shown as invalid. 
Buttons in single-Page Menus do not become valid until their links are 
defined in Command Editor.

[IMAGE: Single-Page Menu Properties window showing Buttons tab with 

filepath and list of buttons]

7.4.6 Adding a Linked Lyrics Menu

A Linked Lyrics Menu is a form of ASV display that the DVD-Audio 

specification refers to as a Sequential Slideshow. In a Linked Lyrics Menu, 

the transitions between ASVs, as well as the selection of buttons on each 

individual ASV, is synchronized to times defined as Markers in an Audio 

Track (see section 7.4.3 above). Before a Linked Lyrics Menu is brought 

into the layout in Author, it is imported into the project in Import Menu 

(see Chapter 5, section 5.2.3).
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In the project layout, a Linked Lyrics Menu is associated directly with an 

Audio Track (not part of a Slideshow or Stillshow). A Linked Lyrics Menu 

must be used alone in a Track or ASVU range; it may not be associated with 

another Linked Lyrics Menu [makes Format crash] or with any other icons.

To add a Linked Lyrics Menu to an Audio Track:

1 Drag a Linked Lyrics Menu icon from the icon bar and drop it onto the 

Audio Track icon in the Layout window.

2 The new Linked Lyrics Menu icon will appear in the layout, underneath 

the Audio Track icon, at the next lower level of hierarchy (the column of 

icons that is fourth from the left). 

3 A label with a generic name will appear to the right of the new icon. 

The name may be changed in the Properties window (see below).

SPECIFY THE MENUPAGE FILE

Once an icon for a Linked Lyrics Menu is present in the layout, the icon 

must be associated with the MENUPAGE file generated for the Menu by 

Import Menu.

To specify the MENUPAGE file for a Linked Lyrics Menu:

1 In the Layout window, right-click on the icon for the Linked Lyrics 

Menu, and choose "Import XML" from the pop-up menu. An Open 

dialog will appear.
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2 Click in the "Look in" field at the top of the dialog. Using the drop-down 

list, look in the PROJECT folder to find the folder (menuname) that you 

created for this particular Linked Lyrics Menu when you imported the 

Menu’s TIFF files into Import Menu. Double-click on the folder to open 

it.

3 Double-click on the MENUPAGE file (menuname_MENUPAGE-

DOC.XML). The dialog will close.

4 The Folder indicator on the Buttons tab (see below) will now show the 

path of the folder that contains the MENUPAGE file.

LINKED LYRICS MENU PROPERTIES

To display a Linked Lyrics Menu’s properties in the Properties window, 

click on the Menu’s icon to select it. The Linked Lyrics Menu Properties 

window includes three tabs:

• General tab (one property):

- Name — if desired, enter a name for the Menu in the Name field. 
(Menu names have no effect on the functionality of a completed 
album.)

• Buttons tab (one property, one list):

• "Menu Builder" [shouldn’t this say "Import Menu", or XML file"?] Data 
Path — shows the filepath of the folder containing the files generated 
by Import Menu for the current Menu (see Defining the XML file 
above). 

• Menu Buttons list — a list of all the buttons defined in the Menu. The 
list contains three columns:

Name: [this column seems redundant to Status; I’ve only seen either the 
red X (broken or invalid) or the chain (resolved). If the heading of this 
column is not going to be changed, how do you want this seemingly 
mislabeled column described?]
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Target: [I understand that this indicates the label that will be applied to 
the button when it is opened in Command Editor. But it seems like this 
is actually the Name of the button, so I’m not sure how to describe it]

Status: The status of each button in the list will be shown as invalid. 
Buttons in Linked Lyrics Menus do not become valid until their links are 
defined in Command Editor.

[IMAGE: Linked Lyrics Menu Properties window showing Buttons tab with 

filepath and list of buttons]

Slideshows and Stillshows

Slideshows and Stillshows are containers for one or more ASVs that are 

displayed during playback of an Audio Track. Either type of container may 

contain an individual Slide, a series of Slides, or a Multi-Page Menu. 

Slideshows and Stillshows are two versions of a form of ASV display that the 

DVD-Audio specification refers to as "Browsable pictures." They are very 

similar, but differ in terms of presets related to two parameters of ASV 

display:

Display Order  Determines the order in which ASVs in a given Slideshow or 

Stillshow are played back. The order may be: 

• Sequential, with ASVs displayed in a predetermined order; 

• Random, with ASVs displayed in an order generated at random by the 
player during playback; or 

• Shuffle (same as random, but no ASV is repeated until every ASV has 
been shown).



148 Chapter 7, Author
Duration  Determines the length of time for which each ASV is displayed, 

with the same setting used for all ASVs in a given Slideshow or Stillshow. 

The setting may be:

• Fixed, with display advancing to the next ASV after the same interval on 
each ASV;

• A range, with the player randomly choosing a duration for each slide 
that is between Max and Min settings defined in Command Editor (see 
Chapter 8, section 8.X); or

• Infinite, meaning that each ASV will be displayed until the end-user 
navigates away with an on-screen button or skips to an adjacent page 
with the PREV/NEXT keys on the remote control.

Note: If the Duration of a Slideshow or Stillshow is not set to infinite, and 

presentation of the ASVs is completed before the end of the Audio Track, 

the presentation will start over from the beginning unless there is a 

subsequent icon (Single-Page Menu, Slideshow, or Stillshow) associated 

with the Track, in which case playback continues on to the ASVs in the 

subsequent icon (see section 7.4.4 above).

The Display Order and Duration parameters are each handled differently in 

Slideshows and Stillshows:

Slideshow: 

• The default Duration is fixed (5 seconds), making what is defined in the 
specification as a "Browsable pictures with automatic transition." 
However, you may enter a different value in Author and may also modify 
the setting later in Command Editor.

• The Display Order may be set in Author to sequential, random, or 
shuffle
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Stillshow:

• The Duration is automatically set by Author to infinite ("0"), making 
what is defined in the specification as a "Sequential Browsable pictures 
without automatic transition." However, the setting may be modified 
later in Command Editor.

• The Display Order is preset by Author to sequential, and may not be 
changed

ADDING A SLIDESHOW OR STILLSHOW

When defining a Slideshow or Stillshow in Author, first the container is 

associated with the Track, then the icon or icons for the ASV-series are 

brought into the container (covered in sections 7.4.8 and 7.4.9 below).

To add a Slideshow or Stillshow to an Audio Track:

1 Drag a Slideshow or Stillshow icon from the icon bar and drop it onto 

the Audio Track icon in the Layout window.

2 The new Slideshow or Stillshow icon will appear in the layout, 

underneath the Audio Track icon, at the next lower level of hierarchy 

(the column of icons that is fourth from the left). 

3 A label with a generic name will appear to the right of the new icon. 

The name may be changed in the Properties window (see below).
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SLIDESHOW PROPERTIES

To display a Slideshow’s properties in the Properties window, click on the 

Slideshow’s icon to select it. The Slideshow Properties window includes 

two tabs:

General tab (one property):

Name  If desired, enter a name for the Slideshow in the Name field. 

(Slideshow names have no effect on the functionality of a completed 

album.)

Slideshow tab (two properties):

Display Order  \The default setting is sequential. To change the Display 

Order, click on the down arrow at the right side of the display field, and 

choose random or shuffle from the drop-down list.

Duration   The default setting is 5 (seconds). To change the Duration, enter 

a different value in the field.

Slideshow Properties
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STILLSHOW PROPERTIES

To display a Stillshow’s properties in the Properties window, click on the 

Stillshow’s icon to select it. The Stillshow Properties window has one tab:

General tab (one property):

Name   If desired, enter a name for the Stillshow in the Name field. 

(Stillshow names have no effect on the functionality of a completed 

album.) 

Adding a Slide

A Slide is an individual ASV with no buttons. Unlike Menus, Slides are added 

to a project directly in Author, without first being imported in Import 

Menu. A Slide or series of Slides may be added to a layout only as part of a 

Slideshow or a Stillshow. 

To add Slides to a Slideshow or Stillshow:

1 Drag a Slide icon from the icon bar and drop it onto the Slideshow or 

Stillshow icon in the Layout window.

2 The new Slide icon will appear in the layout, underneath the Slideshow 

or Stillshow icon, at the next lower level of hierarchy (the column of 

icons that is fifth from the left). 

3 A label with a generic name will appear to the right of the new icon. 

The name may be changed in the Properties window (see below).

4 To add additional Slides to the Slideshow or Stillshow, repeat the steps 

above. The most recently added slide will appear just under the 

Slideshow or Stillshow icon. Drag and drop a Slide to change its order in 

the display sequence.



152 Chapter 7, Author
SLIDE PROPERTIES

To display a Slide’s properties in the Properties window, click on the Slide’s 

icon to select it. The Slide Image Properties window includes two tabs:

• General tab (one property):

- Name — if desired, enter a name for the Slide in the Name field. 
(Slide names have no effect on the functionality of a completed 
album.)

• Image tab (one property, two additional panes):

- Filename — the filepath for the source file for the image (see 
Specifying the source image below).

- Details pane — shows format and resolution attributes for the image.

- Preview pane — shows a thumbnail of the specified source image.

SPECIFYING THE SOURCE IMAGE

The source image file for a Slide is specified in the Image tab of the Slide 

Image Properties window. See Chapter 13, "Asset Preparation," for the 

specifications of source files that may be used in a DVD-Audio Creator 

album.

To specify the source file for a Slide:

1 On the Image tab of the Slide Properties window, click the Select... 

button at the right of the Source pane. A Locate Image Source dialog 

will appear.

2 Click in the Look in field at the top of the dialog. Using the drop-down 

list, find the source file for the image that you wish to associate with 

current Slide icon.

3 Double-click on the source file (or click on the file to select it, then 

click Open). The dialog will close.
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4 On the Image tab of the Slide Properties window, the Filename  filed in 

the Source pane will show the filepath of the specified source file. 

Once a source file is associated with a Slide, the Details pane of the Image 

tab displays the file’s attributes, and a thumbnail of the image is shown in 

the Preview pane.

7.4.9 Adding a Multi-Page Menu

A Multi-Page Menu is a set of ASVs that include buttons. Before a Multi-Page 

Menu is brought into the layout in Author, it is imported into the project in 

Import Menu (see Chapter 5, section 5.2.2).

A Multi-Page Menu may be added to a layout only as part of a Slideshow or 

a Stillshow. Each Slideshow or Stillshow may contain only one Multi-Page 

Menu.

To add a Multi-Page Menu to a Slideshow or Stillshow:

1 Drag a Multi-Page Menu icon from the icon bar and drop it onto the 

Slideshow or Stillshow icon in the Layout window.

Slide Image Properties
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2 The new Multi-Page Menu icon will appear in the layout, underneath 

the Slideshow or Stillshow icon, at the next lower level of hierarchy 

(the column of icons that is fifth from the left). 

3 A label with a generic name will appear to the right of the new icon. 

The name may be changed in the Properties window (see below).

MULTI-PAGE MENU PROPERTIES

To display a Multi-Page Menu’s properties in the Properties window, click 

on the Menu’s icon to select it. The Multi-Page Menu Properties window 

includes two tabs:

• General tab (one property):

- Name — if desired, enter a name for the Multi-Page Menu in the 
Name field. (Menu names have no effect on the functionality of a 
completed album.)

• MENUPAGE-DOC tab (one property):

- Filename — the filepath for the source file for the Menu (see 
Specifying the MENUPAGE file below).
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SPECIFYING THE MENUPAGE FILE

Once a Multi-Page Menu icon is present in the layout, the icon must be 

associated with the MENUPAGE file generated for the Menu by Import 

Menu. 

To define the MENUPAGE file for a Multi-Page Menu:

1 In the MENUPAGE-DOC tab of the Multi-Page Menu Properties window, 

click on the Select button at the right of the Source pane. A Locate 

MenuPage Document dialog will appear.

2 Click in the "Look in" field at the top of the dialog. Using the drop-down 

list, look in the PROJECT folder to find the folder (menuname) that you 

created for this particular Multi-Page Menu when you imported the 

Menu’s TIFF files into Import Menu. Double-click on the folder to open 

it.

3 Double-click on the MENUPAGE file (menuname_MENUPAGE-

DOC.XML). The dialog will close.

4 The Filename field on the MENUPAGE-DOC tab (see above) will now 

show the filepath of the MENUPAGE file.

Adding a Video Track

A Video Track icon represents a Part of Title (PTT) defined in a VTS that is 

referenced by a video-based Title (AVTT or AVTT/AOTT). 

Before a Video Track is brought into the layout in Author, the VTS in which 

it is defined (as a PTT) is created in a DVD-Video authoring application 

such as DVD Creator or Sonic Scenarist. The VTS is created as part of a 

VIDEO_TS directory (see Chapter 13), which is then imported into the 

project in Import VIDEO_TS (see Chapter 6), which generates a set of XML 

files defining the Video Track. In Author, those files are associated with a 

specific Video Track icon that has been placed in a Group.
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LIMITS ON USE OF VIDEO TRACKS

As explained earlier, DVD-Audio Creator (Format) defines two types of VTS-

based Titles:

• AVTT/AOTT Title — at least one audio stream in the VOB file referenced 
by the VTS is LPCM.

• AVTT Title — no LPCM audio stream. 

The DVD-Audio specification defines the following limits related to AVTT 

and AVTT/AOTT Titles and the Video Tracks defined within them:

• An album may include a total of up to [how many?] AVTT and 
AVTT/AOTT Titles [the spec. says 99 VTSs, but if only one video-based 
Title is allowed per Group, that would make only nine video-based Titles 
allowed per album]

• Up to 99 PTTs (Video Tracks) may be defined in a VTS referenced by an 
AVTT or AVTT/AOTT Title.

• No more than 99 Tracks total (Video Tracks and/or Audio Tracks) may be 
used in any one Group.
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In addition to the limits above, the following guidelines apply to the use of 

Video Tracks in Groups in Author’s Layout window (some layouts may be 

allowed by Author but cause errors in Format):

• All Video Tracks in a Group must be from the same VTS (no Group may 
contain Video Tracks from more than one AVTT or AVTT/AOTT Title). 
[even Groups without any AOTTs?]

• If any PTT in a given VTS is used as a Video Track in a Group, all of that 
VTS’s PTTs must be used as Video Tracks in that Group. [true?]

• Video Track icons in a Group must be arranged in the same sequence as 
the PTTs they reference in the source VTS

• A Video Track from an AVTT Title (no LPCM audio stream) may not be 
placed in a Group containing either a Video Track from an AVTT/AOTT 
Title (with LPCM stream) or an Audio Track.

• One Video Track from an AVTT/AOTT Title may be placed in a Group 
containing 1-98 Audio Tracks, under the following conditions:

- The Video Track is the only PTT in the source VTS

- The Video Track is placed either first or last in the Group

To add a Video Track to the Layout:

1 Drag a Video Track icon from the icon bar and drop it onto a Group icon 

in the Layout window.

2 The new Video Track icon will appear in the layout, underneath the 

Group icon, at the next lower level of hierarchy (the column of icons 

that is third from the left). 
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3 A label with a generic name will appear to the right of the new icon. 

The name may be changed in the Properties window (see below).

SPECIFYING THE SOURCE FILE

Once a Video Track icon is present in the layout, the source file for the 

Video Track represented by the icon must be specified.

To specify the source file for the Video Track:

1 Click on the Video Track icon to select it.

2 On the Video tab of the Video Track Properties window (see below), 

click the "Select..." button at the right of the Source pane. A Locate 

Video Source dialog will appear.

3 Click in the "Look in" field at the top of the dialog. Using the drop-down 

list, find the VTSINFO folder within the PROJECT folder. Double-click on 

the folder to open it.

4 The VTSINFO folder contains a folder for each VTS in the VIDEO_TS 

folder imported into the current project with Import VIDEO_TS. The 

folders are named sequentially by VTS number ("VTS01_TT01," 

"VTS02_TT01," etc) [true?]. Find the folder for the VTS containing the 

PTT that you wish to assign to the current Video Track, and double-click 

on the folder to open it.

5 The folder contains a set of sequentially numbered XML files, one for 

each PTT in the VTS. The files are named sequentially by PTT number, 

starting with VIDEO_PTT01.xml. Double-click on the file for the PTT 

that you wish to assign to the current Video Track (or click on the file to 

select it, then click Open). The dialog will close.

6 On the Video tab of the Video Track Properties window, the Source pane 

will show the filepath of the selected file. 
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VIDEO TRACK PROPERTIES

To display a Video Track’s properties in the Properties window, click on the 

Video Track’s icon to select it. The Video Track Properties window includes 

two tabs:

• General tab (one property):

- Name — if desired, enter a name for the Video Track in the Name 
field. (Video Track names have no effect on the functionality of a 
completed album.)

• Video tab (one property):

- Filename — the filepath for the video source file (see Specifying the 
source file above).

Adding a Top Menu

The Top Menu is the visual menu that appears when the end-user presses 

the Top Menu key on the remote control. This Menu resides in the Album’s 

Menu Domain (AMGM_DOM). 

In Author, the Menu Domain is made up of one or more Single-Page Menu 

icons at the first level of hierarchy below the Album level (the same level as 

an album’s Groups). The Menus represented by these icons are typically 

used to list the contents of the album, allowing the end-user to go directly 

to a given Group or Track. Any of these Menus may also link to another 

Menu in the Menu Domain.

The topmost Menu icon in the Menu domain is the target of the Top Menu 

key. Access to all other Menus in the Menu domain is through this Menu, 

using button links defined in Command Editor (see Chapter 8).

To add a Single-Page Menu to the Menu Domain:

1 Drag a Single-Page Menu icon from the icon bar and drop it onto the 

Album icon in the Layout window.
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2 The new Single-Page Menu icon will appear in the layout, underneath 

the Album icon, at the next lower level of hierarchy (the column of 

icons that is second from the left).

3 A label with a generic name will appear to the right of the new icon. 

The name may be changed in the Properties window.

4 Associate the icon with the MENUPAGE file generated for the Menu by 

Import Menu. See "Specifying the MENUPAGE file" in section 7.4.5 

above.

5 Click on the Menu’s icon to display and/or modify the Menu’s 

properties in the Single-Page Menu Properties window. See "Single-Page 

Menu properties" in section 7.4.5 above.

6 Repeat the steps above for each additional Menu in the Menu domain.

7 When you have added all the Menus you want in the Menu Domain, 

drag the Menu that you want to be the target of the Top Menu key onto 

the Album icon, making it the topmost Menu. 

Menu Reference
The items on Author’s File menu are covered in section 7.2 above. Items on 

other menus are covered here.
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EDIT MENU

The Edit menu contains the following items:

Undo, Cut, Copy, Paste  Not enabled in this version of Author.

Delete  (Del) Deletes the selected icon from the layout (available only when 

an icon is selected in the Layout window).

Preferences  (Alt+E > F) Opens the User Preferences dialog:

• Open last disc on startup, instructs Author to automatically open at 
launch the last project that was open in the application.

• Show Thumbnails, [don’t know what this does]

• Icon Size, determines the size of the icons in the icon bar and the 
layout. Choose from Small, Medium, and Large.

Edit menu

User Preferences dialog
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VIEW MENU

The View menu contains the following items:

Status Bar  (Alt+V+S) Toggles on and off the display of the status bar at the 

bottom of the Layout window. 

Properties  (Alt+V+P) [marked "Alt+Enter" on the menu, but that doesn’t 

work] Makes the Properties window the active window; opens the 

Properties window if it is not already open.

HELP MENU

The Help menu contains the following item:

About  (Alt+H+A) Opens the About Author dialog, showing version and 

copyright information. 

View menu

Help menu
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RIGHT-CLICK MENU

The Right-click menu contains the following items:

Import XML  (Right-click+X) Opens an Open dialog for specifying the XML 

file associated with a Single-Page Menu or a Linked Lyrics Menu (available 

only when the right-click is on a Single-Page Menu icon or a Linked Lyrics 

Menu icon in the Layout window).

Reload XML  (Right-click+R) [not really positive what the purpose of this is] 

(available only when the right-click is on a Single-Page Menu icon or a 

Linked Lyrics Menu icon for which the XML file has already been specified).

Properties  (Right-click+P) [incorrectly marked "Alt+Enter"] Makes the 

Properties window the active window; opens the Properties window if it is 

not already open.

Bigger Icons  (Right-click+B) Increases the size of icons in the icon bar and 

the layout (not available when icons are already set to Large).

Smaller Icons  (Right-click+S) Decreases the size of icons in the icon bar 

and the layout (not available when icons are already set to Small).

Load Images  (Right-click+I) [not sure what this does; never seen it active]

Right-click menu
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8 Command Editor
After assembling and publishing a project with Author, the next step is to 

open it in Command Editor, where you can:

• Set the Layer Break for dual-layer DVDs (projects larger than 4.7 GB).

• Configure the Video Attributes for NTSC/PAL, aspect ratio, and Line 21.

• Import Audio Text Data.

• Define Copy Control Information (CCI) for audio and video content.

• Define which audio tracks will require seamless playback, and which 
will use the Return Menu option.

• For menu pages, set Page Properties for color palettes and visual effect 
transitions.

• For buttons, define cursor navigation, selection colors, and commands.

• For Program Chains, define PreCommands and PostCommands, and 
Next, Previous, and GoUp.

• Set the display order, transitional effects, and playback timing for 
Slideshows, Stillshows, and Linked Lyric Menus.

After using Command Editor, you will use Format and Imager to create and 

write the disc image.
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To launch Command Editor:

• From the Windows Start menu, choose Programs > DVD-Audio Creator 
> Command Editor. 

Command Editor window
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To open a project in Command Editor, do one of the following:

• Choose File > Open, or click Open in the lower right of the Command 
Editor window. Navigate to and select the SFF.XML file, then click Open.

• Drag the SFF.XML file to the open Program Editor window. You can also 
drag the file to the Command Editor application icon on the desktop to 
automatically launch Command Editor and open the file.

To save a project: in Command Editor:

• Choose File > Save. 

To exit Command Editor:

• Choose File > Exit, or click Exit in the lower right of the Command 
Editor window.

Command Editor with open project
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Sett ing the layer  break

For disc images larger than 4.7 GB, which will not fit on a single-layer DVD, 

the content must be split between two layers of a dual-layer DVD. When 

creating dual-layer DVDs, you must specify the layer break, which usually 

resides somewhere in the middle of the content.

Note: Seamless audio playback cannot occur across the layer break.

Note: It is not possible to write dual-layer DVDs to DVD-Rs or Rewritable 

DVDs. You can however write projects larger than 4.7 GB to a single-layer 

DVD, for the sake of testing navigation, by truncating audio tracks (see 

“Truncating Audio” on page 231).

To define the Layer Break in Command Editor:

1 Choose Tools > Layer Information. The Layer Information dialog opens.

2 Choose one of the following Layer Break options:
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Opposite  The disc is formatted so that the data track starts at the inner end 

of the first layer (Layer 0), continues to the outer end of that layer and then 

continues with the second layer (Layer 1) from the outer edge towards the 

middle of the disc. Select this option when you need the shortest 

interruption in audio playback across the layer break, since the laser beam 

transitions from the outer edge of the first layer to the outer edge of the 

second layer.

When using Opposite, the second layer must be smaller than the first, with 

the layer break residing after the middle of playing time.

Parallel  The disc is formatted so that the data tracks of both layers are 

written starting from the inner end to the outer edge. This option provides 

slower transition times for audio playback, since the laser beam transitions 

from outer edge of the first layer back to the inner end of the second layer.

Select Parallel if the second portion of the content is larger than the first 

and must play seamlessly.

3 Select the track that you want to reside after the layer break. If using 

Opposite, the track must be after the middle of playback.

4 Click Ok to close the Layer Information dialog.

Video At t r ibutes

The Video Attributes dialog configures basic video settings for the project, 

which include NTSC/PAL, aspect ratio, and Line 21.

Note: Video Attribute settings are global and apply to all content on the 

DVD. It is not possible, for example, to have some material set to NTSC and 

other material set to PAL.
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To configure the video attributes in Command Editor:

1 Choose Tools > Video Attribute. The Video Attributes dialog opens.

2 Set the TV System to one of the following options:

NTSC  Video standard used in the U.S, Canada, Japan, and Korea. Select this 

option when preparing a DVD for those markets, or when preparing a DVD 

for world-wide release, since most PAL-based entertainment systems can 

play NTSC discs.

PAL  Video standard used in Europe. Select this option when preparing a 

DVD specifically for the European market. NTSC-based entertainment 

systems cannot play PAL discs. 

3 Set the Aspect Ratio to one of the following options:

• Select 4x3 when preparing DVDs for most entertainment systems.

• Select 16x9 when preparing for the more modern entertainment 
systems that support the larger format, or if you want to retain the full 
width of material when using film-based content.
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4 If the Aspect Ratio is set 16x9, choose one of the following Display 

Modes (to allow for playback on 4:3 systems):

Both  Provides both Letter Box and Pan-scan displays.

Letter Box   The full width of the screen is displayed (16x9), but with black 

bars at the top and the bottom of the screen. The actual picture size is 

reduced to retain the 16x9 aspect ratio while displaying the entire width.

Pan-scan  Left and right portions of the screen are cropped. The video is 

displayed with no black bars and the picture size is not reduced.

5 If preparing a disc that contains closed captions, set Line 21 to On. 

6 If the Aspect Ratio is set to 16x9 and the project contains letter-boxed 

images, set the Source Picture Letter Boxed option to LB.

7 Click OK to close the Video Attributes dialog.

Note: The project’s images and video content must match the selected TV 

System and Aspect Ratio.

Audio Text  Data
In future versions of DVD-Audio Creator it will be possible to import Audio 

Text Data xml files here. [or is that already possible? If so please provide 

file requirements]
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Copy protect ion (CCI )

You can use the Copy Protection controls in Command Editor to specify 

how the project’s audio and images (for menu pages, linked lyrics, 

slideshows, and stillshows) are copy protected.

To configure copy protection for a project:

1 In the Command Editor’s main window, select the items for which you 

will configure copy protection:

• To copy protect an individual item in the project, select and audio 
track, menu page, or slide image, or slide image.

• To copy protect multiple items in the project, select the group, audio 
track, video track, or Slideshow containing the items.

• To apply copy protection globally for all content in the project, select 
the Album.

2 For the selected audio tracks, do one of the following:

• To allow the audio to be freely copied, select Freely from the Audio CCI 
menu.

• To enable copy protection for the audio, select from the Audio CCI 
menu one of the following grades of protection offered by CPPM 
(Content Protection for Prerecorded Media):

- 2-channel CD quality

- Multichannel CD quality

Copy Protection controls 
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- 2-channel full quality

- Multichannel full quality

3 For the selected images, do one of the following:

• To allow the images to be freely copied, select Freely from the CCI 
menu.

• To enable copy protection for the images, set the CCI menu to 
Restricted and select from the Analog menu one of the following grades 
of protection offered by CPPM:

- Type1

- Type2

- Type3

DVD content is not encrypted until the master is created from the DLT tape 

(written by Imager). The flags for the Copy Control Information (CCI) are 

merely set in the Command Editor. If necessary, for testing purposes, the 

CCI can be reset (disabled) in Imager when writing the disc image to a 

hard drive.

Note: Owners of the disc content must sign a CPPM licensing agreement 

before the master can be encrypted.

Return Menu
The Return Menu option, when enabled, instructs the player to return to 

the Audio Manager Menu when playback ends for an audio group.

To set the Return Menu option:

1 In the Command Editor’s main window, select the group for which you 

will configure Return Menu. To affect all groups, select the Album. The 

menu for Return Menu appears in the right side of the window.
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2 Select On from the Return Menu to enable it.

Track node Cont inuous Playback

The Track node option for Continuous Playback determines how the track’s 

audio and images (ASVs) play when transitioning between audio tracks. 

Continuous Playback is configured separately for each track and determines 

the transition from the previous track. It is not necessary to configure 

Continuous Playback for the first audio track in the album.

Depending on the nature of the project’s content, Continuous Playback 

may have to be configured for some or all of the audio tracks (except the 

first) to achieve seamless playback. If there is space (silence) between each 

of the tracks, with no overlap, on the disc, Continuous Playback need not 

be configured.

To configure Continuous Playback for an audio track:

1 In the Command Editor’s main window, select the audio track for which 

you will configure Continuous Playback. The Track node controls for 

Continuous Playback appear in the right side of the window.

2 Select from the following Continuous Playback options:

AOB   (Audio Object) Provides for uninterrupted playback when 

transitioning between audio tracks. With this option, the Format 

application multiplexes the data streams so that seamless playback is 
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ensured. When using AOB, the neighboring audio tracks must have the 

same sample rate, bit depth, and number of channels; otherwise, Format 

will return an error message.

ASVU  The track’s associated images are preloaded into a 2 MB buffer and 

made available for display during playback. A group of images (ASVs) that 

stretches over an uninterrupted passage of music is an Audio Still Video 

Unit (ASVU). A new set of images can only be loaded into the buffer when 

there is an interruption in audio playback.

ASVU Range  Extends the range of the ASVU from the selected track to the 

previous track, ensuring that the images for both tracks are preloaded into 

a 2 MB buffer and made available for display during playback of either 

track. 

2 MB BUFFER LIMIT FOR ASVU

Although there is a 2 MB limit for the buffer size for ASVUs, there is no limit 

to the number of images that can be loaded into the buffer. As many as 20–

25 images may fit into this buffer. However, as you go beyond this number 

Continuous Playback

Audio 
Track 1

Audio 
Track 2

Audio 
Track 3

Audio 
Track 4

Audio 
Track 6

ASVsASVs ASVs ASVsASVs

Images for Tracks 2–3 (ASVU) 
preloaded into buffer

Tracks overlap and transition 
with no pause in playback
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of images, the ASVU size may exceed the 2 MB limit, causing the Format 

application to use the necessary MPEG-2 compression to fit the images into 

the buffer, which can lead to display artefacts.

Sett ing the menu palet te

A menu palette’s color and transparency settings define how key colors for 

imported xxx_HL graphic files are interpreted for displaying the three 

button states (Normal, Select, and Action). The Palette Editor defines, for 

the selected menu page, which colors and transparencies are used and 

with which button states they are associated. 

When importing menu files with Import Menu (see Chapter 5, “Import 

Menu”), there are two available color schemes (see below), either of which 

can trigger the desired display colors, with the desired degree of 

transparency.

Sonic  Black, blue and red on white background, where:

• White areas on the xxx_HL.tif trigger the “Background” color

• Black areas on the xxx_HL.tif trigger the “Border” color

• Blue areas on the xxx_HL.tif trigger the “Foreground” color

• Red areas on the xxx_HL.tif trigger the “Caption” color

MEI  Red, blue and green on black background, where:

• Black areas on the xxx_HL.tif trigger the “Background” color

• Red areas on the xxx_HL.tif trigger the “Border” color

• Blue areas on the xxx_HL.tif trigger the “Foreground” color

• Green areas on the xxx_HL.tif trigger the “Caption” color

[Please verify the MEI color scheme, never worked with this!]
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To set the palette colors for a menu page:

1 In the Command Editor’s main window, select the menu page for which 

you will set the color palette. The Track Menu node appears in the right 

side of the window.

2 Click Set Palette Color to open the Palette Editor.

3 To define the colors for Normal, Select, and Action, drag any of the 16 

colors in the Color Set to Background, Foreground, Caption, and Border. 

You can also enter Index numbers (1–16, from the Color Set) in the 
appropriate field for Background, Foreground, Caption, and Border.
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4 If desired, enter a Transparency value (0–15) for each of the colors, 

where 0 is completely transparent and 15 is full saturation.

5 Click OK to close the Palette Editor and confirm the color palette 

changes. 

Menu palettes are defined individually, but can be easily copied to other 

menu pages (see “Copying color palettes between menu pages” on page 

181).

Editing the Color Set

The Color Set can hold up to 16 colors, which are used to define the colors 

for the three button states. The colors in the Color Set can be defined in the 

Color dialog.
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To define a new or existing color in the Color Set:

1 In the Palette Editor dialog, double-click the color you want to edit. The 

Color dialog opens.

2 Select one of the Basic colors and click OK.

– or –

Double-click 
to edit color
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3 Define a custom color. Click Define Customer Color to expand the 

Color dialog and do the following:

• Click in the color rainbow to choose the new color (drag the 
Luminance control on the right side of the dialog to make any necessary 
adjustments). You can also enter numeric values in the fields for Hue, 
Saturation, and Luminance and Red, Green, and Blue.

• Click “Add to Custom Colors” to add the new color to the Custom 
Colors.

• Select the new Custom Color and click OK to close the Color dialog.

4 The new color appears in the Color Set in the Palette Editor.

Adding button color families

If one set of colors for Select and Action is insufficient for the button color 

variations in a menu page, you can add up to two more families of button 

colors for both Select and Action.

Luminance 
control
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To add button color families for Select and Action:

1 In the Select Color section of the Palette Editor, click Add. A second 

family of button colors (Color #2) appears.

2 If desired, click Add to add a third family of Select Colors. The Color #3 

family appears.

3 Repeat the previous steps, if necessary, for the Action Colors.

4 To select a button color family for editing, click its tab (Color #1, 

Color #2, or Color #3) to bring it to the front.

5 To delete the front-most button family, click Delete.

6 Click OK to close the Palette Editor and confirm the color palette 

changes.

Buttons are assigned color numbers in the Property window. For more 

information, see “Button Color Number” on page 206.

Copying color palettes between menu pages

You can easily apply the color palette of a menu page to other menu pages 

by copying and pasting.



182 Chapter 8, Command Editor
To copy and past a color palette between menu pages:

1 In the Command Editor’s main window, Right-click the menu page 

containing the color palette you want to copy. 

2 Choose Copy Palette from the menu that appears.

3 To paste the color palette, do one of the following: 

• To paste to an individual menu page, Right-click it and choose Paste 
Palette from the menu that appears. 

• To paste to all menu pages in a group, Right-click the group and choose 
Paste Palette from the menu that appears. 

• To paste to all menu pages in the project, Right-click the Album icon 
and choose Paste Palette from the menu that appears.
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Set  Menu Page

The Set Menu Page command opens the selected menu page for editing in 

the Property and Preview windows, where you can define button and page 

properties. 

For Button Properties, you can define:

• Button Commands

• Cursor Movement

• Button Order ordering

• Color Number

• Auto Activate

For Page Properties, you can define:

• Forced Selection and 

• Forced Activation

• Cell Still Time

• Button Offset

• Number of Selectable Buttons

• Visual Effects

Maybe say something here about copying page properties between menu 

pages and provide a cross-ref. However, I’m not really sure how to make 

this work, and what actually gets copies, what about the button properties?
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Editing a menu page

To open a menu page for editing:

1 In the Command Editor’s main window, do one of the following:

• Select the menu page you want to edit and click Set Menu Page in the 
Page node (in the right side of the window). The Property and Preview 
windows open.

• Select the menu page you want to edit and choose Tools > Set Menu 
Page. The Property and Preview windows open.

• Double-click the menu page you want to edit. The Property and Preview 
windows open.

Preview and Property windows
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The Property window contains View options for the Preview window, 
as well as Button Properties and Page Properties. The Preview window 
displays the edited menu page, where you can view and select buttons 
for editing.

2 In the Property window, set the size of the Preview window by 

selecting a zoom level (50%, 67%, 100%, 150%) from the Zoom menu. 

3 If you will be editing Cursor Movement for buttons, set the Show 

Button Links option to On. If a button has Cursor Movement defined, 

the movement is indicated with arrows in the Preview window when 

the button is selected.

4 To close the Property and Preview windows and confirm any new 

settings, click OK in the Property window.

Buttons Cursor Movement

With the Button Properties you can specify how the cursor moves (with 

the remote’s RIGHT, LEFT, UP, and DOWN arrows) from button to button 

on a Menu Page.

To define the cursor movement for the buttons on a menu page:

1 In the Command Editor’s main window, double-click the Menu Page 

containing the buttons you want to define. The Property and Preview 

windows open.

2 In the Preview window, click the button (so it becomes selected) for 

which you will define the cursor movement.
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3 In the Property window, select the button destinations from the Left, 

Right, Up, and Down menus. If you don’t want a cursor direction to 

have any effect on a button, leave it set to the selected button.

4 In the Property window, select View > Show Button Links > On. In the 

Preview window, verity the arrow directions for the selected button.

5 Repeat the previous steps for each button in the Menu Page.

6 Click OK in the Property window to confirm the changes for Cursor 

Movement. The Property window closes.
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Button Commands

Menu page buttons can be defined to perform a wide range of commands, 

such as playing an audio track, advancing through a slideshow, jumping to 

another Program Chain, or returning the Audio Manager Menu. When the 

user selects and activates the button, the command is executed.

Button commands are defined in the Property window. The available 

command types is dependent on whether the button resides in an Audio 

Manager Menu or a Title Group Menu.

To define a button command:

1 In the Command Editor’s main window, double-click the menu page 

containing the buttons you want to edit. The Property and Preview 

windows open.

2 To select a button for editing, do one of the following:

• In the Preview window, select the button for which you will define the 
command, then click Edit in the Command section of the Property 
window. The Command Editor dialog opens.

• In the Preview window, double-click the button for which you will 
define the command. The Command Editor dialog opens.
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Undefined buttons appear in the Command Editor dialog as having a 
command that is “Invalid.”

3 To remove a button definition, click Delete. This is necessary if the 

button was previously defined and you want to use a different 

command type.

4 To edit the button command, click Edit, or double-click the command 

line.
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5 In the Command Type dialog, select a command type (see “Button 

Command Types” on page 190 for a description of each type), then 

click OK.

6 In the Edit Command dialog, configure the command’s parameters (see 

“Button Command Types” on page 190 for a description of command 

parameters).

7 To add comments to the button command, click the Comment tab at 

the top of Edit Command dialog and enter the text you want associated 

with the command. Command comments are provided only as a source 

of reference and do not affect the command, nor do they appear 

anywhere else in the Command Editor application.

8 Click OK to close the Edit Command dialog. The new command appears 

in the Command Editor dialog.

9 Click OK to close the Command Editor dialog.

10 Repeat the previous steps to define any additional buttons in the menu 

page.

11 Click OK in the Property window to confirm the new button 

definitions. The Property window closes.
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BUTTON COMMAND TYPES

The following sections describe each of the button command types.

NOP (Audio Manager Menus only)

The Nop command indicates that “No Operation” is assigned to the button. 

If you want to leave a button temporarily unassigned but still enter some 

comments, as a placeholder, you can use the Nop command.

[How come buttons default to “Invalid” instead of Nop? Is there a 

difference between the two?? Is there some sort of functional reason why 

you would choose Nop for button, aside from being able to ad comments. 

Why are Nops only available with AMGM buttons?]

Set (Audio Manager Menus only)

The Set command assigns a value to one of 16 available General Parameters 

(GP). This function can be used to keep track of status information that can 

later be recalled, as the user navigates the DVD.

The Set Variable specifies which GP will be set (0–15). The Set Value 

(depending on the Set Operator) can be entered as an integer (0–65536), 

other GP, or System Parameter (0–25).

The following operators are available with the Set command:

Set command
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Move (=)  Assigns a numerically entered or GP/SP value to the GP variable. 

Swap (<- ->)  Swaps the GP variable with another GP value (SPs and 

numerical input not available for this operation).

Add (+=)  Adds the numerically entered or GP value to the GP variable (SPs 

not available for this operation).

Subtract (–=)  Subtracts the numerically entered or GP value from the GP 

variable (SPs not available for this operation).

Multiply (*=)  Multiplies the GP variable by the numerically entered or GP 

value (SPs not available for this operation).

Divide (/=)  Divides the GP variable by the numerically entered or GP value 

(SPs not available for this operation).

Modulo (%=)  Divides the GP variable by the numerically entered or GP 

value and assigns the remainder to the GP variable (SPs not available for 

this operation).

Random (RND)  Assigns a random value, between 0 and the numerically 

entered or GP value, to the GP variable (SPs not available for this 

operation).

AND (&)  The GP variable and numerically entered or GP/SP value are 

converted to binary and a bitwise AND operation is executed (if both 

values are 1, the result is 1) with the result assigned as the new GP variable.

OR (l)  The GP variable and the numerically entered or GP/SP value are 

converted to binary and a bitwise OR operation is executed (if at least one 

of the values is 1, the result is 1) with the result assigned as the new GP 

variable.

Exclusive OR (^)  The GP variable and the numerically entered or GP/SP 

value are converted to binary and a bitwise ExclusiveOR operation is 

executed (if one of the values is 1 and the other 0, the result is 1) with the 

result assigned as the new GP variable.
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There are 25 System Parameters that can be used as the Value for the Set 

command. Of these 25, the following are defined by the DVD-Audio 

specification:

• SP 0, the AMGM language code.

• SP 1, the intended Audio Selection Number and the currently presented 
Audio Selection Number (2 values).

• SP 7, the current Program number.

• SP 8, the currently selected button number.

• SP 21, the current group number.

• SP 23, the current track number.

• SP 24, the current ASV number.

Most of the System Parameters are read only. However, there are two 

system parameters (SP1 and SP8) that can be set with the SetSystem 

command.

SetSystem (Audio Manager Menus only)

The SetSystem command provides access to two System Parameters: SP1 

(Stream Number) and SP8 (Highlight Button Number).

Stream Number  The SetSystem command “Set Stream Number” is used to 

program an audio selection menu in the AMGM Domain that takes effect 

when the user starts music playback in the Title Group Domain.
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In the “Stream Number” field you can either choose

• directly between the first or second Audio Stream or between the first 
or second PGC in a PGC Block (refer to Chapter 11, XML Editing for an 
in-depth description of PGC Block), represented by the values 0 or 1 (as 
in DVD-Audio there can never be more than 2 Audio Streams)      or 

• make this choice from the values currently assigned to any of the GPs 
(however, only 0 and 1 are legal values, so you should only use this 
option when you have made sure that the GP you choose has been set 
elsewhere in the DVD to either 0 or 1 before the user can possibly 
arrive here) 

In the “Assign flag” pane you can chose between the following two options:

• “Assign” = assign the new value to the User’s intended Audio Selection 
Number in SP1

• “Not Assign” = the User’s intended Audio Selection Number in SP1 
remains unchanged

Use the default setting “Assign” to make your SetSystem command take 

effect.

SetSystem command, Stream Number
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[I can’t think of any situation where you would use the “not assign” option. 

What would be the effect of changing the stream number and then not 

assigning it to SP1? I guess that is as if I had not touched a SetSystem 

command at all…so what is that good for?…It just doesn’t make sense to 

me. Can you ask Yuki or Mori-san?] (AU-9, 62-64)

Highlight Button Number  Sets the number for the selected button (SP8). 

Use this option when you need to control which menu page button is 

selected. The button number can defined by directly entering a numeric 

value, or by using one of the GPs (0–15). The Highlight Button Number can 

only be set to multiples of 1024 (for example, 1024, 2048, 3072, all the way 

up to 36864).

SetSystem command, Highlight Button Number
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Branch

The Branch command defines links between different elements on a DVD. 

For example, you could provide links from one audio track to other audio 

tracks in the same group, or you could provide a link back to the Audio 

Manager Menu, where the available Program Chains could be browsed.

The types of destinations available for Branch depend on whether you are 

working with an Audio Manager Menu, Title Group Menu, or Linked Lyrics 

Menu. Each of the Branch destinations is discussed in the following 

sections.

Branch command
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Exit  (Audio Manager Menus only) Stops playback of the disc.

Goto Label  (Audio Manager Menus only) Executes one of the following 

options:

• Resume, continues playing the current Title Group from the beginning 
of the track, where the remote’s TOP MENU button was pressed to 
access the Audio Menu Manager.

Branch Exit

Branch Goto Label
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[Dietrick, please decipher what this is supposed to mean. I haven’t a clue! 

Thanks, Greg]

• Goto PreCommand, branches to the PreCommand of the current 
Program Chain.

• Goto PostCommand, branches to the PostCommand of the current 
Program Chain.

Group  (Audio Manager Menus only) Branches to the selected Title Group.

Track  For Audio Manager Menus, branches to the selected audio or video 

track, which can be any track on the disc. For Title Group Menus, branches 

to the selected track within the current group.

Branch Group

Branch Track
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When using Branch Track with a Title Group Menu, you can set the Forced 

Selection Button for the track’s first menu page. Select a button from the 

Highlight Button Number menu and that button will become selected 

when arriving at the page (provided the menu page has Forced Selection 

set to None, see “Forced Selection” on page 206).

AMGM Menu PGC  (Audio Manager Menus only) Branches to another 

Program Chain.

Page  For Audio Manager Menus, branches to another menu page within the 

same Program Chain. For Title Group Menus, branches to another menu 

page within the current track.

Branch AMGM Menu PGC

Branch Page



Set Menu Page 199
When using Branch Page with a Title Group Menu, you can set the Forced 

Selection Button for the linked menu page. Select a button from the 

Highlight Button Number menu and that button will become selected 

when arriving at the page (provided the menu page has Forced Selection 

set to None, see “Forced Selection” on page 206).

Marker  (Linked Lyrics Menu only) Branches to a Linked Lyrics Marker 

within the current audio track, which can be specified as a specific marker, 

or as the next or previous marker.

When using Branch Marker, you can specify the Forced Selection Button for 

the track’s first menu page. Select a button from the Highlight Button 

Number menu and that button will become selected when arriving at the 

page (provided the menu page has Forced Selection set to None, see 

“Forced Selection” on page 206).

Branch Marker
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If Set (Audio Manager Menus only)

The If Set command performs a Set command (see “Set (Audio Manager 

Menus only)” on page 190) if the conditional comparison between a 

variable (GP0–16) and a value (numerically entered integer between 0–

65536, GP0–16, or SP0–25) is met.

The following conditionals are available with the If Set command:

Equal (==)  If the GP variable is equal to the numerically entered or GP/SP 

value, the Set command is performed.

Not Equal (!=)  If the GP variable is not equal to the numerically entered or 

GP/SP value, the Set command is performed.

Greater than or Equal to (>=)  If the GP variable is greater than or equal to 

the numerically entered or GP/SP value, the Set command is performed.

Greater than (>)  If the GP variable is greater than the numerically entered 

or GP/SP value, the Set command is performed.

Less than (<)  If the GP variable is less than the numerically entered or 

GP/SP value, the Set command is performed.

Less than or Equal to (<=)  If the GP variable is less than or equal to the 

numerically entered or GP/SP value, the Set command is performed.

If Set command
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Bitwise compare (BC)  The GP variable and numerically entered or GP/SP 

value are converted to binary and a bitwise AND operation is executed. If 

both are 1, the Set command is performed.

After assigning the If Set Variable, Condition, and Value, click the Set tab (at 

the top of the Edit Command dialog) to configure the Set command to be 

performed. 

If SetSystem (Audio Manager Menus only)

The If SetSystem command performs a SetSystem command (see 

“SetSystem (Audio Manager Menus only)” on page 192) if the conditional 

comparison between a variable (GP0–16) and a value (numerically entered 

integer between 0–65536, GP0–16, or SP0–25) is met. The If SetSystem 

command uses the same conditionals as the If Set command. For a 

description of these conditionals, see “If Set (Audio Manager Menus only)” 

on page 200.

After assigning the If SetSystem Variable, Condition, and Value, click the 

SetSystem tab (at the top of the Edit Command dialog) to configure the 

SetSystem command to be performed. 

If SetSystem command
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If Branch

The If Branch command performs a Branch command (see “Branch” on 

page 195) if the conditional comparison between a variable (GP0–16) and a 

value (numerically entered integer between 0–65536, GP0–16, or SP0–25) 

is met. The If Branch command uses the same conditionals as the If Set 

command. For a description of these conditionals, see “If Set (Audio 

Manager Menus only)” on page 200.

After assigning the If Branch Variable, Condition, and Value, click the 

Branch tab (at the top of the Edit Command dialog) to configure the Branch 

command to be performed. 

Set Branch

Set Branch combines the Set commands with the Branch; however, all 

Branch commands that perform a Jump from AMGM_DOM to TT_GR_DOM 

are unavailable as SetBranch commands.

If Branch command
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SetSystem Branch

SetSystem Branch combines the SetSystem commands with the Branch 

commands; however, all Branch commands that perform a Jump from 

AMGM_DOM to TT_GR_DOM are unavailable as SetBranch commands.

COMMENTS FOR BUTTON COMMANDS

Under “Comment” you can take your own notes as to for what purpose you 

chose which operation or the like. Comment entries do not at all affect the 

navigation behavior of your DVD, they are just for your own records.

Auto Activate

Normally, when cursoring to a menu button with the remote control, the 

button becomes selected and the user must then press ENTER or OK to 

activate the button’s command. You can facilitate easier navigation for the 

user by setting some buttons to Auto Activate, which allows the buttons to 

automatically perform their function when they are selected.

Deciding whether to use Auto Activate for a button depends on its context, 

its relation to other buttons on the page, and its command. A good example 

for using Auto Activate would be left and right arrow buttons that turn 
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pages in a Multi Page Menu. In this case, you would save the user the 

additional remote control operations when simply stepping forward and 

back through the pages.

To set a button to Auto Activate:

1 In the Command Editor’s main window, double-click the menu page 

containing the buttons you want to set to Auto Activate. The Property 

and Preview windows open.

2 In the Preview window, select the button for which you will enable 

Auto Activate.

3 In the Button Properties section of the Property window, set Auto 

Activate to Yes.

4 Configure any additional buttons as Auto Activate.

5 Click OK to close the Property window and confirm the new button 

settings.

Button Order Number

Each menu page can have up to 36 buttons, each of which is automatically 

assigned a number when the graphic file is imported with Import Menu. 

The numbers, which are visible in the Preview window in Command 

Editor, are assigned based on their position, starting from left to right at the 

top of the screen and moving down.
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If you need to change the default button numbering (for example, to affect 

numeric selection of buttons from the remote control), you can edit the 

button order from the Property window in Command Editor.

To edit the button order for a menu page:

1 In the Property window, click Edit Button Order. The Button Order 

dialog opens, displaying a list of buttons with their assigned numbers 

(to the left).

2 To change a button’s location in the order, drag it up or down to a new 

location. The button is assigned the new order number and the 

neighboring buttons are updated as well.

3 Repeat the previous step, as necessary, for additional buttons.

4 Click OK to close the Button Order dialog and confirm the new button 

ordering.
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Button Color Number

As discussed in “Adding button color families” on page 180, up to three 

families of button colors can be defined for each menu page. Button color 

families can be used to distinguish the appearance of some buttons from 

others.

To set a button’s Color Number:

1 From the Command Editor window, double-click the menu page 

containing the buttons you want to change. The Property and Preview 

windows open.

2 In the Preview window, select the button for which you will set the 

Color Number.

3 In the Button Properties section of the Property window, choose a 

Color Number from the Select and Active menus.

4 Click OK to close the Property window and confirm the new Color 

Number settings.

Forced Selection

When arriving at a menu page, there is always one button automatically 

selected. This button is called the Forced Selection button. Specifying 

which button is the Forced Selection button facilitates navigating the page 

once the user arrives there. 

To set the Forced Selection Button for a menu page:

1 From the Command Editor window, double-click the menu page for 

which you will set Forced Selection. The Property and Preview 

windows open.
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2 In the Page Properties section of the Property window, choose one of 

the following options from the Forced Selection menu:

Button Number  Sets Forced Selection to a fixed button number. When 

arriving at the menu page, this button will always be selected, regardless of 

how the user arrives at the menu page.

None  Leaves the Forced Selection button undefined, so it can be set 

variably with either of the following methods:

• By a SetSystem command in the PreCommand of a Program Chain (see 
“PreCommands and PostCommands” on page 215).

• By a button command that leads to the menu page (see “Branch” on 
page 195).

A None setting results in button B1 becoming selected if there is no 

definition of the Forced Selection button by a PreCommand or by a button 

command leading to the menu page.

Forced Activation

One of the buttons on an Audio Manager Menu page can be set to Forced 

Activation. This button becomes active after the Cell Still Time has elapsed 

(see “Cell Still Time” on page 209), even if the user has not taken any 

remote control action. The Forced Activation button never becomes active 

if the Cell Still Time is set to Infinite.
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The Forced Activation button can be the same button as the Forced 

Selection button (see “Forced Selection” on page 206), or it can be a 

different button.

To set the Forced Activation button for an Audio Manger Menu page:

1 In the Command Editor’s main window, double-click the Audio Manager 

menu for which you will set Forced Activation. The Property and 

Preview windows open.

2 In the Page Properties section of the Property window, select a button 

number from the Forced Activation menu.

3 Click OK to close the Property window and confirm the new Forced 

Activation button.

Note: Only Audio Manager Menu pages have a Forced Activation button. 

This capability is not available for Title Group Menu pages.
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Cell Still Time

You can use the Cell Still Time to program movement from the Audio 

Manager Menu after a specified amount of time has elapsed. After this time 

elapses, one of the following events will occur (in order of priority):

• Execute the command for the Forced Activation button, if one exists for 
the Audio Manager Menu page.

• Move to the next page in a Multi Page Menu, if one exists within the 
Program Chain.

• Move to the PostCommand for the Program Chain (see “PreCommands 
and PostCommands” on page 215).

• if no PostCommand exists, or if it contains no Branch instruction, move 
to the next Program Chain, if one exists.

If none of these conditions is met, the DVD will remain on the Audio 

Manager Menu page indefinitely, regardless of the defined Cell Still Time.

[true? I don’t know and Torsten doesn’t know either but he says: "that’s bad 

programming anyway!!"]

To configure the Cell Still Time for an Audio Manager Menu page:

1 In the Command Editor’s main window, double-click the Audio Manager 

menu for which you will configure Cell Still Time. The Property and 

Preview windows open.

2 In the Page Properties section of the Property window, enter a value for 

Cell Still Time:
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• Enter a time value in seconds between 0–254. This is the amount of 
time that must elapse before moving from the Audio Manager Menu 
page.

• Select and clear the field to set it to Infinite (the default). When Cell Still 
Time is set to Infinite, the Audio Manager Menu page will not advance 
until the user clicks a menu button or remote control button.

3 Click OK to close the Property window and confirm the new Cell Still 

Time.

Note: Only Audio Manager Menu pages have the Cell Still Time option. 

This capability is not available for Title Group Menu pages.

Number of Selectable Buttons

As discussed in “Button Order Number” on page 204, each button of a 

menu page is assigned a number. In addition to affecting cursor navigation 

between buttons, the button numbers can be used for numeric selection 

from the remote control’s numeric keys.

In the Property window, you can specify whether some or all of the 

buttons are available for numeric selection.
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To define which buttons on a menu page can be numerically selected:

1 From the Page Properties section of the Property window, select one of 

the following options from the menu for Number of Selectable Buttons:

• Select “Same as Number of Buttons” to have all buttons numerically 
selectable.

• Select “0” to have no buttons numerically selectable.

• Select a specific (button) number to have all buttons up to that number 
numerically selectable.

2 Click OK to close the Property window and confirm the new button 

settings.

Button Offset Number

You can offset the button numbers in a menu page. This would be 

necessary to ensure that higher-numbered audio tracks are numerically 

selectable from the remote control. For example, if you had more than 36 

audio tracks and wanted to make sure that track 37 and beyond were 

selectable (menu pages can only hold 36 buttons), you could offset the 

button numbers so they matched the higher-numbered tracks.
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To set the Button Offset for a menu page:

1 In the Command Editor’s main window, double-click the menu page for 

which you will set the Button Offset. The Property window opens. 

2 In the Page Properties section of the Property window, enter a numeric 

value between 0–255 for the Button Offset Number.

3 Click OK to close the Property window and confirm the new Button 

Offset Number.

The Button Offset applies to all buttons in the menu page. For example, if 

you entered an offset of 36 for a menu page that had eight buttons, those 

button numbers would be numbered as 37–44.

Visual Effects for ASV Transitions

You can define visual effect transitions between ASVs (menu pages, linked 

lyrics, and slides) within each audio track. 

For example, to set the visual effects for the slides in a Slideshow:

1 In the Command Editor’s main window, double-click the slide image for 

which you will set the visual effects. The Property window opens.

The Page Properties section of the Property window displays the Visual 
Effect controls.
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2 Set the Start Effect Mode by doing one of the following:

• For the first image in the Slideshow, select either Cut or Fade from the 
Start Effect Mode menu.

• For subsequent images in the Slideshow, the effect cannot be changed 
and is determined by the End Effect Mode for the previous image in the 
Slideshow.

3 Select a time value from the Start Effect Time menu (0–15). This value 

determines the speed of the effect.

4 Select one of the following effects from the End Effect Mode menu:

• Cut

• Fade

• Dissolve

• Wipe from top

• Wipe from bottom

• Wipe from left

• Wipe from right

• Wipe diagonal left

5 Select a time value from the End Effect Time menu (0–15). This value 

determines the speed of the effect.

6 Repeat the previous steps for any additional slide images.

7 Click OK to close the Property window and confirm the new effect 

settings.

To configure a slide image with no visual effects (the default):

1 In the Command Editor’s main window, double-click the slide image for 

which you will set the visual effects. The Property window opens. The 

Page Properties section of the Property window displays the Visual 

Effect controls.
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2 Select Cut from the Start and End Effect Mode menus.

3 Select 0 from the Start and End Effect Time menus.

4 Click OK to close the Property window and confirm the new effect 

settings.

Note: Visual effects are optional features in the DVD-Audio Spec and 

may not be supported (and therefor viewable) on many DVD-Audio 

players.

[Dietrick, do we have to go into detail here? Or can you recycle all those 

Effect mode rules from earlier recipes or the like? I somehow can’t 

convince myself it is worth the extra working time to outline all those 

things like end effect of this one has to match start effect of next one 

etc…when none of the current players lets you see any of these….]

Start Timing

No info available on this feature...

[Dietrick, how is this operated? Not sure what the preconditions for this to 

become active are in Import Menu/Author (new function in 3.0.3)]

Copying page properties between menu pages

You can easily apply the page properties of one menu page to another by 

copying and pasting.

To copy and past page properties between menu pages:

1 In the Command Editor’s main window, Right-click the menu page 

containing the page properties you want to copy. 

2 Choose Copy Page Properties from the menu that appears.
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3 Right-click the menu page to which you want to copy the page 

properties.

4 Choose Paste Page Properties from the menu that appears.

Note: It is not possible to paste page properties to multiple menu pages by 

pasting to a group or the Album. You must paste to each desired menu 

page individually.

PreCommands and PostCommands

Each Program Chain has a PreCommand and a PostCommand, both of 

which can use the same commands available for button commands (see 

“Button Commands” on page 187 for details). However, while menu 

buttons contain just one command, PreCommands and PostCommands can 

have up to 128. When a Program Chain is reached, its PreCommand is 

executed before playback begins. Once playback finishes, the 

PostCommand is executed.
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A PreCommand could be used to set the Forced Selection button (with 

SetSystem) for the first menu page in the Program Chain. In addition, 

another command, inserted before this one, could check a condition to see 

if the Program Chain should be played, or whether the DVD should link 

somewhere else.

A PostCommand could be used to link to another Program Chain or back to 

the main menu. PostCommands can also be used when a button within the 

Program Chain requires more than one command; the button would use a 

Branch command with a GoTo Label that points to the Post Command, 

which can hold up to 128 commands.

Note: Unlike the PreCommand, a Program Chain’s Post Command may 

not always get processed. If a button within the Program Change uses a 

Branch command to link out of the current Program Chain, the 

PostCommand is bypassed.

To configure a PreCommand or PostCommand for a Program Chain:

1 In the Command Editor’s main window, select the Program Chain for 

which you will set the PreCommand or PostCommand. The Menu node 

appears in the right side of the window.

2 In the Menu node, click Set Pre Commands or Set Post Command. The 

Command Editor dialog opens.
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3 Click Insert to add a new command. The Command Type dialog opens.

• Select a command from the Type menu (for information on the different 
command types, see “Button Commands” on page 187), then click OK. 
The Command Type dialog closes and the Edit Command dialog opens.

• Configure the command’s parameters (see “Button Commands” on page 
187 for details) and click OK. The Edit Command dialog closes and the 
new command appears in the Command Editor dialog.

4 Insert additional commands (up to 128) as needed.

5 To edit an existing command, select the command line you want to edit 

and click Edit, or double-click the command line.
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6 To delete a command, select the command line you want to delete and 

click Delete.

7 Click OK to close the Command Editor dialog and confirm the new 

PreCommand or PostCommand.

The command lines for PreCommand and PostCommand can be processed 

sequentially, or you can use the GoTo Label command to affect their order. 

To use GoTo Label in a PreCommand or PostCommand, you must label the 

command lines you want to reference.

To label a command line in a PreCommand or PostCommand:

1 In the Command Editor dialog, select the command line you want to 

label.

2 Enter a name in the Label field.

3 Click Set Label to label the selected command line. The label for the 

command appears in the list of command lines, and also appears as a 

GoTo Label destination for any Branch commands residing in the same 

Pre/PostCommand.

Cell  Commands
Audio Manager Menu pages can each have a Cell Command, which is 

performed once the page’s Cell Still Time elapses. If the Cell Still Time for 

the page is set to Infinite, the Cell Command is not performed.

Cell Commands use the same commands as buttons (see “Button 

Commands” on page 187 for details). Just like buttons, Cell Commands can 

only contain one command (unlike PreCommands and PostCommands, 

which can contain up to 128 commands).

[Still not sure how Cell Command interacts with Forced Activation. If both 

are defined, which comes first after Cell Still Time elapses? -GT]
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To define a Cell Command for an Audio Manager Menu page:

1 In the Command Editor’s main window, select the Audio Manager Menu 

page for which you will define the Cell Command. The Page node 

controls appear in the right side of the window. 

2 In the Page node section, click Set Cell Command. The Command Editor 

dialog opens.

3 Click Insert to add a new command, or click Edit to edit an existing 

command. The Command Type dialog opens.

• Select a command from the Type menu (for information on the different 
command types, see “Button Commands” on page 187), then click OK. 
The Command Type dialog closes and the Edit Command dialog opens.

• Configure the command’s parameters (see “Button Commands” on page 
187 for details) and click OK. The Edit Command dialog closes and the 
new command appears in the Command Editor dialog.

4 Click OK to close the Command Editor dialog and confirm the new Cell 

Command.
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Defining Next ,  Prev,  and GoUp

For navigating between AMGM Program Chains, you can define the remote 

control buttons for NEXT, PREVIOUS, and RETURN with the Menu node.

To define Next, Prev, and GoUp for an AMGM Program Chain:

1 In the Command Editor’s main window, select the AMGM Program 

Chain for which you will define Next, Prev, and GoUp. The menu 

controls for Next/Prev/GoUp PGC appear in the left side of the window.

2 From the Next menu, select the Program Chain to which the user will 

navigate when pressing the remote control button for NEXT.

3 From the Prev menu, select the Program Chain to which the user will 

navigate when pressing the remote control button for PREV.

4 From the GoUp menu, select the Program Chain to which the user will 

navigate when pressing the remote control button for RETURN. 
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Slideshow node (playback t iming)

The default playback timing for Stillshows is “0” (or infinite), which means 

the pages only advance if the remote control PAGE buttons are used. The 

timing for Slideshows is determined by a duration value set in the 

Slideshow Properties window in Author; in this case, the pages advance 

once the slide’s duration value elapses.

You can change the playback timing for a Slide show or Stillshow from the 

Slideshow node in Command Editor.

To set the playback timing for a Slideshow or Stillshow:

1 In the Command Editor’s main window, select the Slideshow or 

Stillshow for which you will set the playback timing.

2 Enter a duration value (in milliseconds) for both Max Duration and Min 

Duration:

• Enter identical values for Min and Max Duration to use that duration for 
the playback timing.

• Enter different values for Min and Max Duration to use a random 
duration (between the two values) for the playback timing.

• Enter a value of 0 for Min and Max Duration if you want the Slideshow 
or Stillshow to advance only when the remote control PAGE buttons are 
pressed.

[Question: how large of a duration value can be entered for these fields?]
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Note: The remote control PAGE buttons are always “live” and can 

advance a Slideshow, even if the duration for the playback timing has not 

elapsed.

Linked Lyr ic  node (Display  Order)

If using Linked Lyrics, you can set the display order for them with the 

Linked Lyric node.

To set the display order for linked lyrics:

1 In the Command Editor’s main window, select the Linked Lyrics for 

which you will set the display order.

2 Choose from the Display Order menu one of the following options:

• Sequential, lyrics are displayed sequentially, in the order they were 
entered in Author (as they appear In the Command Editor’s main 
window).

• Random, lyrics are displayed in a randomly generated order by the 
player.

• Shuffle, lyrics are displayed in a randomly generated order by the player. 
Unlike Random, no lyric is repeated until all others have been displayed.



9 Format
This Chapter Under Construction

Using Format

Format generates a disc image from previously-created XML script files, 

audio data, and images.  The generated disc image can then be used in 

Imager to write to DLT tape or Raw HDD.
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To ljlkjzlxkjvclxzkjcvlkzx

1 From the Windows Start menu, choose Programs > DVD-Audio Creator 

> Format. The Format window opens.

2 To open the SFF.XML file for the project, do one of the following:

• Choose File > Open, or click Browse, and navigate to and select the 
XML file, then click Open.

• Drag the XML file to the open Format window. You can also drag the 
XML file to the Format application icon on the desktop to automatically 
launch Format and open the file.
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3 Click Directory and set the destination folders for ELEM (elementray 

file), VOB (system stream), and IMG (disc image). In the Directory 

dialog, click Browse and select the folder for each. Click OK to close 

the Directory dialog.

4 In the Format window, select the Operation parameters you want 

enabled for the Execute. For an explanation the Operation paramters, 

see “Operation Parameters” on page 233.

5

6

7 Click Execute
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8

9

10

Format Option

The Format Option determines what happens when Format encounters a 

“spec” violation when writing to the Video Zone. 

To set the Format Option:

1 Choose Settings > Format Option. The Format Option dialog opens.

2 Choose one of the following Format options:

Stop Format when Spec violation is detected in Video Zone  Formatting is 

interruped when encountering a spec violation. Make sure to select this 

option to verify the content written to the Video Zone.
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Continue Format when Spec violation is detected in Video Zone  Formatting 

continues when encountering a spec violation. If you know there are 

problems with the current project and still want to write the disc image, to 

verify and test other content on the disc, select this option.

3 Click OK to close the Format Option dialog.

Book Version

By default, Format generates disc images that are compliant with Book 

Version 1.25. If necessary, you can generate version 1.1 disc images. The 

disc image version generated by Format is stored in the registry and is 

easily changed.

To set the Book Version for disc images generated by Format:

1 Double-click one of the following files, located in the DVD-Audio 

Creator folder:

• BookV11S (for version 1.1)

• BookV125 (for version 1.2)

2 When prompted to verify the change to the registry, click Yes. The 

registry is updated with the selected Book Version. 

Changes to the registry are unique to the particular user who is logged in. 

These changes are also retained after uninstalling or installing new versions 

of Format.

Formatt ing for  Dual  Discs

There are two methods of generating Dual Discs: directly specifying the 

cutting position and describing a track to be cut in SFF.
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To configure a dual disc using Format:

1 Open Format and specify the XML file, directories, and Operation 

parameters. For details, see “Using Format” on page 223.

2 Choose Settings > Cutting Position. The Cutting Position dialog opens.

3 Set the Disk Type to either Opposite or Parallel.

4 Click Browse and select the Cutting File. 

[Not sure whether this should be the SFF.XML file specified in the main 

Format window, or the XML file that is the first audio track in the second 

layer.]

5 Enter the Cutting Sector (a sector number in the cutting file), then click 

OK to close the Cutting Position dialog.

6 Click Execute in the Format window to write disc image.

7
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To configure a dual disc by editing an XML file:

1 Open Format and specify the XML file, directories, and Operation 

parameters. For details, see “Using Format” on page 223.

To describe in SFF, first edit an SFF-DVD element in SFF.XML, convert it, and 

execute the operations of MakeParam and later.

2.5.1 Set the Cutting Position

Select Setting – Cutting Position in the Menu to display the following 

dialog.  Single Disc is set as a default.

In order to generate Dual Disc, select Disc Type to be generated, and press 

the Browse button to specify the file to be cut.  Enter the cutting position 

in the specified file (i.e. the sector No.), then press the OK button to close 

the dialog. 

Execute Layout, set Dual Disc setting with the disc image output tool 

(OutputDiscImage), then output to DLT to generate DLT for Dual Disc. 

Refer to "A method of various settings – A method of generating Dual Disc" 

in the "Disc Image Output Tool Reference Manual" for the settings with the 

disc image output tool.

SPECIFY IN SFF

You can also specify a dual-layer disc by editing the SFF.XML file.

Describe the following attributes in SFF-DVD elements in SFF.XML to 

generate Dual Discs.
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 * DiscType attribute

 * CutTrack attribute

DiscType attribute: Describe "Single", "Parallel", or "Opposite".

CutTrack attribute: Describe the name of an XML file for the first track in 

the second layer.

    In the case of Single, it is not necessary to specify the CutTrack attribute.

e.g.) 

<?xml version = "1.0"?>

<SFF-DVD …DiscType="Opposite" CutTrack="AUDIO 12_Track.XML">

…

</SFF-DVD>

Describe the attributes, execute Convert, and then execute the operations 

of MakeParam and later.  The backend tool calculates Cutting Position and 

generates a disc image.

* If the DiscType attribute is described in SFF.XML, CuttingPosition setting 

described in Section 2.5.1. cannot be executed.

Creat ing Hybrid  Discs

2.6  Set Layout Option (Hybrid Disc ROM image and MAC Information 

directories) 
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Select Setting-Layout Option in the Menu to display the following dialog.  

No ROM image and MAC Information directories are set in the default 

setting. 

In order to generate Hybrid Disc, press the Browse button to specify the 

ROM image directory.  Select Layout Order, and press the OK button to 

close the dialog.

If the ROM image contains a file for MAC, extract MAC file information 

beforehand and specify a directory where such information is located in 

the MAC Information directory. 

Layout Order settings are as follows: 

  Audio Files first: ROM files are created subsequent to Audio files on a Disc. 

  ROM Files first: ROM files are created first on a Disc. 

Execute Layout to create Disc Image of Hybrid. 

Truncat ing Audio
You can truncate audio for disc images to facilitate testing navigation 

information. 

Audio Truncate Mode is mainly used to create disc images for Navigation 

information check.  In Audio Truncate Mode, Audio data and the duration of 

ASV that is played in sync with the Audio data are truncated at a specified 

ratio to create disc images of smaller size for testing.

The following will be enabled by this mode.
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o    Navigation of a dual layer disc can be written in DVD-R for a check.

o    Turnaround to check and modify Navigation (re-create disc images) can 

be shortened.

Silent Cells in Audio Zone and Video Zone are not changed in this mode.

To trunate audio for a DVD-Audio disc:

1 Choose Settings > Audio Truncate Mode.

2 Specify the Truncate Ratio. The ratio can be set between 1/2 – 1/10,

3 For example, if 1/2 is specified, the first half of Audio data (excluding 

Silent Cell) is used and the duration of TRK and Cell is reduced by half.  

In addition, the duration of ASV that is played in sync with the Audio 

data is shortened by half.  (See the figure below.)

Audio Truncate Mode offers two options: truncating the entire Audio data, 

or truncating only Audio data that is longer than a specified length.  

Therefore, a setting in which a very short dummy track of one second, for 

example, is not truncated can be made.

2.7.3 Notes



Operation Parameters 233
The directions below for the use of Audio Truncate Mode should be 

followed.

• Audio Truncate ratio is fixed in a disc.  A user is not allowed to change 
Truncate ratio for each Track. (The ratio can be set not to truncate Audio 
data shorter than a specified length at the user’s Option.)

• Audio Truncate Mode does not affect Silent Cells.  (They are not 
truncated.)

• The duration of ASV is also truncated at the ratio specified for Truncate 
ratio.

• The settings of Audio Truncate Mode are not saved.  Every time Truncate 
Mode is used, settings from the Menu of Converter are required.

• If Audio Truncate Mode is set, it is necessary to execute MakeParam and 
EncodeAOB on Converter again.

• If the aob_continuous flag is used, a warning message 
"aob_continuous="yes", but they are discontinuous." may appear at re-
conversion after Truncate Mode settings.

Operat ion Parameters

File Conversion  Writes the parameter file required for 

A parameter file required for Sysenc ASV/ AOB/ VOB and a file with 

navigation information after conversion are output.  The navigation 

information file becomes an input file to the Formatter.

Make Param execution may affect all the other operations (Sysenc ***, 

Format, and Layout).  Therefore, if you check Make Param, all the other 

operations in the field are checked.

Generate ASV System Stream  Still pictures and highlight information 

which become ASV are encoded, and a system stream for each ASVU is 

generated.  System streams become input files to the Formatter. 
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Sysenc ASV execution affects Format and Layout.  Therefore, if you check 

Sysenc ASV, the Format and Layout operations are also checked.

Generate AOB System Stream  A sound file (RAW data) that becomes AOB is 

encoded, and a system stream for each AOB is generated. System streams 

become input files to the Formatter.

Sysenc AOB execution affects Format and Layout.  Therefore, if you check 

Sysenc AOB, the Format and Layout operations are also checked.

Generate VOB System Stream  Still pictures and highlight information that 

become AMGM_VOB are encoded, and a system stream for each 

AMGM_PGC is generated.  System streams become input files to the 

Formatter.

Sysenc VOB execution affects Format and Layout.  Therefore, if you check 

Sysenc VOB, the Format and Layout operations are also checked.

Generate IFO and NV Data  This operation reads navigation information and 

combines system streams to generate address information and disc images. 

Format execution affects Layout.  Therefore, if you check Format, the 

Layout operation is also checked.

Layout UDF Structure  This operation determines a location of the file on 

the disc and creates a layout information file.



10 Imager
This Chapter Under Construction

Imager gathers and writes the disc image files (from Format) to a directory 

structure that will be printed to the final DVD-audio disc. Imager can write 

to Digital Linear Tape (DTL), which is used by disc replication plants, or to 

a SCSI hard drive, which can be used as a source for writing DVD-Rs.

Workflow for disc imaging with Imager

Disc Image 
from Format

Digital 
Linear Tape

SCSI
Hard Drive

DVD-R

Disc 
Replication

Imager or
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Writ ing a  Disc Image

To write a disc image with Imager:

1 From the Windows Start menu, choose Programs > DVD-Audio 

Creator > Imager. The Imager window opens.

2 Specify the Builds Directory. Click Browse and select the folder 

containing the image files for the project.

3 If creating a hybrid disc with PC ROM data, specify the ROM Data 

Directory. Click Browse and select the folder containing these files.

4 Set the Destination type for the disc image by selecting one of the 

following options:

Layoutlayer 0 to DLT  Outputs the disc image to Digital Linear Tape (DLT). 

Select this option if outputing to a single-layer disc, or if outputing to the 

first layer of a dual-layer disc.

Layoutlayer 0 to HDD  Outputs the disc image to Digital Linear Tape (DLT). 

Select this option when outputing to the second layer of a dual-layer disc.
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Layoutlayer 0 to HDD  Outputs the disc image to a SCSI hard drive, where it 

can then be transferred to a DVD-R. The hard drive must be local (not on a 

network). Using this option will overwrite the drive’s entire contents; it is 

not possible to write only to a specific partition for the drive.

5 If outputting to DLT, select the tape output format (DDP 2.0 or 

DDV 1.11). Check with your disc replicator to see which format is 

required.

[Need to say if this has anything to do with CCPM.]

6 If outputing to a hard drive, select one of the following options for 

Copy Control Information (CCI):

• Select No Change if you want the CCI to be the same as in the disc 
image generated by Format.

• Select Reset if you want the CCI to be reset.

7 Specify the SCSI Setting by doing one of the following:

• Click List. The Select HDD/DLT dialog opens, displaying a list of devices 
of the Destination type previously specified. Select the destination 
device for the disc image, then click OK. The Host Adapter ID and SCSI 
ID appear in the Imager window.

• The desiination device may not appear in the Select HDD/DLT dialof if 
contains any existing data, or if your computer has a special device 
structure. In these instances, you can enter the Host Adapter ID and 
SCSI ID directly in the fields. 
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Note: Before proceeding, make sure you have entered the correct Host 

Adapter and SCSI IDs. 

8 If desired, enter an Album ID. 

[Probably need a little more info about what this is ued for.]

9 Click Execute. A Progress dialog appears as Imager begins writing the 

disc image to the destination drive or DLT. You are prompted once the 

disc image is successfully written.

10 Click Exit to close Imager.

Finally, set a drive to receive the output.  Here, set SCSI ID/Host Adapter ID 

of DLT/HDD to receive the output.  Press on List button in lower right of 

the screen to display a list of DLT drive/HDD connected to PC.  Which list 

is displayed depends on setting in Destination item, which is explained in 

2.2.  If either of ÅuOutput Layer 0 to DLTÅv or ÅuOutput Layer 1 to DLTÅv 

is selected, only DLT drive is displayed.  If ÅuOutput Layer 0 to HDDÅvis 

selected, only HDD is displayed.  Note that any drive which is determined 

to contain some data such as system drive is excluded from the list when 

displaying HDD.  

Following is an example of displaying a list of drives.  In this example, a 

drive called ÅuSEAGATE ST34555NÅvwhich is connected to Host Adapter 

ID 0 / SCSI ID 3 is displayed. 

After selecting a drive to receive the output here, press on OK button in 

the bottom of the screen to set a drive.  SCSI ID/Host Adapter is 

automatically set in main window for the tool.  Following is an example of 

displaying SCSI Setting item. 
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There may be some cases where a drive to receive the output is not 

displayed in a list of drives explained in basic use instructions.  This may 

happen when some data are already written in this drive or when PC has a 

special device structure.  In such case, it is possible to set ÅuHost Adapter 

IDÅvand ÅuSCSI host IDÅvdirectly.  Input a value directly in SCSI item.  

Note that data on HDD may be destroyed at worst if value is set improperly.  

Set a value with extra special care. 

Imaging for  Dual  Discs

DVD Specifications are capable of creating not only 4.7GB / 1 layer disc but 

also 8.5GB / 2 layers disc.  This tool can create such Dual-layers disc.  It is 

necessary to have 2 DLT tapes for 2 layers disc.  One is for the first layer 

and the other is for the second layer.  (Since DVD-R media cannot record 2 

layers disc, this tool does not provide 2 layers disc recording function for 

Raw HDD.) 

Instructions to output 2 layers disc is to output the first layer to DLT tape 

pursuant to basic use instructions, then to output the second layer to DLT 

tape.  Select ÅuOutput Layer 1 to DLTÅvin Destination item to output the 

second layer to DLT tape.  

Note that it is necessary to specify threshold between 2 layers in order to 

create 2 layers disc image.  See manual indicating disc image creation for 

details, which is provided separately.  

To write a dual-layer disc image with Imager:

1 Open Imager 
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11 Editing XML Files
The Graphical User Interface (GUI) of DVD-Audio Creator provides a 

convenient interface for accomplishing the vast majority of tasks required 

to create a DVD-Audio album from a set of prepared assets. However, in 

certain instances, the XML files generated by DVD-Audio Creator 

applications must be manually edited to achieve the desired result. These 

instances include:

• Creating a dual-stream Audio Track (PGC Block) with a multichannel and 
a stereo mix of the same music 

• Adding a Silent Cell (an interval before the start of a Track during which 
the player’s display counts down to zero)

• Defining Indexes and Spotlights in an Audio Track

The editing required in the above situations is covered below.

Using Two Streams in  an Audio  Track

The DVD-Audio specification allows each Track in an AOTT Audio Title to 

include up to two audio streams, selectable by the user at playback. The 

specification refers to this as a "PGC Block."
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Every Audio Track that is present in a multichannel channel assignment is 

also required to be available for playback on systems that support only two-

channel playback. There are two ways to accomplish this:

SMART downmix  The ability to downmix multichannel Audio Tracks to 

stereo outputs is a mandated feature of every DVD-Audio player. The way a 

Track’s channels are downmixed is predefined in premastering or authoring 

by setting SMART downmix parameters (level and phase).

Separate stereo mix  A separate two-channel version of a multichannel 

selection is included on the album. This approach allows greater control 

over the stereo mix, but it takes up more of the disc’s available storage 

capacity (shortening the total time of the program that can fit on the disc). 

If separate stereo mixes are used, the stereo and multichannel mixes of a 

given audio program may be organized into two separate Groups. 

Alternatively, the two mixes may be made available as two streams within 

the same Audio Track. (This approach reduces the risk of the listener 

inadvertently playing the wrong mix.)

PLAYBACK OF DUAL-STREAM TRACKS

When a player is first installed, the end-user typically sets the player to 

either multichannel or stereo playback mode depending on the speaker 

setup in the listening room. This means that when an Audio Track includes 

both multichannel and stereo streams, the player will automatically play the 

correct mix for the listening environment. 

During playback, if the player is set to Multichannel mode, the user may 

manually switch which mix is playing by pressing the AUDIO key on the 

remote control. When switching to the other audio stream, audio playback 

is interrupted and playback starts again from the beginning of the track. In 

other words, "seamless" switching between audio streams — which is 

supported for Video Tracks — is not possible with Audio Tracks.
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If the player is set to Stereo mode, the user cannot use the remote control 

to manually switch which mix is playing. Only the stereo stream (or a 

multichannel stream with downmix parameters) will be available for 

playback.

REQUIREMENTS FOR STREAMS IN DUAL-STREAM TRACKS

As a precondition to using two streams in an Audio Track, the DVD-Audio 

specification requires that the streams meet the following conditions:

• The two streams must be of identical duration

• The Track start times (if any) defined for the streams in the Track Editor 
dialog in Import Audio (see Chapter 4) must be identical

Preparing streams for dual-stream Audio Tracks

For the most part, the workflow for each stream in a dual-stream Audio 

Track is the same as if the streams were intended for use in a single-stream 

Track. 

To prepare streams for dual-stream Audio Tracks: 

1 Import the source files with Import Audio.

• For every Audio Track with two streams, import the source files for both 
streams into the project with Import Audio. 

• You do not need to set downmix parameters in Import Audio’s Down 
Mix level dialog.
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2 Define the Audio Tracks in Author.

• In Author, create the structure of the DVD-Audio album. The structure is 
the same whether or not the album includes any dual-stream Audio 
Tracks (do not use two Audio Track icons for a Track that will be 
assigned two audio streams).

• For each Audio Track, use the Audio tab of the Audio Track Properties 
window to specify the XML file corresponding to the source file 
imported for that Track. (The XML files are located in the AUDIO folder 
within your PROJECT folder.) 

• For each dual-stream Audio Track, specify the XML file corresponding to 
the multichannel file for the Track. (The stereo stream is added later, as 
described below.)

• After saving the project, publish it and then quit Author.

Adding a second stream to an Audio Track

To allow the Format application to recognize a second audio stream in a 

dual-stream Audio Track, a reference to the second stream is added 

manually to the XML file created by Author that describes each Track.

To add a reference for a second audio stream:

1 In the PUBLISH folder within your PROJECT folder you will find a set of 

files, created by Author, named "trackname_Track.XML." 

2 In a text editing program, open the XML file corresponding to the Track 

that is to include a second stream. The file will appear as follows:

<?xml version="1.0"?>
<TRACK-DOC  name=".........>
.......
<AUDIO–PTR file="multichannel-filename.XML" />
</TRACK >

</TRACK-DOC >
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3 Select the line starting with "AUDIO _PTR file=..."

4 Copy the line and paste it immediately below the line that you copied, 

creating two "AUDIO _PTR file=..." lines.

5 In the second "AUDIO _PTR file=..." line, replace the filename of the 

XML file for the multichannel stream with the filename of the XML file 

for the stereo stream of the same program. 

6 The edited "trackname_Track.XML." file for the Track will now appear as 

follows:

<?xml version="1.0"?>
<TRACK-DOC  name=".........>
.......
<AUDIO–PTR file="multichannel-filename.XML" />
<AUDIO–PTR file="stereo-filename.XML" />
</TRACK >

</TRACK-DOC >

7 Save the changes and close the file. 

For each dual-stream Audio Track, repeat the steps above. When the project 

(SFF file) is opened in Command Editor, both audio streams in each dual-

stream Track will be shown in the project structure.

As explained above, once the end-user has set a player to match the 

channel configuration of the playback system, the correct stream will play 

back automatically, and the AUDIO button on the remote control may be 

used to switch between mixes (if the player is in Multichannel mode). To 

add on-screen buttons for selecting the desired audio mix, use the Set 

Stream commands within the Set System command-set in Command Editor 

(see Chapter 8).

Adding a  Si lent  Cel l

In DVD-Audio, a Silent Cell is a short period of time before the start of a 

Track during which the time display on the player counts down to zero 

(the equivalent of an Index 0 or Pause on a CD-Audio). 
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Adding a Silent Cell to the start of a Track only affects the display of time on 

the player. A Silent Cell has no effect on the duration of the silence (if any) 

between Tracks. 

Setting the Silent Cell Parameter

A Silent Cell is added to a given Audio Track by editing an XML file that is 

created when the source file for that Track is imported into the project 

with Import Audio.

To add a Silent Cell before an Audio Track:

1 Import the source audio files for your project with Import Audio.

2 After import, you will find in the AUDIO folder within your PROJECT 

folder a set of XML files created by Import Audio. For each imported 

track there will be a file named "trackname.XML." 

3 In a text editing program, open the "trackname.XML" file corresponding 

to the Track that is to include a Silent Cell. The file will appear as 

follows:

<AUDIO-DOC name="...
<DVDAUDIO id="... silent="0"></DVDAUDIO>

</AUDIO-DOC >

4 In the "silent=" parameter (last parameter in the DVDAUDIO tag), 

replace the value "0" by the desired duration (in milliseconds) of the 

silent cell. The value must be 500 or higher (the DVD-Audio 

specification does not allow Silent Cells of less than a half-second). The 

following example shows a "trackname.XML" file with a Silent Cell set to 

a duration of three seconds:

<AUDIO-DOC name="....
<DVDAUDIO id=".........silent="3000"></DVDAUDIO>

</AUDIO-DOC >

5 Save the changes and close the file. 
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Repeat the steps above for each Track in which you wish to use a Silent 

Cell. When DVD-Audio Creator’s Format application reads the edited files, it 

will generate Silent Cells for each of these Tracks.

Defining Indexes and Spot l ights

Indexes and Spotlights are both features of the DVD-Audio specification 

that relate to subdivisions of Tracks:

Index  A subdivision of an Audio Track, allowing direct access to a specific 

location within the Track (equivalent to an Index in the CD-Audio 

specification or a Cell in the DVD-Video specification).

Spotlight  A special designation that may be applied to some Indexes in an 

album. If the end-user places the player into Spotlight mode, the player will 

play only those Indexes that have been flagged as Spotlights. The Spotlight 

feature allows the producer of a DVD-Audio to select as Spotlights the most 

representative or attractive moments of program, thereby preparing in 

advance a kind of demonstration mode for the album. Multiple Spotlight 

Indexes may be defined within a single Track.

So far, there are no players on the market that support display of or 

navigation to Indexes, nor are there players supporting the Spotlight 

function. However, because these features may be supported in the future, 

DVD-Audio Creator allows you the option of incorporating them into your 

albums.

THE DVDCELL TAG

Indexes and Spotlights are added to a given Audio Track by editing an XML 

file that is created when the source file for that Track is imported into the 

project with Import Audio. The editing consists of inserting a DVDCELL tag 

into the file.
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A DVDCELL tag starts with the line "<DVDCELLLIST>" and ends with the 

line "</DVDCELLLIST>." In between is a list made up of one or more 

DVDCELL statements. Each statement corresponds with an Index, and 

defines the following parameters:

Start  The time at which the Index begins, expressed in milliseconds from 

the start of the Track

Stop  The time at which the Index ends, expressed in milliseconds from the 

start of the Track

Index  The number of the Index in the current Track (sequentially 

upcounting from 1)

Spotlight  Sets the Spotlight status of the Index (yes or no)

To add an Index or Spotlight:

1 Import the source audio files for your project with Import Audio.

2 After import, you will find in the AUDIO folder within your PROJECT 

folder a set of XML files created by Import Audio. For each imported 

track there will be a file named "trackname.XML." 

3 In a text editing program, open the "trackname.XML" file corresponding 

to the Track that is to include an Index or Spotlight. The file will appear 

as follows:

<AUDIO-DOC name="....
<DVDAUDIO id=".........silent="0"></DVDAUDIO>

</AUDIO-DOC >

4 Between "silent="0">" and "</DVDAUDIO>," insert a DVDCELL tag. The 

following example shows an edited file with a tag defining three 

Indexes, with Index 2 defined as a Spotlight:

<AUDIO-DOC name="....
<DVDAUDIO id=".........silent="0">

<DVDCELLLIST>
<DVDCELL start= "0" stop="30000" index="1" spotlight="no"  />
<DVDCELL start= "30000" stop="50000" index="2" spotlight="yes"  />



Defining Indexes and Spotlights 249
<DVDCELL start= "50000" stop="70000" index="3" spotlight="no"  />
</DVDCELLLIST>

</DVDAUDIO>
</AUDIO-DOC >

5 Save the changes and close the file. 

Repeat the steps above for all Tracks to which you wish to add Indexes and 

Spotlights. When DVD-Audio Creator’s Format application reads the files, it 

will generate Indexes and Spotlights for each of these Tracks.



250 Chapter 11, Editing XML Files



A DVD-Audio Format
Like DVD-Video, the DVD-Audio format is built on the foundation of DVD-

ROM. So a DVD-Audio disc is actually a DVD-ROM disc that includes a zone 

of material supported by the DVD-Audio specification (and may optionally 

contain a zone of DVD-Video material as well). These zones are essentially 

directories or folders within the UDF file system.

The DVD-Audio specification incorporates many of the navigational and 

architectural features of DVD-Video, but it also includes several new 

interactive and playback features. It also supports higher audio fidelity and 

more flexible multichannel playback options. Thus, while the two formats 

are closely related, DVD-Audio is a truly distinct product tailored for audio-

centric applications. 

For those intending to create DVD-Audio albums with DVD-Audio Creator, 

this chapter outlines important information that can help you get the most 

out of the format. It also clarifies the functional and technical similarities 

and differences between DVD-Audio and it’s DVD-Video cousin.

DVD-Audio Players

The specifications for DVD-Audio were developed by Working Group 4 

(WG-4) of the DVD Forum, a consortium representing companies involved 

in consumer electronics, computing, and entertainment. To ensure DVD-
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Audio’s flexibility across a wide range of applications, WG-4 decided not to 

attempt to define one single set of features that would be mandated for all 

DVD-Audio players. Instead, a DVD-Audio disc may contain a variety of 

different content types, each of which will play back on one or more of 

several different player types designed for different playback settings.

While this approach sounds complicated, much of the distinction between 

the different envisioned playback settings boils down to the question of 

whether or not video display is available. With an audio format, it is crucial 

to support playback without a video display, particularly in such situations 

as a "Walkman" style portable, a "boom box," or a car. Even for home 

listening, requiring video support in all players would increase 

manufacturing costs, making it harder to reach the less-expensive end of 

the audio player market.

Though the need for audio-only playback was clear, DVD-Audio’s 

developers also needed to support all the visual extras that consumers 

would expect from a next-generation entertainment format: graphics, text 

and motion video. To cover all bases, WG-4 envisioned that five roughly-

defined player types might possibly be used to play back content from a 

disc in DVD-Audio format. These include:

Audio-only player types (AOPs):

• A "simple" Audio-only player has no video output, and navigates the disc 
linearly using a list of tracks that is analogous to the Table of Contents 
(TOC) on a CD

• A "smart" Audio-only player (still no video output) gives the user more 
choice of how to navigate the material on the disc, and may include an 
LCD display to show song titles and other text information such as lyrics
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Video-capable player types (VCAPs):

• An "Audio-with-Video" player supports navigational choice and includes 
video outputs to support multimedia, including visual menus, album 
artwork, "slide show" graphics and motion video (such as music videos)

• A "Universal" player offers the same audio and multimedia support as 
the Audio-with-Video DVD-Audio player, but also plays DVD-Video discs

• A DVD-Video player may be used to play optional video content that has 
been included on a DVD-Audio disc (though the DVD-Audio content on 
a DVD-Audio disc will not play on a DVD-Video player).

While the different player types above may be inferred from the DVD-Audio 

specification, it is considered unlikely that all of them will actually reach 

the market. In particular, it is unclear what demand there might be for the 

Audio-with-Video player that is not a Universal player. Similarly, many 

observers believe that there will be little justification for a distinct Video-

only player once the Universal player is widely available at a competitive 

price point. Eventually, then, new consumer DVD players may well be sold 

in just two main categories: Audio-only and Universal.

DVD-Audio disc and player types

DVD-Audio Player

Universal Player

DVD-Video Player

DVD-Audio Disc 
(Audio Only)

DVD-Audio Disc 
(Audio+Video)

DVD-Video Disc

Full Playback

DVD-Video Content Only

DVD-Audio Content Only
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One way to easily visualize the difference between the two main categories 

of DVD-Audio players (Audio-only and Universal) is to compare the 

prototypical remote control implied for each type in the specification. The 

Universal player’s remote control looks very much like that of a DVD-Video 

player:

In contrast, the minimal set of functions required to control the Audio-only 

player makes for a very simple remote indeed:

Figure 1: Remote control for a Universal DVD player

Figure 2: Remote control for an audio-only DVD-Audio player
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DVD-Audio Content

While the availability of different player types allows DVD-Audio discs to be 

played in a variety of settings, it also means that it is possible for a DVD-

Audio disc to include some types of content that will not be available for 

playback in some situations. By choosing which types of content are put on 

a given DVD-Audio title, it is the producer who decides what the end-user’s 

experience will be in various playback settings:

Linear audio-only discs  The base-case DVD-Audio disc is one that contains 

no graphics, text or motion video information. This "Pure Audio" disc 

supports higher fidelity, greater capacity and more channels than a CD, but 

it functions in much the same way, with similar track-based navigation. 

Pure Audio discs play on both Audio-only and Universal DVD-Audio players, 

but they do not play on DVD-Video players.

Navigable audio-only discs  Somewhat more sophisticated DVD-Audio titles 

may be created by using the format’s logical structure to offer listeners 

different navigational options, such as multiple paths (playlists or "Groups") 

through the audio material. These discs will still play on the simple Audio-

only players, but their more sophisticated features will come to life when 

they are played on smart Audio-only players, or on video-enabled players 

such as Universal players. They do not play on DVD-Video players.

Multimedia discs  More complex DVD-Audio titles will take greater 

advantage of the format’s multimedia capabilities, using visual menus for 

navigation, slideshows with audio, and motion video. Once again, these 

titles will play audio on Audio-only players, but without all the extras that 

will be viewable on video-capable players such as Universal players. If such 

a disc includes motion video content, that content (only) will be playable 

on DVD-Video players.
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The following table provides an overview of some common combinations 

of disc contents and player types:

Audio Formats

The core content type of the DVD-Audio format is, obviously, audio. 

While the DVD-Video specification gives equal weight to both linear PCM 

(pulse code modulation) and compressed audio formats such as Dolby 

Digital (AC-3), the DVD-Audio specification puts the priority on delivering 

the highest possible audio fidelity, and thus focuses primarily on PCM. 

PCM data may be stored in either of two forms: linear (LPCM) or "packed" 

using Meridian Lossless Packing (MLP). All players are required to support 

both LPCM and MLP audio in either stereo or multi-channel configurations. 

Players with video outs must also support Dolby Digital. Optional audio 

formats such as DTS or others not yet defined may be supported at the 

manufacturer’s discretion.

Table 3: 

Player Type Disc Contents

DVD-Audio disc 
without video

DVD-Audio disc 
with video

DVD-Video disc

Audio-only 
DVD-Audio 
Player

• Audio
• Text 

information

Audio elements of 
DVD-Audio and 
DVD-Video titles

Not playable

Universal 
DVD-Audio 
Player

• Audio
• Still pictures
• Text 

information

• Visual menus
• All audio, text, 

graphic and 
video content

All DVD-Video 
content supported

DVD-Video 
Player

Not playable Video content only All DVD-Video 
content supported
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DVD-Audio content may offer up to two audio streams in any given 

program. The first stream is required to be PCM (stereo or multi-channel), 

the optional second stream may be an optional audio type. 

AUDIO RESOLUTION

Within the PCM approach (LPCM or MLP), DVD-Audio offers content 

developers a wide array of choices regarding resolution. In PCM, the 

resolution of a given audio stream depends on two factors: the word-length 

and the sample-rate. The sample-rate is the number of times per second that 

the amplitude of the source analog waveform is sampled for conversion 

into a digitally stored value. The word-length is the number of bits available 

to store the value of each sample.
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DVD-Audio’s PCM support covers two "families" of sample-rates. One family 

is based on the 44.1 kHz rate of the audio CD, and also includes the 

multiples 88.2 and 176.4 kHz. The other family starts with the 48 kHz rate 

commonly used in video formats, and adds 96 and 192 kHz.

When digitizing an analog waveform, the resolution (fidelity to the input 
signal) may be improved by increasing the sample-rate (number of 
samples per unit of time), the word-length (number of bits per sample), 
or both
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DVD-Audio also includes support for several word-lengths, including not 

only the 16-bit samples used in CD-Audio, but also 20- and 24-bit samples as 

well. A longer word-length translates into finer resolution and a wider 

dynamic range.

MULTI-CHANNEL SOUND

Of all of DVD-Audio’s features, one of the most appealing to consumers is 

the format’s ability to deliver multi-channel sound. In each sample-rate 

family, the highest sample-rate (176.4 or 192.0 kHz) is supported only for 

mono or two-channel playback. The rest of the rates (44.1, 48, 88.2, and 96 

kHz) are supported for mono up through six channels. 

DVD-Audio’s maximum data-rate allocable to audio—9.6 Megabits per 

second—places limits on the total data bandwidth available to spread 

among the channels. Six channels of 20-bit audio at either 88.2 or 96 kHz, 

for instance, would substantially exceed the format’s data-rate. The 

specification offers two complementary strategies for dealing with this 

limitation. One is MLP (explained below), the other is mixed resolutions.

Mixed resolutions allow the producer to prioritize the allocation of bits 

among the channels in a given audio track. Each channel is assigned to one 

of two "Channel Groups," with the resolution of Group 1 always equal to or 

greater than that of Group 2. Within a given track, the sample-rates used for 

all the channels in both groups must be from the same family.

Table 4: Sample-rate families for DVD-Audio

44.1 kHz Family 48 kHz Family

Sample Rate (kHz) 44.1 88.2 176.4 48 96 192

Maximum Channels 6 6 2 6 6 2
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Note: When the sample rate is 192 kHz or 176.4 kHz, the number of 

channels must be two or less (two-channel stereo or mono).

Assignment of channels to groups, and selection of attributes within each 

group, may be changed on a track-by-track basis. To regularize the use of 

mixed resolutions among channels, most—but not all—of the reasonably 

foreseeable possibilities for varying the resolution of up to six channels are 

defined in the format’s 21 supported channel configurations. 

Table 5: Supported sample-rate and word-length combinations for DVD-Audio’s two 
channel groups

If Channel Group 1 is: ... then Group Channel 2 may be:

Sample rate 48 kHz 48 kHz

96 kHz 96 or 48 kHz

192 kHz —

44.1 kHz 44.1 kHz

88.2 kHz 88.2 or 44.1 kHz

176.4 kHz —

Word length 16 bits 16 bits

20 bits 20 or 16 bits

24 bits 24, 20 or 16 bits
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To illustrate the range of channel groupings permitted by the specification, 

here are a couple of examples shown with possible attribute assignments: 

[IMAGE = BOOK Figure 5-5: Examples of supported channel assignments. 

Assignment 8 uses three channels, with priority to left and right. 

Assignment 21 uses six channels, with priority to the four corners (left and 

right front, left and right surround).]

PLAYING TIME AND MERIDIAN LOSSLESS PACKING

Because DVD-Audio supports so many different variations of sample-rates, 

word-lengths and channel configurations, the capacity in minutes of the 

format may vary widely. The ability to vary these attributes on a track-by-

Figure 3: Supported channel assignments for two DVD-Audio’s two 
channel groups
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track basis simply adds to the complexity of stating the maximum playing 

time. But it is clear that the use of more channels, more samples, or more 

bits per sample will all result in shorter playback capacity.

Note: Single-layer, single-sided disc with no lossless compression; assumes 

5% overhead for navigation and formatting data.

As shown in the table above, at the same resolution as CD-Audio (stereo 16-

bit/44.1 kHz), DVD-Audio is capable of far greater playing time than CD-

Audio’s 74 minutes. But even with DVD-Audio’s greater data rate and data 

capacity, full support for high-fidelity surround sound (six channels of 24-

bit/96 kHz audio, for instance) would exceed the format’s maximum bit-

rate and quickly use up the available storage. 

To address this issue, WG-4 adopted the Meridian Lossless Packing (MLP) 

compression system developed by Meridian Audio. Because it is a 

completely lossless system, a decoded MLP datastream is bit-for-bit identical 

to the pre-encoded PCM source stream. 

MLP permits substantial reduction in the bandwidth required to store high-

quality multi-channel PCM audio. The efficiency of the algorithm varies 

with the program content, particularly for material at sample-rates of 44.1 

or 48 kHz. For higher sample-rates (88.2, 96, 176.4 and 192 kHz), however, 

MLP has been demonstrated to reliably achieve a 45% reduction in 

bandwidth requirements. This allows a DVD-5 disc to be used for 

Table 6: Playing times for DVD-Audio variations

Quantization 

(bits)

Sample Rate 

(kHz)

Channels Data Rate 

(mbps)

Time 

(minutes)

16 44.1 2 1.41 422

16 48 2 1.54 388

20 96 4 7.68 78

24 192 2 9.22 65



DVD-Audio Content 263
presentation of up to 74 minutes of program using six channels of 24-bit/96 

kHz audio. DVD-Audio discs are not required to use MLP, but decoding 

capability for MLP is mandated for all DVD-Audio players. 

SMART CONTENT AND DOWNMIXING

One of the problems confronted by WG-4 in defining DVD-Audio stems 

from the fact that, aside from home theater systems, most playback 

situations (stereo receivers, headphones, and boom-boxes, for instance) are 

currently configured for stereo. To ensure that a DVD-Audio disc will always 

play, regardless of the available monitoring configuration, WG-4 had to 

define how a player should present multi-channel programs in situations 

where only stereo playback is available. The difficulty is that a program 

mixed for surround presentation will not sound correctly balanced if the 

player simply ignores all channels other than front left and right.

DVD-Audio will allow both stereo and multichannel mixes of the same 

music to be delivered on one disc. So one solution would have been to 

require that every disc that includes a multi-channel program must also 

include a two-channel version of the same program. But that would have 

imposed significant limitations on the playing time of discs with multi-

channel programs. 

Instead, WG-4 mandated that players support an approach championed by 

Warner Bros. Records called "SMART Content" (System Managed Audio 

Resource Technique). SMART allows the producer to determine in advance 

a set of downmix parameters ("coefficients") defining the relative level, 

panning and phase that will be applied to each channel of a multichannel 

mix if it is combined into stereo. A SMART "downmix" will only be played 

if a discrete 2-channel mix of a given program has not been included on the 

disc.

SMART coefficients are specified as 8-bit numbers in a six-by-two matrix, 

along with a phase bit for each channel. A set of 16 tables of these 

coefficients may be defined for each Audio Object Set (more on these later). 

The table for each individual track of a title may be selected from among 
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these 16. This allows producers a workable means to control the sound of 

their music in cases where their multichannel mix is downmixed by the 

player.

[IMAGE-BOOK: Table 5-7: Relying on the SMART Fold-Down feature to 

create a stereo downmix in two-channel playback situations allows a longer 

playing time compared to including a separate stereo mix.]

THE AUDIO OBJECT (AOB)

Like the other presentation data (pictures, video, and text) that may be 

included in a DVD-Audio album, the audio data is stored in files that are 

referenced in the disc’s logical data files (which determine the conditions 

under which the audio data files are actually played).

The basic unit of audio presentation data is the Audio Object (AOB), a file 

containing the audio data for one or more selections (songs or 

compositions). In each AOB, all audio attributes (resolution, channel 

configuration, etc.) must remain consistent throughout.

An AOB may also contain Real-Time Information (RTI) that may be used to 

display Real-Time Text if that feature is supported by the player. (See the 

section on Text Information below).

Value-Added Content

While audio playback is at the heart of DVD-Audio, the format is also 

intended to offer a workable platform for the kinds of value-added 

multimedia features that have proven difficult to deliver to the mass market 

on formats such as CD-ROM and Enhanced CD. These features include 

graphical accompaniment for the music, text information about the music 

and the artist, and motion video such as music videos or interviews.
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STILL PICTURES 

The DVD-Audio specification fully supports the display of still pictures 

during audio playback, and offers the producer a wide range of options as 

to when and how the pictures are shown. 

Still pictures in DVD-Audio are MPEG-2 encoded images. There are two 

basic categories of pictures:

Slide  Picture without buttons, made up of only an image layer. 

Menu  Picture with buttons (up to 36), made up of:

• A Background layer containing the visible background image

• A subpicture Overlay (SPU) layer of up to four colors for shapes 
(including text) that are displayed over the background image

• A Button Hotspots layer for highlight information (HLI), which defines 
the rectangular boundaries of each of the menu’s buttons. 

A still picture that is displayed during playback of an Audio Track is referred 

to as an ASV (Audio Still Video). While the data size of an individual ASV 

may vary greatly, typical ASVs may be expected to average about 100 KB.

[IMAGE-BOOK Figure 5-6: An ASV is composed of a main picture (MPEG 

still) plus optional subpicture overlay and highlights.]

ASVs are grouped into sets of graphics referred to as ASVUs (Audio Still 

Video Units), each of which may contain up to 99 ASVs (individual images). 

The audio selection(s) over which the ASVs from a given ASVU are intended 

to display is referred to as the ASVU range. An ASVU range may be either a 

single Track or a set of Tracks.

The total size of an ASVU may not exceed 2 Megabytes, which is the size of 

the buffer that player manufacturers are required to provide to allow ASVUs 

to be preloaded into player memory. This preloading process ensures that 

players will not interrupt audio playback in order to read graphical data 

from the disc. For instance, a listener can browse a series of still graphics 

without affecting the currently playing song.
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From an authoring point of view, it is crucial to realize that audio output is 

muted during preloading of ASVUs. Depending on player design, the 

duration of the muting between each ASVU range is at least a second, 

possibly more. This limitation means that the use of graphics must be 

carefully planned in situations such as live albums, where audio program 

may continue for long periods without the opportunity to load a new 

ASVU.

MODES, EFFECTS, AND HIGHLIGHTS

For each ASVU, the producer defines a playback mode that determines the 

order and duration of graphical display:

Slideshow ASVU  The display duration of all ASVs in the ASVU is 

predetermined during authoring and is not changeable by the end-user). 

There are three types of Slideshows:

• Sequential, ASVs displayed in a predetermined order.

• Random, ASVs displayed in an order generated at random by the player 
during playback.

• Shuffle, same as random, but no ASV is repeated until every ASV has 
been shown.
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Browsable ASVU  The display duration of the ASVs in the ASVU may be 

affected by end-user input from the remote control. There are four types of 

Browsable ASVUs:

• Timed sequential — ASVs displayed in a predetermined order. The 
display duration of each ASV is either fixed (predetermined) or 
randomly generated by the player from within a predetermined range. 
The end-user may override the duration and browse the ASVs by using 
the PAGE keys (PREV/NEXT) on the remote control.

• Timed random — ASVs displayed in an order generated at random by 
the player during playback. The display duration of each ASV is either 
fixed (predetermined) or randomly generated by the player from within 
a predetermined range. The end-user may override the duration and 
browse the ASVs by using the PAGE keys on the remote control.

• Timed shuffle — same as timed random, but no ASV is repeated until 
every ASV has been shown.

• Infinite sequential: ASVs displayed in a predetermined order. The display 
duration of all ASVs is predetermined as "infinite" (displayed until there 
is end-user input from the remote control). The end-user may override 
the duration and browse the ASVs by using the PAGE keys on the 
remote control. 

The DVD-Audio specification supports a variety of start and end effects 

(wipes and dissolves) as transitions between ASVs.

The specification also allows the highlights within a given ASV to change 

over time. This is useful for content such as song lists, lyrics or libretto. 

Links allowing listeners to navigate to different parts of a song by clicking 

on lyrics are an appealing feature of DVD-Audio titles. (In DVD-Audio 

Creator this is referred to as a "Linked Lyrics Menu.")

[IMAGE-BOOK-Figure 5-7: Changing highlights within an ASV can be used 

to indicate the current line or word of lyrics.]
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TEXT INFORMATION

The DVD-Audio specification provides for storage of text information on 

disc, though inclusion of text is not mandatory.

In the specification, text support is provided for multiple "language units," 

with up to eight languages available on any given disc. Two character types 

are supported. For languages such as English that use single-byte characters 

(ISO8859-1), text is structured for presentation as "pages" of four lines of 

up to 30 characters each. Japanese and other languages using double-byte 

characters (JIS Kanji) are organized into pages of two lines of up to 15 

characters each. 

The manner in which any given player uses this text information (if at all) 

is left to the discretion of the player manufacturer. A player with video 

output, for instance, may display the text on screen. But the size of the 

pages defined by the specification suggests that the primary application is 

envisioned as an LCD screen on "smart" Audio-only players, Audio-with-

Video players, and/or Universal players. 

The specification defines two distinct types of text:

Audio Text Data  Intended for display of static information that is not 

synchronized to the audio program. If Audio Text Data is used at all, it must 

include the Album title, "Group" name (more about Groups later) and Track 

name. It may also include optional information such as the name(s) of the 

artist and composer. Up to 64 KB of data may be included for each 

language unit.

Real Time Text  Stored on disc as part of the audio stream, allowing 

synchronization with audio playback. Ideal for lyrics and libretto, Real Time 

Text may also be used for context-dependent commentary such as running 

liner notes. 

Once again, the extent to which Real Time Text or Audio Text Data is 

supported by a given player is up to the hardware manufacturer. As of this 

writing, none of the players on the market support the format’s text display 

capabilities.
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VIDEO ON DVD-AUDIO

DVD-Audio’s support for motion video is substantially similar to that of 

DVD-Video, using Video Objects (VOBs) comprised of MPEG-2 video plus 

audio and optional subtitles. However, some advanced features that are 

supported in DVD-Video VOBs—such as parental control and complex 

interactivity—are not supported in all DVD-Audio settings. In order to fully 

understand these limitations, it is necessary to first understand the overall 

organization of the DVD-Audio format.

The Structure  of  DVD-Audio

As noted above, a DVD-Audio disc is a DVD-ROM disc that includes a 

special zone (the Audio_TS folder or directory) for DVD-Audio material. A 

DVD-Audio disc may also include a Video_TS folder for an optional DVD-

Video zone, as well as a DVD-Others zone for applications and data (e.g. a 

browser for Web connectivity) that may be accessed from a computer-

hosted DVD-ROM drive.

The overall volume structure of the DVD-Audio Disc requires the DVD-

Audio area to appear first, followed by the DVD-Video area and any other 

non-Audio/Video files and directories.

The final playback experience of a given DVD-Audio title involves two 

interrelated elements of DVD playback: the presentation data (audio, still 

pictures, text and motion video) and the logical data that determines the 

order and conditions of playback. Because DVD-Audio discs are intended 

for playback on a number of different player types, the way in which the 

information on disc is utilized and experienced also depends on the type of 

player.

Volume structure of a DVD-Audio disc

Volume and File 
Structure

DVD-Audio Zone DVD-Video Zone DVD other Zone

DVD Volume Space
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MULTIPLE CONTENT MANAGERS

In the world of DVD, the first place a player goes to find out what content 

is present on a given disc is a directory (table of contents) referred to as a 

"Manager." 

For playback in a DVD-Audio player, a disc is required to include in the 

Audio zone several different content directories, each used to 

accommodate a different playback situation (player). A DVD-Audio disc that 

includes an optional DVD-Video zone will also include a Manager in the 

DVD-Video zone (a Video Manager or VMG), but this directory is only used 

if the disc is played in a DVD-Video player.

The most basic form of Manager in DVD-Audio is the SAMG (Simple Audio 

Manager). Containing a list of up to 314 tracks, it serves the same function 

as the TOC (table of contents) on a CD-Audio disc. Simple Audio-only 

players look at SAMG to find the information they need for linear, track-

based navigation of the disc’s audio content. 

As mentioned earlier, "smart" Audio-only players, Audio-with-Video players 

and Universal players all support more sophisticated navigation than do 

simple Audio-only players. The directory information these players need is 

found in the Audio Manager Information (AMGI) section of the AMG (Audio 

Manager). 

The AMGI contains several subsections, two of which are tables of "Search 

Pointers" telling the player the location on disc of all the content that is 

playable by that type of player. Smart Audio-only players use the AMG 

Search Pointer table designated as AOTT_SRPT, while video-capable players 

use the table ATT_SRPT.

In addition to these Search Pointer tables, AMG contains the logical data 

and presentation data (audio, still pictures, overlays, video) for the Audio 

Manager Menu (AMGM), which is the visual menu that is the destination of 

the TOP MENU key on the player remote control. The data making up the 

AMGM is referred to as the "AMGM domain" (AMGM_DOM).
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LOGICAL STRUCTURE: ALBUMS, GROUPS AND TRACKS

Except for AMGM, all of a DVD-Audio’s aural and visual content makes up 

the "Title Group domain" (TT_GR_DOM). DVD-Audio players that read AMG 

(all except simple Audio-only players) are able to take advantage of DVD-

Audio’s capacity to organize this content hierarchically rather than simply 

linearly. This logical hierarchy is based on five different levels: Album, 

Group, Title, Track and Index. 

Each side of a DVD-Audio disc contains one Album. Each Album may 

contain up to nine Groups, each of which is essentially a playlist specifying 

the playback order of a number of Titles. While any Title may contain up to 

99 Tracks, there may be no more than 99 Tracks total within a single Group.

As on a CD, a Track may be thought of as an identifiable chunk of program 

(e.g. a song). A Track’s presentation data may be either audio or video. 

During playback, Audio Track attributes such as channel configuration, 

sample-rate, and word-length may be changed on Track boundaries (players 

may mute during such attribute changes). Audio Track playback may be 

accompanied by still pictures (ASVs in an ASVU).

An Index is a reference point to a portion of an Audio Track (a cell). There 

may be up to 99 Indexes within a single track.

While this hierarchy has many levels, in practice the end-user is never 

aware of the existence of Titles. On a smart Audio-only player, for instance, 

a user would normally be able to play any Track using the remote by simply 

entering a Group number and then the number of a Track within that 

Group.

Because a Group is simply a playlist, a given Track may be referenced by 

more than one Group. On an Album with twenty Audio Tracks, for instance, 

one Group might be a sequence of all the songs, another could be a 

"mellow" playlist of just acoustic numbers, and a third might be a "party" 

playlist of just dance tracks. Groups thus allow producers to create up to 

nine different listening experiences drawn from one underlying set of 

material. 
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[IMAGE-BOOK-Figure 5-10: A DVD-Audio album with three groups, one 

playing all tracks, a second playing just mellow tracks, and a third playing 

just party tracks. ]

NAVIGATION AND PROGRAM CHAINS

As noted above, DVD-Audio discs are required to include several different 

content directories to facilitate navigation. The various players that use 

these directories may be informally characterized as follows: 

Track 1

Track 2

Track 3

Track 4

Track 5

1 – Play All

2 – Mellow

3 – Party

Track 1
Track 2
Track 4

Track 3
Track 5

Track 1
Track 2
Track 3
Track 4
Track 5
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SAMG players  Simple Audio-only players that read SAMG and ignore AMG.

AOTT players  Smart Audio-only players, which read the AOTT_SRPT table in 

the AMG.

ATT players  Video-capable players (Audio-with-video and Universal players), 

which read the ATT_SRPT table in the AMG.

Navigationally, the difference between ATT players and AOTT players is that 

in ATT players the content may be navigated via visual menus like those 

used in DVD-Video. (AOTT machines can’t use visual menus because they 

have no video output.) In both cases, however, the underlying structure 

being navigated is the same:

• Aset of Groups is defined in the AMG’s Search Pointer table

• Each Group is a list of Titles, with a pointer to the location of each 
corresponding Title Set

• Each Title Set contains:

Audio Title Set Information (ATSI)  Logical data defining the manner in 

which the Title’s content will play back, and including references to the 

locations of the Title’s presentation data (audio, still pictures, and/or video)

Audio Object Set (AOBS)  A collection of Audio Object (AOB) files, which 

are the presentation data for the audio content of titles that do not contain 

motion video content (AOTT Titles). 

The ATSI includes a set of Program Chains (PGCs), which are instructions 

that tell the player what Programs or (PGs) to play and when to play them. 

The content unit played back for each Program is a Track.

The DVD-Audio specification includes a set of Navigation Commands for 

use in audio PGCs, as well as General and System parameters that are 

stored in player memory. As with DVD-Video, the commands are broken 

into various categories (Link, Jump, GoTo, SetSystem, Set and Compare). 

However, because Groups are intended to be DVD-Audio’s primary 

mechanism for defining a specific path through all the available content on 

the disc, the navigation commands supported in DVD-Audio are a subset of 
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the DVD-Video set. The availability of nine Groups allows navigation that is 

far more varied than that of CD-Audio, but the possibilities are more limited 

than in DVD-Video. 

Among the most important navigational constraints in DVD-Audio are those 

relating to movement within a Group. A user may enter a Group at any 

point by selecting a specific Track. But once playback has started within a 

given Group, that Group will continue playing in order through to the end, 

unless the user exits playback by using the TOPMENU, MENU, or GROUP 

button on the remote control. The specification makes no provision for 

linking directly from a given Group to content outside that Group. 

Using Video in  DVD-Audio
As explained earlier, DVD-Audio Groups are made up of Audio Titles that 

include one or more Tracks. If the Title is made up of Audio Tracks, the 

Title’s presentation data is drawn from an AOB and (optionally) an ASVU. In 

the specification, this kind of Audio Title is referred to as an "AOTT." 

At the same time, Groups may also contain Audio Titles whose presentation 

data is a Video Object (VOB) stored in a Video Title Set (VTS) in the disc’s 

DVD-Video zone. This kind of Audio Title is referred to as either an AVTT or 

an AVTT/AOTT, depending on whether the video soundtrack is enabled for 

playback on audio-only players (see below).

Whether a VTS is used in an AVTT Title or an AVTT/AOTT Title, the DVD-

Audio specification requires that it be playable in a DVD-Video player. 

Therefore each VTS on a DVD-Audio is actually referenced in two different 

managers on the disc: the AMG (Audio Manager) and the VMG (Video 

Manager).
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VIDEO SOUNDTRACKS IN DVD-AUDIO

Even though the VOBs used in DVD-Audio are also playable in a DVD-Video 

player, some VTS functionalities supported by the DVD-Video specification 

are not supported for a VTS used on a DVD-Audio disc. One such area 

where DVD-Video and DVD-Audio differ is the audio format requirements 

for video soundtracks. 

As noted earlier, the DVD-Audio specification requires that every Audio 

Track include at least one PCM stream (LPCM or MLP). This rule may or 

may not apply to the soundtracks of VOBs, depending on the player types 

for which the video’s soundtrack is intended.

During the DVD-Audio production process, the producer decides whether 

or not the soundtrack of each VTS (if any) on the disc should be playable 

on Audio-only players. This means there are two types of Audio Titles that 

draw content from a VTS:

AOTT/AVTT  The soundtrack is intended for playback on both Audio-only 

and Video-capable players. The VTS must follow the same audio 

requirements as an AOTT (one mandatory PCM stream plus one optional 

additional stream). 

AVTT  The VTS soundtrack is not intended for playback on Audio-only 

players, therefore a PCM stream is not required (either PCM or Dolby 

Digital may be used). 

Table 7: Audio format requirements for video soundtracks in DVD-Audio vary 
depending on whether the type of Video Title Set used allows playback on an Audio-
only player.

AOTT/AVTT VTS AVTT-ONLY VTS

Playable on Audio-only 
players?

Yes No

Required Audio Format Linear PCM Dolby Digital or 
LPCM
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The DVD-Audio specification also requires that if a given type of player is 

able to play some of the content in a group, it must be able to play all of 

the content in that group. This means that a Group which includes an AVTT 

Title (a VTS that is not enabled for playback on Audio-only players) may not 

also contain an AOTT Title or an AVTT/AOTT Title (which do play on Audio-

only players). In effect, videos that are not enabled for (audio) playback on 

Audio-only players must be segregated into their own Group(s).

ADDITIONAL VIDEO RULES AND LIMITATIONS

Another distinction between video on a DVD-Video disc and video on DVD-

Audio is that a VTS on a DVD-Audio disc may not include an individual 

menu (VTSM); the only menu in the Video zone on a DVD-Audio disc is the 

main Video Manager Menu (VMGM).

Optional Audio Format Dolby Digital Dolby Digital or 
LPCM

LPCM Parameters Max. channels, 48kHz: 8 
Max. channels, 96kHz: 2

Bits: 16, 20 or 24
Max. bit rate: 6.1444 Mbps 

Same as AOTT/AVTT

Dolby Digital Parameters Max. channels: 5.1
Max. bit rate: 448 kbps

same as AOTT/AVTT

Table 7: Audio format requirements for video soundtracks in DVD-Audio vary 
depending on whether the type of Video Title Set used allows playback on an Audio-
only player.

AOTT/AVTT VTS AVTT-ONLY VTS
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Additional differences are found in the capabilities of video PGCs (which 

are used to control which VOBs should be played under which conditions). 

The features available to control VOBs in DVD-Audio are a subset of those 

available on a DVD-Video disc. The degree to which the video feature set is 

different depends on the "domain" in which the video is used.

Conceptually, a Video zone (VIDEO_TS directory) on a DVD-Video disc is 

made up of two distinct domains. The "menu domain" refers to Video 

Manager (VMG), which contains a VMG menu (VMGM) with either still 

image or motion video (VOB) backgrounds. The "title domain" refers to a 

series of Video Title Sets that normally contain the main video content of a 

DVD-Video disc. Thus, both the menu and title domains of the Video zone 

draw their presentation data from VOBs.

If motion video content is present on a DVD-Audio disc, the disc still 

contains a Video zone with both menu and title domains. However, the 

menu domain of the Video zone is never seen during playback on any type 

of DVD-Audio player (including Universal); it is present only to allow the 

disc’s Video Title Sets to be viewed on a DVD-Video player. 

In addition to the domains in the Video zone, a DVD-Audio disc has two 

additional domains that are both in the Audio zone (AUDIO_TS): Audio 

Manager (AMG) and Title Group. Like VMG menus, the visual menus in the 

menu domain of the Audio zone (AMGM) may use motion video 

backgrounds. The attributes of VOBs in the AMG are nearly the same as — 

but not identical to — those of VOBs on a DVD-Video disc. Because features 

such as pre- and post-commands are supported, it is possible to create 

complex interactivity in the AMGM.

In contrast, the use of video in VTS-based Audio Titles (AVTT and 

AVTT/AOTT) — which are stored in the Video zone but referenced from 

the Audio zone’s Title Group domain — is quite restricted compared to 

VTSs on a DVD-Video disc. Parental control and seamless branching are not 

supported. Also, VTS PGCs in DVD-Audio do not include pre-commands or 
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post-commands, and the use of dummy PGCs is not supported. Thus VTSs 

on DVD-Audio discs are less capable of complex interactivity than those on 

DVD-Video discs.

Two additional notes about video on DVD-Audio discs: because the 

contents of the VMG menu — including any motion video therein —  is 

never seen by a DVD-Audio player (and vice versa), the AMG menu and 

VMG menu might each have a completely different look and feel, including 

the use of different motion video (if any).

It is also possible to create a DVD-Audio disc that plays the same content on 

either a DVD-Video player or a video-capable DVD-Audio player (Audio-

with-video or Universal). In other words, the presence of AOTT Audio Titles 

is not required. In this case, all the content (other than menus) would be 

AVTT/AOTTs and/or AVTTs with PCM audio. This content would be 

accessed through AMGM on a video-capable DVD-Audio player and VMGM 

on a DVD-Video player. To ensure that this material would also play on an 

Audio-only player, the Titles would have to be AVTT/AOTTs.

An Example DVD-Audio Ti t le
To see how all these audio and video options might work in practice, let’s 

consider how a typical CD release with a dozen songs might be organized 

if it were released as a DVD-Audio title. Group 1 on the DVD might be the 

same material in the same sequence as the CD release, but in multi-channel 

surround. Each song could be accompanied by a Sequential Slideshow 

allowing the listener to navigate to different index points in the song by 

clicking on lyrics. Group 2 could be a dance version of the album, with 

ballads dropped and longer "club" mixes substituted for several of the other 

songs. Group 3 might be a collection of three or four music videos 

produced for the album, each enabled for playback on audio-only players. 

And Group 4 might be a mini-documentary including interviews with the 

band (with playback on audio-only players disabled.) 



An Example DVD-Audio Title 279
Taking advantage of the disc’s DVD-Others zone, meanwhile, would open 

up even more creative, promotional and commercial opportunities when 

the title is placed in a DVD-ROM drive. The disc might contain a custom 

browser programmed to take the user to the artist’s section of the label’s 

Web site. There the user might hear song samples from the band’s other 

albums, order albums and other merchandise online, check a tour schedule 

and order tickets, or send fan e-mail to the band. Combining the flexibility 

of the DVD-Audio format with the underlying capabilities of DVD-ROM, the 

possibilities for DVD-Audio discs become nearly unlimited.

Figure 4: DVD-Audio title with four groups, two with audio content and 
still graphics, and two with video content

Group 2 Group 3 Group 4Group 1
Surround Audio Club Mix Music Video (PCM) Interview

PLAYLIST – Surround
PLAYLIST – Club Mix
VIDEO
INTERVIEW
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B Asset Preparation
As we’ve seen in previous chapters, DVD-Audio Creator is used to define 

the structure of a DVD-Audio album, to populate that structure with 

content (presentation data), to define links between parts of the structure, 

and to output the entire album in a form that may be used by a replication 

plant to manufacture copies for distribution. However, DVD-Audio Creator 

is not designed to actually create the presentation data — audio, graphics, 

and video — used in a DVD-Audio album. 

Because the same capabilities needed to create content files for DVD-Audio 

are also utilized in preparing media for other purposes, it is not necessary 

to integrate those capabilities directly into DVD-Audio Creator. Instead, the 

DVD-Audio asset preparation process is performed in separate applications, 

with each task handled by a specialist in that particular area of production:

Audio  Files are premastered by audio mastering engineers. Files 

premastered in SonicStudio HD are finalized for DVD-Audio use in OneClick 

DVD. 

Graphics  Files are prepared as TIFF files by graphic designers in bitmap-

editing programs such as Adobe Photoshop.

Video  Content is prepared as a VIDEO_TS directory by DVD-Video 

authoring specialists using Scenarist, DVD Creator, or DVD Fusion for 

Macintosh. 
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Preparing the assets for a given project means not only creating individual 

media elements, but also ensuring that those elements are compliant with 

the requirements of the DVD-Audio specification. The assets must also be in 

formats that can be used by the authoring application. In this chapter, we’ll 

look at the steps involved in preparing such assets for use in DVD-Audio 

Creator.

Preparing Audio  Source Fi les

This section provides a quick reference for some key points about audio 

program in the DVD-Audio format, and discusses the workflow for using 

audio premastered in SonicStudio HD. For a more detailed description of 

the audio capabilities of DVD-Audio, see Chapter 14, section 14.2.1. 

Audio Formats and Attributes

The primary type of audio used in DVD-Audio is PCM (pulse code 

modulation). Two types of PCM are supported:

Linear PCM (LPCM):

• Completely uncompressed

• Stored in the .bin file format. 

Meridian Lossless Packing (MLP): 

• Uses a lossless compression scheme, allowing a greater volume of audio 
data to be stored and transmitted, while ensuring playback that is bit-
for-bit identical with the original source.

• Stored in the .mlp file format

• MLP files are created by encoding files that originate as LPCM.
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FORMATS SUPPORTED BY PLAYERS

In addition to the two PCM-based formats, players may support other types 

of audio. The following rules define audio format support in DVD-Audio 

players:

• All DVD-Audio players are required to support both LPCM and MLP 
audio in either stereo or multi-channel configurations. 

• Players with video outs must also support Dolby Digital. 

• Optional audio formats such as DTS or others not yet defined may be 
supported at the player manufacturer’s discretion.

NUMBER OF AUDIO STREAMS

DVD-Audio content may offer up to two audio streams in any given 

program. The first stream is required to be PCM (stereo or multi-channel), 

the optional second stream may be an optional audio type. To create an 

Audio Track with two audio streams, see Chapter 12, section 12.1.

SUPPORTED RESOLUTIONS

DVD-Audio’s PCM support covers two families of sample-rates:

44.1kHz  Based on the rate of the audio CD; also includes the multiples 

88.2kHz and 176.4kHz. 

48kHz  Based on the rate commonly used in video formats; also includes the 

multiples 96kHz and 192kHz.

DVD-Audio also includes support for several word-lengths:

• 16-bit samples (same as CD-Audio)

• 20-bit samples

• 24-bit samples
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SUPPORTED CHANNEL ASSIGNMENTS

DVD audio supports playback of PCM audio in channel configurations 

ranging from one to six channels. The following table shows the maximum 

number of channels allowed for audio at each supported sample-rate:

To allow multiple channels within the maximum data-rate allocable to 

audio (9.6 Megabits per second), each channel is assigned to one of two 

"Channel Groups." The use of Channel Groups is governed by the following 

rules:

• The resolution of Group 1 is always equal to or greater than that of 
Group 2. 

• Within a given Track, the sample-rates used for all the channels in both 
Groups must be from the same family.

The following table lists the supported assignments of channels to Channel 

Groups:

[IMAGE = BOOK Table 5-5] 

Table 13-2: Supported channel assignments for DVD-Audio’s two channel 

groups.

Table 8: Supported channels at various sample-rates

44.1 kHz Family 48 kHz Family

Sample rate (kHz) 44.1 88.2 176.4 48 96 192

Maximum 
channels

6 6 2 6 6 2
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SMART CONTENT AND DOWNMIXING

DVD-Audio allows — but does not require — both stereo and multichannel 

mixes of the same music to be delivered on one disc. To ensure that a DVD-

Audio disc will always play back, even when the only available mix is 

multichannel but the playback system is two-channel, players must support 

the SMART Content system.

SMART allows producers to determine in advance a set of downmix 

parameters ("coefficients") defining the relative level, panning and phase 

that will be applied to each channel of a multichannel mix if it is combined 

into stereo. A SMART "downmix" will only be played if a discrete 2-channel 

mix of a given program has not been included on the disc.

SMART downmix coefficients may be prepared in OneClick DVD (if the 

target audio format is MLP) or in DVD-Audio Creator’s Import Audio 

application (see Chapter 4, section 4.2.6).

Audio asset preparation

In DVD-Audio, the preparation of audio assets is an extension of the 

premastering process used to optimize audio for release on CD or other 

prerecorded media. In the case of a DVD-Audio album, the premastered 

material is not output directly to a master to be used for replication, but 

rather is output to files that may be imported into DVD-Audio Creator.

Audio is imported into a DVD_Audio Creator project with Import Audio 

(see Chapter 4), which can import .aif, .wav, .bin, and .mlp files. The 

section below covers the typical workflow for making .bin or .mlp files 

from projects that have been premastered in SonicStudio HD. The process 

involves steps in both SonicStudio HD and OneClick DVD.
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PREMASTERING AND EDL PREPARATION IN SONICSTUDIO HD

SonicStudio HD is used to optimize the sound of the program in audio 

source files (premastering), to generate an EDL for import into OneClick 

DVD, and to generate a list of PQ codes for use in Import Audio.

To work in OneClick DVD, the SonicStudio EDL must conform to the 

following requirements:

[the table was adapted from outdated materials and needs to be double-

checked. Also, if only panels 1-3 are used, will the third channel play 

through the Ls speaker only, or will a mono surround (S) signal 

automatically play back through the Ls and Rs speakers?]

Table 9: SonicStudio EDL requirements for OneClick DVD

Sample rate (kHz) 44.1, 48, 88.2, 96, 176.4, or 192

Sample bit depth 16, 20 or 24,

Destination panels Designate the EDL panels for the channels that will 
be encoded by OneClick DVD:

• 1: C (mono)
• 2: L, R
• 3: Lf, Rf, S
• 4: Lf, Rf, Ls, Rs
• 5: Lf, Rf, Ls, Rs, C
• 6: Lf, Rf, Ls, Rs, C, LFE

Delivery tracks All channels to be encoded must be in Destination 
panels

Sync group All destination channels must be in Sync Group A 
(SonicStudio 5.4 EDLs only)

Track ID marks At least one Track Start and one Track End Mark 
placed in the top panel of the EDL

Index marks Optional within audio streams
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To prepare source audio in SonicStudio HD:

1 Premaster the audio material, including making the channel assignments 

for each Track.

2 Set the Start and End marks (PQ codes) for each Track, and print out a 

PQ list. The list will be used in Import Audio when entering Track start 

and end times for files containing the audio for more than one Track 

(see Chapter 4, section 4.3).

3 Export an EDL in SonicStudio version 5.4 format. This EDL should 

contain the desired number of channels, bit depth and sample rate to be 

included on the DVD (see table 13-3 above).

For further information on the steps above, see the Sonic Studio HD User 

Guide.

ENCODING THE EDL IN ONECLICK DVD

OneClick DVD is used to encode an EDL prepared in SonicStudio HD into 

.bin or .mlp source files ready for import into a DVD-Audio Creator project 

with Import Audio. 

To encode source audio in OneClick DVD:

1 If the target audio format is MLP (.mlp), use the Preferences dialog to 

set the SMART downmix coefficients for any multichannel Audio Tracks 

for which you will not be preparing a separate stereo mix.

2 Open the SonicStudio EDL, specifying the target audio format (.mlp or 

.bin) in the drop-down list in the Open dialog. 

3 Specify the filename and destination folder for the .mlp or .bin file.

4 After the encoding to .mlp or .bin, FTP-transfer the "Sources" folder 

generated by OneClick DVD to the machine running DVD-Audio 

Creator. 
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For further information on the steps above, see the OneClick DVD User 

Guide.

Preparing Graphics  for  Menus and Sl ides

The following sections give a brief overview of the use of still pictures in 

DVD-Audio, followed by an explanation of the requirements for still picture 

source files.

Still Pictures in DVD-Audio

There are two basic categories of still pictures used in DVD-Audio Creator:

Slide:

• No buttons

• Made up of only a single image layer (24-bit color)

Menu: 

• Up to 36 buttons 

• Made up of three layers:

- 24-bit color Background layer containing the visible background 
image

- Subpicture Overlay (SPU) layer of up to four colors for shapes 
(including text) that are displayed over the Background

- Button Hotspots layer for highlight information (HLI), which defines 
the rectangular boundaries of each of the menu’s buttons. 

Slides used in a DVD-Audio Creator project must be contained within a 

Slideshow or Stillshow (see Chapter 7, section 7.4.7). The source files for 

the Slides are brought into the project in Author (see Chapter 7, section 

7.4.8). 
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For Menus, the source files are imported into DVD-Audio Creator with 

Import Menu (see Chapter 5). There are three types of Menus used in a 

DVD-Audio Creator project: Single-Page, Multi-Page, and Linked-Lyrics. For a 

description of each Menu type, see Chapter 5, section 5.2. For a 

description of the use of each Menu type within the structure of a DVD-

Audio album, see Chapter 7, section 7.4.

NAMING SOURCE FILES FOR MENUS

For each type of Menu, there are specific naming conventions used for the 

Background, Overlay and Button Hotspots files. The filenames allow DVD-

Audio Creator to correctly identify the files as a set associated with a given 

Menu, and to correctly assign each file to its intended function within the 

Menu. For an explanation of the naming conventions for each Menu type, 

see Chapter 5, section 5.2.

Graphic File Considerations

In a DVD-Audio Creator project, the source files for still pictures are 

prepared in the TIFF format. The files are encoded into MPEG-2 I-frames 

when the project is formatted.

Because pictures are commonly prepared in the computer space but 

displayed in the TV space, graphic design for DVD involves a number of 

special considerations.

Note: To spot potential problems as they arise, it is advisable to connect a 

television display to the graphics computer during the design stage.
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ASPECT RATIO

Visual content on a given DVD-Audio album may be at either of two aspect 

ratios (but not both): 

• 4:3 (standard)

• 16:9 (widescreen)

Graphic source files for pan/scan and letterbox display modes on 16:9 

albums have special requirements and naming conventions (see section 

13.2.4 below).

PIXEL SHAPE

The computer displays used in graphic design have square pixels, while 

television displays use rectangular pixels that are about 12-percent taller 

than they are wide. As a result, on a computer monitor an image with a 

resolution of 720 x 540 has an aspect ratio of 4:3, but for television display 

an image of the same width and aspect ratio requires a resolution of 720 x 

480.

Because of the different pixel shapes, graphics prepared on computer must 

be scaled (resized) before being used in a DVD-Audio project. This will 

make the graphics look vertically stretched or compressed  (depending on 

the target television format) on the computer display. However, the 

proportions will be correct when the picture is ultimately displayed on a 

video monitor. (If the album is played back on a computer, the scaling will 

be reversed during decoding to yield the correct proportions.)
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The target resolution for scaling depends on the aspect ratio and television 

system of the album:

[double-check the numbers given above!]

TELEVISION SAFE AREA

Television monitors are designed to overscan the screen area, meaning that 

the outer 5-10 percent of the picture on all sides (top, bottom, left and 

right) is not actually visible to the viewer. (Computer monitors do not 

overscan.) The degree of overscan varies depending on the individual 

television. 

Table 10: Target resolution for preparing and scaling graphics

4:3 Aspect Ratio 16:9 Aspect Ratio

Prep graphics at: Scale to: Prep graphics at: Scale to:

NTSC 720 x 540 720 x 480 854 x 480 720 x 480

PAL 720 x 540 720 x 576 1024 x 576 720 x 576

Figure 5: Menu backgrounds prepared in a computer graphics 
environment are scaled to compensate for the rectangular pixels used in 
television
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Computer pixels: square Television pixels: rectangular

Prepared on computer 
at 720 x 540

Scaled to 720 x 480 Displayed on TV



292 Chapter B, Asset Preparation
The "safe area" is the rectangular area within a video picture that will 

definitely be visible when displayed on all televisions. Text, menu buttons, 

and other essential picture elements must be placed within this safe area. 

The boundary coordinates for a rectangle defining a 10 percent safe area 

depend on the TV format:

4:3 NTSC and PAL  For graphics prepared at a resolution (before scaling) of 

720 x 540:

• Left top = 72, 54 

• Right bottom = 648, 486

16:9 NTSC  For graphics prepared at a resolution (before scaling) of 

854 x 480:

• Left top = 85, 48

• Right bottom = 769, 432

16:9 PAL  For graphics prepared at a resolution (before scaling) of 

1024 x 576:

• Left top = 103, 58

• Right bottom = 922, 518

Figure 6: Safe area on a television

Safe Area
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COLOR PALETTE

The range of colors supported in the NTSC and PAL color space is different 

(more limited) than the color range supported in the RGB world of 

computers. Therefore, when designing graphics on computer for use in 

DVD, you need to take into account how color choices will translate when 

displayed on a TV screen. 

The following guidelines can help avoid problems with color:

• Avoid highly saturated colors (above 75-90 percent). 

• Detail should be defined by differences in brightness (visible in gray 
scale) rather than by the contrast between two colors of the same 
brightness (e.g. dark red text over a dark blue background).

DEFINITION AND DETAIL

Computer monitors normally have much higher resolution than video 

displays, and use progressive rather than interlaced video. That means that 

details which look great on a computer may appear unstable or be lost 

entirely when viewed on a television. This is particularly important when 

dealing with text. 

The following guidelines can help maintain legibility and visual clarity:

• Fonts should be at least 11-12 points, with the thinnest parts of the 
letters at least 2 points thick to avoid moire and flickering.

• Sans serif fonts display better than serif fonts.

• Avoid putting more than 10-15 lines of text on any one screen.

• In line art, use lines that are at least 4 pixels wide.
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Graphic File Requirements

As noted above, Menus are imported into a DVD-Audio Creator project 

using Import Menu, while Slides are imported directly into Author. The 

source file requirements for both types of graphics are as follows:

File format  TIFF (.tif)

Compression  None

Resolution (after scaling)  

• NTSC: 720 x 480 pixels

• PAL: 720 x 576 pixels

Pixels/inch (dpi)  72

Color depth  

• Background layer file (Menus and Slides): 24-bit color (subject to 
limitations of NTSC and PAL color space; see Color palette in section 
13.2.2 above)

• Overlay layer file (Menus only): 4 colors (see Chapter 5, section 5.3.1)

• Button Hotspot layer file(s) (Menus only): 2 colors (see Chapter 5, 
section 5.3.2)

Channels  RGB only (no alpha channels)

For information on scaling 4:3 or 16:9 graphics for use in either NTSC or 

PAL television systems, see Pixel shape and aspect ratio in section 13.2.1 

above.

Letterbox and Pan/Scan for 16:9 albums

Visual content on a given DVD-Audio album may be at an aspect ratio of 

either 4:3 or 16:9 (but not both). The DVD-Audio specification supports 

two methods for playing back 16:9 content (pictures and motion video) on 

a standard (non-widescreen) television:
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Pan/scan:

• The left and right sides of the original widescreen image are cropped 
out to create a 4:3 viewing area. 

• In motion video, the viewing area may be moved around (panned) 
within the widescreen source image in an attempt to follow the most 
important action in the frame. 

• Vectors for the location of the viewing area within the original frame 
are encoded into the MPEG-2 data stream.

Letterbox:

• The image is scaled proportionally until the complete picture fits 
horizontally in a 4:3 viewing area, reducing the image to about 75-
percent of its original size.

• The resulting blank space above and below the picture is filled with a 
black matte.

The DVD-Audio specification requires that every 16:9 album support not 

only widescreen display mode, but also either pan/scan, letterbox, or both. 

You choose from these three options in the Display Mode pane of the Video 

Attribute dialog in Command Editor (see Chapter 8, section 8.x).

BACKGROUND AND BUTTON HOTSPOT SOURCE FILES FOR 16:9

As described above, DVD-Audio Menus and Slides each contain a 24-bit 

color layer (the Background layer in a Menu). In addition, Menus utilize a 

subpicture Overlay (SPU) layer (up to four colors), and a Button Hotspots 

layer for highlight information (HLI), which defines the rectangular 

boundaries of each of the menu’s buttons.

In a 16:9 album, the Background and Button Hotspot layers for every 

display mode are derived from a single file per layer:
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Background layer (Menus and Slides):

• A TIFF is prepared at 16:19, but scaled (to 720 x 480 for NTSC; 720 x 
576 for PAL) before being imported into the project. This image is used 
for the widescreen display mode and also for the letterbox and/or 
pan/scan modes.

• During playback, display of the Background image is determined by the 
display mode setting on the player:

- Widescreen, the image is stretched on-the-fly from 4:3 to 16:9 
(restoring its pre-scaled shape);

- Pan/scan, the image is stretched on-the-fly from 4:3 to 16:9, but only 
a 4:3 area in the center (pan/scan vector = 0) is displayed;

- Letterbox, the image is stretched on-the-fly from 4:3 to 16:9, then 
scaled proportionally so that the width fits within a 4:3 frame.

Button Hotspots (Menus only):

• The Button Hotspot layer source file is prepared for widescreen mode.

• During formatting of the project by Format, the button hotspot 
information for the other display modes (pan/scan and/or letterbox) are 
calculated based on the positions defined in the source file for 
widescreen mode.

OVERLAY SOURCE FILES FOR 16:9

The Overlay layer is not scaled on-the-fly during playback, because this 

layer is frequently used to display text, and the visual clarity of the text 

would be significantly degraded by playback scaling. This means that a 

separate Overlay source file is required for the widescreen display mode 

and also for the letterbox and/or pan/scan modes (depending on the 

setting in the Display Mode pane of the Video Attribute dialog in Command 

Editor).

The Overlay source files for each display mode are TIFF files prepared and 

named as follows:
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Widescreen:

• The file is prepared at 16:9 aspect ratio and scaled (to 720 x 480 for 
NTSC; 720 x 576 for PAL) before being imported into the project.

• Text and interface elements in the overlay layer may be placed 
anywhere within the safe area for 16:9 images (see Television safe area 
in section 13.2.2 above). 

• Naming of the file is the same as for 4:3 Overlay source files (see 
Chapter 5, section 5.2):

- For Single-Page and Multi-Page Menus: menuname_HL.tif

- For Linked Lyrics Menus: menuname_HL##.tif

• The source file is imported into the project with Import Menu.

Pan/scan:

• The file is prepared at 4:3 aspect ratio [this is a guess!] (720 x 540 for 
both NTSC and PAL) and scaled (to 720 x 480 for NTSC; 720 x 576 for 
PAL) before being imported into the project.

• Text and interface elements in the overlay layer may be placed 
anywhere within the safe area for 4:3 images [this is a guess!] (see 
Television safe area in section 13.2.2 above). 

• The naming conventions for the files are as follows:

- For Single-Page and Multi-Page Menus: menuname_HL_PS.tif

- For Linked Lyrics Menus: menuname_HL##_PS.tif

• The source files are imported into the project manually by placing them 
in the same folder as the corresponding widescreen source file that has 
been imported with Import Menu.
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Letterbox:

• The file is prepared at 4:3 aspect ratio [this is a guess!] (720 x 540 for 
both NTSC and PAL) and scaled (to 720 x 480 for NTSC; 720 x 576 for 
PAL) before being imported into the project.

• To display within the area of the letterboxed Background image, text 
and interface elements in the overlay layer must be placed within a 
rectangle described by the following coordinates in the pre-scaled 720 x 
540 graphic:

- Left top: 72, 68 [this is a guess, based on letterboxed image being 
75% of the height of the original widescreen image]

- Right bottom: 648, 472 [this is a guess!]

• The naming conventions for the files are as follows:

- For Single-Page and Multi-Page Menus: menuname_HL_LB.tif

- For Linked Lyrics Menus: menuname_HL##_LB.tif

• The source files are imported into the project manually by placing them 
in the same folder as the corresponding widescreen source file that has 
been imported with Import Menu.

13 .3  Preparing a  VIDEO_TS for  DVD-Audio
The DVD-Audio format allows an album to include Video Tracks in the DVD-

Video format. This DVD-Video material may be played in a video-capable 

DVD-Audio player (an Audio-with-video player or a Universal player), or in a 

DVD-Video player.

LIMITATIONS ON DVD-VIDEO MATERIAL IN DVD-AUDIO

While the DVD-Audio format supports the inclusion of DVD-Video material, 

the specification places some additional limitations on that material that are 

not part of the DVD-Video specification. This means that it is possible to 

unintentionally create DVD-Video compliant material that cannot actually 

be used as part of a DVD-Audio album.
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The limitations on DVD-Video material in DVD-Audio are covered in 

Chapter 6, section 6.1.2. These limitations must be respected during DVD-

Video authoring in order to create a working DVD-Audio album that 

includes DVD-Video material.

AUTHORING DVD-VIDEO MATERIAL FOR DVD-AUDIO

In DVD-Audio Creator, the Import VIDEO_TS application is used to import 

the source files for DVD-Video material into your project. The source files 

come from a VIDEO_TS directory created in a DVD-Video authoring 

application such as Sonic Scenarist, DVD Creator, or DVD Fusion for 

Macintosh. However, to use the VIDEO_TS in a DVD-Audio album, certain 

additional steps must be performed during the DVD-Video authoring 

process. 

To author DVD-Video material for DVD-Audio, follow the DVD-Video 

authoring process as normal — keeping in mind the limitations discussed 

in Chapter 6, section 6.1.2 — until the project is ready for multiplexing. At 

this point, some manual script modification is necessary to obtain a DVD-

Audio compliant DVD-Video Zone. The specific steps to be taken vary 

depending on whether you are working in Scenarist, or DVD Creator/DVD 

Fusion for Macintosh.

VIDEO_TS Prepared in Scenarist

When Scenarist is used to prepare a VIDEO_TS directory for inclusion in a 

DVD-Audio album, playback for Region 7 must be enabled before the 

directory is imported into DVD-Audio Creator with Import VIDEO_TS. This 

step involves manually modifying the Scenarist script file for the project. 

The modification is performed after the entire authoring process (defining 

the content and navigation of the VIDEO_TS) has been completed in 

Scenarist, but before the project is multiplexed for final output. 
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To modify a Scenarist script file:

1 Export a Scenarist script file for the project:

• With the project open in Scenarist, choose File > Export. The Export 
dialog box will open.

• Choose Export Scenario to Script. The "Export Scenario to Script" dialog 
will open.

• Specify the export settings:

- Choose Script in the Export To pane at the upper left of the dialog

- In the Script File field, check that the correct path is specified for 
the Script folder in the My Scenarios folder. The pathname should 
end with the project name and the ".scp" extension.

• Hit Return or click the OK button. The dialog will close, and the 
creation of the script will be reflected in Scenarist’s Information 
Window. When the script has been output, an alert dialog will appear 
indicating that the process is completed. Hit Return or click the OK 
button to close the dialog.

• For further information, see Scenarist User Guide, Section 2, paragraph 
2.7.1.

Scenarist, Export Scenario to Script dialog
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2 Edit the script file:

• Open the script file in a text-editing application such as Wordpad (in 
ASCII text mode) or a dedicated text editor such as BBEdit (the file may 
be too large to open in Notepad).

• Search for the string "Regional Code #7="

• Change the parameter value from "Shall not be played" to "May be 
played".

• Save the change and close the script file.

3 Import the script back into Scenarist:

• In Scenarist’s Project Manager, choose the New From Script option near 
the bottom of the window. The "Create New Scenario from Script" 
dialog will open.

• Specify the import settings:

- Choose Script in the Import From pane at the upper left of the 
dialog

- Click the Browse ("...") button at the right of the Script File field, and 
use the Open dialog to specify the script file (ProjectName.scp) that 
you edited. 

- Click the Browse ("...") button at the right of the Scenarist File field 
at the bottom of the Create New Scenario from Script dialog. The 
Select File dialog will open.

• In the File Name field, enter a name for the project that is different from 
the name of the project from which the script file was exported for 
editing. 

• Click the Open button. The Select File dialog will close.

• In the Create New Scenario from Script dialog, the filepath in the 
Scenarist File field will now be complete. Hit Return or click the OK 
button. The dialog will close, and the creation of a new project from the 
specified script file will be reflected in Scenarist’s Information Window. 
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When the script has been output, an alert dialog will appear indicating 
that the process is completed. Hit Return or click the OK button to 
close the dialog.

• For further information, see Scenarist User Guide, Section 2, paragraph 
2.6.1.

4 Confirm the modification of the script:

• In Scenarist, open the Layout Editor tab [in which window?].

• In the Project Information: Tree view area, select the Disc icon. The Disc 
Property sheet will appear.

• Double-click Regional area, and look for "Regional code #7." The value 
of the parameter should read: "May be played."

5 Output the project as a VIDEO_TS directory:

• See Scenarist User Guide, Section 13 for information on copy protection 
settings.

• See Scenarist User Guide, Section 14 for information on Layout and 
Premastering (DVD-Video format).

Scenarist, Create New Scenario from Script dialog
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VIDEO_TS Prepared in DVD Creator or DVD Fusion for 
Macintosh

When DVD Creator or DVD Fusion for Macintosh is used to prepare a 

VIDEO_TS directory for inclusion in a DVD-Audio album, a "dummy" DVD-

Audio zone must be added to the project to ensure that during 

multiplexing the project is recognized as a DVD-Video Zone that will be 

included on a DVD-Audio disc. 

[This following description is based on the assumption that Sonic will 

provide both a OneClick project folder (called DummyZone) and (to make 

it more foolproof for the user) a separate text file (I’m calling it 

DummyScript.txt) that has in it only the exact text that needs to be pasted 

into the AuthorScript file.]

The dummy DVD-Audio zone is in a folder call DummyZone. The zone is 

referenced by a script segment found in the file called DummyScript.txt. 

These items are located [specify where they find the DummyZone folder 

and DummyScript.txt file]. The following section explains how to insert the 

text into the AuthorScript file (ProjectName.as) for a DVD-Video project 

that will be used to create a VIDEO_TS that will be imported into a DVD-

Audio Creator project. 

The insertion is performed after the entire authoring process (defining the 

content and navigation of the VIDEO_TS) has been completed in DVD 

Creator (or DVD Fusion for Macintosh), but before the project is 

multiplexed for final output.

Note: Before starting to edit the AuthorScript file, make sure that the 

DVD-Video project is not currently open in DVD Creator or DVD Fusion 

for Macintosh.
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To modify an AuthorScript file:

1 Transfer the DummyZone folder and DummyScript.txt file

• Locate the DummyZone folder and DummyScript.txt file [where?].

• Transfer the folder and file to the machine running DVD Creator or DVD 
Fusion for Macintosh.

2 Copy the contents of the file DummyScript.txt:

• Open the file DummyScript.txt in a text-editing application such as 
SimpleText, or a dedicated text editor such as BBEdit.

• Select the entire contents of the file (Command + A), and copy to the 
clipboard (Command + C).

3 Paste the dummy Audio zone into the AuthorScript file:

• In your text-editing application, open the AuthorScript file 
(ProjectName.as) for the DVD-Video project that will be used to create a 
VIDEO_TS for the DVD-Audio Creator project.

• Select the first three lines of the AuthorScript file, including the line 
"AuthorScriptSpec"

• Paste the contents of the clipboard into the selected portion of the 
AuthorScript file.

4 Edit the filepath for the dummy audio file:

• Search the AuthorScript file for the line that starts with "SourceFile."

• Change the value of the SourceFile parameter to the correct filepath for 
the file DummyFile.mlp [this is just my name for the audio file; change it 
if you prefer something else] in the DummyZone folder.

• Save the changes and close the AuthorScript file.



13.3 Preparing a VIDEO_TS for DVD-Audio 305
5 Output the project as a VIDEO_TS directory:

• Open the edited AuthorScript file in the Imager module of DVD Creator 
(version 2.1.6 or later) or DVD Fusion for Macintosh, and output the 
project as a VIDEO_TS directory. (For further information, refer to the 
section on "Write Direct" in the User Guide for DVD Creator or DVD 
Fusion for Macintosh.)

• The resulting DVD Volume contains a VIDEO_TS folder and an 
AUDIO_TS folder:

- The VIDEO_TS folder contains the DVD-Video zone for the DVD-
Audio project. This is the folder that will be imported into the DVD-
Audio Creator project using Import VIDEO_TS (see Chapter 6).

- The AUDIO_TS folder contains a second of silent audio derived from 
the dummy OneClick .mlp file. It is of no further use, and may be 
discarded.
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